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RESUMEN

La investigacion fue realizada en la cuenca del rio Tumbes en una superficie de 1
663,28 Km2 en altitudes entre 0 a 1589 m.s.n.m. y médulo pluviométrico anual que
va desde 278,743 a 887,244 mm. El objetivo del estudio fue estimar la tasa de
erosion hidrica en la cuenca del rio Tumbes, aplicando la metodologia RUSLE con
técnicas de teledeteccién; RUSLE es un método que integra cinco factores mediante
el uso de herramientas SIG, el factor (R) se determin6é a partir de precipitaciones
acumuladas mensuales, el factor (K) se estimd con clases texturales y materia organica
obtenidas de SoilGrids, el factor (LS) se obtuvo a través de un modelo de elevacién
digital (DEM) obtenido del MINAM, el factor (C) se estim6 a partir de imagenes
satelitales landsat 7 y 8. Los resultados obtenidos respecto a la erosion hidrica
potencial (sin considerar la cobertura vegetal, ni practicas de conservacion), indican
gue la mayor parte de la cuenca (31,92%) experimenta pérdidas mayores a 200
Tn/Ha/Afio considerada critica, mientras que un menor porcentaje (8,11%) tiene
pérdidas inferiores a 5 Tn/Ha/Afo con una clasificacion baja. En comparacion, la
erosion actual muestra que la mayoria de la cuenca (58,16%) presenta pérdidas
menores a 5 Tn/Ha/Afio y en menor porcentaje (0.25%) erosion mayor a 200
Tn/Ha/Afo, todo esto bajo la clasificacién de la FAO. En cuanto a la tasa de erosion se
obtuvo una tasa de erosién potencial de 167,18 Tn/Ha/Afo y una tasa de erosion actual

de 5,06 Tn/Ha/Afo generando mapas de erosion de suelo (periodo 2000 — 2022).

Palabras clave: Erosion hidrica, suelo, RUSLE, teledeteccion, sistemas de

informacion geografica (SIG).
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ABSTRACT

The research was conducted in the Tumbes river basin over an area of 1663,28
kmz2, ranging in altitudes from O to 1589 meters above sea level, with an annual
rainfall ranging from 278,743 to 887,244 mm. The aim of the study was to estimate
the water erosion rate in the Tumbes river basin, using the RUSLE methodology
with remote sensing techniques. RUSLE is a method that integrates five factors
using GIS tools. Factor (R) was determined based on monthly accumulated
precipitation, factor (K) was estimated using textural classes and organic matter
obtained from SoilGrids, factor (LS) was obtained through a digital elevation model
(DEM) obtained from MINAM, and factor (C) was estimated from Landsat 7 and 8
satellite images. The results regarding potential water erosion (without considering
vegetation cover or conservation practices) indicate that the majority of the basin
(31,92%) experiences losses greater than 200 Tn/Ha/Year, considered critical,
while a smaller percentage (8,11%) has losses lower than 5 Tn/Ha/Year with a low
classification. In comparison, current erosion shows that the majority of the basin
(58,16%) experiences losses lower than 5 Tn/Ha/Year, and a smaller percentage
(0,25%) has erosion greater than 200 Tn/Ha/Year, all under the FAO classification.
Regarding the erosion rate, a potential erosion rate of 167,18 Tn/Ha/Year and a
current erosion rate of 5.06 Tn/Ha/Year were obtained, generating soil erosion maps
(period 2000-2022).

Keywords: Water erosion, soil, RUSLE, Remote sensing, geographic information

systems (SIG).
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CAPITULO |

1. INTRODUCCION

El crecimiento econdémico y social de un pais esta estrechamente relacionado con
la disponibilidad de sus riquezas naturales, particularmente las tierras, llevando a
cabo un uso sostenible e integrado a través del tiempo (Cisneros et al., 2012), ya
gue el suelo provee de los nutrientes necesarios para la produccién de alimentos,
asegurando la subsistencia de los seres vivos en el medio donde interactdan. En
este contexto en la degradacion de los suelos, la erosién es un problema a escala
mundial porque disminuye significativamente la capacidad de produccién, con

danos irreversibles.

Los problemas ambientales, tales como la erosion hidrica de los suelos ha sido un
tema que ha permanecido ignoto o considerado secundario, puesto que se ha
subestimado la importancia de un entorno equilibrado, no obstante, el panorama
gue se presenta hacia el deterioro ambiental es una conminacion grave al
desenvolvimiento del presente y futuro (SEMARNAT, 2009), en el Peru este
problema afecta abundante superficie nacional en diferentes grados de rigidez, en
tal sentido, de acuerdo con el estudio realizado por INRENA en el afio 1996,
determind que en el territorio nacional se produce el 41,40% de erosion hidrica nula
o ligera, el 27,40% erosion hidrica moderaday el 24,40% erosion alta, sumando un

total de 8 millones de hectareas afectadas.

La cuenca del rio Tumbes no es indiferente a este preocupante hecho, pues es
evidente la reduccion de la cobertura vegetal por acciones antropicas, sumandole
las pendientes pronunciadas en la cabecera y fuertes precipitaciones que se dan
por la presencia de la corriente del nifio, ante toda esta situacién es necesario
adoptar una metodologia con la que se pueda estimar la tasa de pérdida del suelo
por erosion hidrica y con ello reconocer las areas con principal riesgo y proponer
medidas de conservacion, por ello se hara uso de la metodologia RUSLE aplicando
técnicas de teledeteccién utilizando el entorno Gis, para determinar cada uno de

los factores que intervienen en esta ecuacién universal.
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CAPITULO II

2. ESTADO DEL ARTE
2.1. ANTECEDENTES

D’Amario (2016) en su tesis de grado “Evaluacion del riesgo de erosion hidrica, su
distribucién espacial y el efecto de la cobertura vegetal en el proceso erosivo, en la
cuenca hidrografica del Rio Tunuyan Superior (Mendoza)’, donde el objetivo
principal de esta investigacion fue evaluar el riesgo de erosion hidrica, distribucion
espacial, asi como el impacto de la cobertura vegetal en el proceso de erosion, en
la cuenca del rio Tunuyan Superior (Mendoza), con el fin de sugerir pautas de
implementacion. Para ello aplico la metodologia RUSLE (Revised Universal
Equation of Land Loss).

El autor concluye que el 4,6% del area de la cuenca estudiada pertenece al estrato
de muy alta erosion y el 28,2% al estrato alto. La mayoria de ellos (55,5%)
presentaron erosion moderada, todos estos resultados en base a la clasificacion
dada por la FAO.

Mendes et al. (2018), en su articulo cientifico “Water erosion in Oxisols under coffee
cultivation”, plante6 como objetivo estimar las pérdidas de suelo asociada con el
limite de tolerancia a la pérdida de suelo en Oxisoles (Latossolos Vermelhos
Distroficos) bajo cultivo de café. Este estudio fue realizado en marzo de 2015 a
enero de 2017 en la Subcuenca hidrografica Corrego da Laje. utilizé la metodologia
RUSLE desarrollada a través de técnicas de geoprocesamiento, imagenes de
teledeteccion y datos de literatura. Los resultados obtenidos muestran pérdidas
potenciales de suelo de 0,01 a 18,77 Mg ha™* afio, con un promedio de 1,52 Mg
ha! afio. La tolerancia a la disminucién de suelo vari6 de 5,19 a 5,90 Mg ha* afio-
1, con 7,35 % del area con mayores pérdidas. Las areas con pendientes mas
pronunciadas y sin practicas sostenibles tienen pérdidas de suelo por encima del
nivel de tolerancia y, por lo tanto, son una prioridad para la adopcién de medidas
para mitigar los efectos erosivos. En cuanto al uso de la ecuacién RUSLE, logré
optimizar costos y tiempo al momento de evaluar los factores involucrados en la

disminucién de la pérdida de suelo.
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Dioses y Pérez (2018) en su tesis de grado “Estimacion de la erosion hidrica

mediante la aplicacion de la metodologia RUSLE en la cuenca del rio Piura”

Donde su proposito principal fue estimar la tasa de erosion hidrica de la cuenca
hidrografica del rio Piura aplicando la metodologia RUSLE. En un periodo de
estudio de 35 afios (1981-2016), utilizando la percepcion remota como principal
herramienta. Evalué los factores de la siguiente manera: el factor Erosividad R con
data de PISCO Senamhi a través de una interpolacion mensual; el factor
erodabilidad K con data de la plataforma SOILGRID en base a textura del suelo,
estructura y capacidad de drenaje; el factor longitud y pendiente LS haciendo uso
de un digital elevation model (DEM, por sus siglas en inglés); el factor Cobertura
Vegetal C basado en la data del Ministerio del ambiente. Concluyendo que el mayor
grado de erosion se presenta en el rango de normal y ligero con valores de 0,5 a5
Tn/ha-afio en las zonas bajas, por otro lado, en la cabecera de la cuenca el grado
de erosion esta en el rango de medio a muy alto en el rango de 5 a 50 Tn/ha-afio.
Dentro de los afios de estudio resaltan con la maxima erosion hidrica los afios 1983,
1998 y 2001 a consecuencia de las impetuosas precipitaciones provocadas por el

fendmeno del nifo.

Flores (2015) en su tesis de grado “Aproximacién de riesgo por erosion hidrica
aplicando un SIG en la cuenca Shambillo, distrito de Padre Abad”, utilizo la
metodologia de la “Ecuacion Universal de Perdida de Suelo Modificada”
(USLE/RUSLE), haciendo uso de las SIG y técnicas de teledeteccion. Respecto a
los factores involucrados en la ecuacion, el factor “R” se generdé mediante el uso
del indice de Fuirier modificado (IMF) y la ecuacion de Foster; referente al factor
Erodabilidad “K” se obtuvo aplicando la formula de Wischmeier (1978), tomando en
cuenta la textura del suelo, materia organica, estructura y permeabilidad a través
de muestras de suelos; el factor topografico “LS” lo obtuvo a través del método de
Renard et al (1997); el factor de cobertura vegetal “C” lo determind haciendo una
clasificacion supervisada de cada uso y cobertura de suelo; respecto al factor “P”
se asumio el valor de 1, debido a que no se desarrollan practicas de conservacion
de suelos en el area de estudio, obteniendo entre sus resultados mas resaltantes
una erosion potencial media (no considera la cobertura vegetal) de 71,46 tn/ha/afio,

en cuanto a la erosion real sobresalié la media de 26,87 tn/ha/afio. En términos mas
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especificos el 98,8% del area presenta una erosion baja y el 0,2% evidencia una

erosion no significativa que sobrepasa los limites de clasificacion aceptables.

Sabino (2016) en su tesis de grado “Analisis espacio — temporal de erosion de
suelos por regiones hidrolégicas en el Peru (1981 — 2014)” tiene como objetivo
principal evaluar la variabilidad espacio — temporal de la pérdida por erosion de
suelos a nivel de Regiones Hidrolégicas en el Perl aplicando el modelo RUSLE.
Los factores involucrados en esta metodologia fueron tratados y manejados con
técnicas de percepcion remota. Estos factores fueron evaluados de la siguiente
manera: el factor erosividad (R) fue obtenido del producto PISCO SENAMHI a
través de imagenes satelitales interpolando la precipitacion mensualmente, el mapa
de erodabilidad (K) se proceso a partir de las caracteristicas fisicas del suelo con
apoyo de imagenes satelitales, el mapa de cubierta vegetal (C) se baso en la data
de vegetacion del pais, el factor topografico (LS) en base a un digital elevation
model (DEM) y el factor de préacticas de conservacion de suelos (P) se obtuvo con
la vegetacion alineada a las curvas de nivel. Los resultados obtenidos para la
Region Hidrolégica Pacifico 6 (Region que involucra a la cuenca del rio Tumbes)
muestra una erosion de 30,90 Tn/ha/afio para el periodo de 33 afios (1981-2014),
resaltando los valores mas bajos en los afios de 1989, 1992 y 2004. Concluyendo
gue el factor erosividad (R) es el que tiene mayor influencia en la ecuacion RUSLE,
seguido del factor topografico, debido al relieve pronunciado que incita el
escurrimiento superficial del recurso hidrico conjuntamente con las particulas

arrastradas en los primeros centimetros de la corteza terrestre.

Senamhi (2017) en su estudio “Atlas de erosion de suelos por regiones hidrologicas
del Peru” aplica la metodologia RUSLE, obteniendo resultados para la Region
Hidrogréfica del Pacifico 6 (Regidn que involucra a la cuenca del rio Tumbes) en la
costa norte del Perd. Con niveles de erosion bajo, moderado y alto de acuerdo a la
clasificacion de la FAO; menos de 3,0 Tn/ha/afio (1990 afio seco), 30,90 Tn/ha/afio
y 108,0 Tn/ha/afio (afio 1998) respectivamente.

2.2. MARCO TEORICO
2.2.1. EROSION

La erosion puede definirse ampliamente como un proceso por el cual el suelo es

arrastrado por accion de agentes como el agua y el viento. Esto involucra la
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presencia de dos factores que intervienen en el desarrollo: un elemento pasivo, el
suelo, y un elemento activo, como el agua, el viento o su participacion alterna. Por
otro lado, la cobertura vegetal interactia dando un ajuste a la relacion de estos
factores (Leon, 2001).

2.2.2. TIPOS DE EROSION

2.2.2.1. Erosién de forma natural

Segun ICONA (citado en Perales, 2019) define de la siguiente manera:

A veces se le llama erosién geoldgica porque ocurre de forma natural y gradual,
ocurre durante miles o millones de afos y se desarrolla a través de fenébmenos

naturales.

2.2.2.2. Erosion edlica

La erosion edlica ocurre cuando el suelo desnudo se expone a altas velocidades
del viento. Cuando la velocidad del viento crea un arrastre que es mayor que la
gravedad y la fuerza adhesiva de las particulas, transportando las particulas en un
estado suspendido. Las particulas mas pequefias (0,1-0,5 mm) son resbaladizas o
flexibles con el viento (Ada, 2015).

2.2.2.3. Erosién hidrica

Este tipo de erosion surge a causa del agua de lluvia, produciéndose cuando la
gota de lluvia precipita sobre el suelo descubierto, asi como los procesos
hidraulicos que eliminan y transportan las particulas del suelo de las laderas y
taludes (Figura 1) (CENEPRED, 2014).

FLUJO DE AGUA

Figura 1: Consecuencias del flujo de agua sobre un acantilado 1) situacion inicial, 2) pedazo a
desprenderse, 3) linea de corte y 4) erosion del suelo
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2.2.3. FACTORES QUE INTERVIENEN EN LA EROSION HIDRICA

(Vasquez et al, 2016) sefiala que los principales factores que se asocian en la

erosion hidrica son los siguientes:

2.2.3.1. EL SUELO

Las propiedades fisicas del suelo, determinan el grado de resistencia a la
separacion y arrastre de los granulos debido a la influencia del agua sobre el suelo,
su potencial de escorrentia y penetracion.

2.2.3.2. LA TOPOGRAFIA

La pendiente y la longitud de la inclinacion son las principales caracteristicas que
influyen en la topografia del terreno, asimismo se ve incluido la forma y tamafio de

drenaje del area involucrada.

2.2.3.3. EL CLIMA

Los factores climaticos persisten en gran medida en el proceso erosivo, tales como
la precipitacion, el viento y la temperatura. Los mismos que estan relacionados
entre si; ya sea el viento al variar su direccion, velocidad y angulo de caida cuando

ocurren las precipitaciones, afectando sobre su fuerza erosiva.

2.2.3.4. LA VEGETACION

La vegetacidon actia como un colchon sobre la superficie, disminuyendo el golpe
del agua, derivado de la lluvia o escorrentia superficial. La cobertura vegetal
protege al suelo mediante: la disminucion de energia de las gotas de lluvia,
disminucion gradual de la velocidad de escorrentia, facilita el transito vertical del
agua debido a la presencia de raices y residuos de la cubierta vegetal, asimismo

las raices entrelazan las particulas del suelo evitando su desprendimiento.

2.2.3.5. EL HOMBRE

El ser humano es el agente principal y decisivo de todos los procesos de erosion,
fundamentalmente por el papel y la participacion de las personas en la gestién y

uso de los recursos naturales.
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2.2.4. ETAPAS DE LA EROSION HIDRICA
2.2.4.1. EROSION

Es el acto de roer y gastar, causando pérdidas significativas y creando vacios,
reduciendo el volumen (SENAMHI, 2017).

2.24.2. TRANSPORTE

Consiste en desplazar el material desgastado de un lugar a otro, ya sea por el
viento, la gravedad, fuertes pendientes, etc. Estos factores aseguran el transporte
(SENAMHI, 2017).

2.2.4.3. ACUMULACION

El material erosionado luego de ser transportado, produce una acumulacion,
presente en la parte inferior de una laguna o el océano (llamado sedimentacion)

alterando o modificando el relieve involucrado (SENAMHI, 2017).

Desagregacién

Figura 2: Representacién del proceso de erosion: Desagregacion, Transporte y Sedimentacion.

2.2.5. PERDIDA DE SUELO POR EROSION HIDRICA (A)

(Nufez, 2001) Menciona que las pérdidas aceptables o los niveles de erosion,
manejados de manera objetiva, pueden ser una herramienta valiosa para identificar
problemas de erosién y seleccionar métodos de control para minimizar los dafios.
Por supuesto, la disminucion del suelo tolerable consiste en las condiciones del
suelo: si es un suelo con una profundidad considerables y fertilidad constante en
todo su corte transversal, entonces la pérdida de 25 mm en 30 afios en un suelo
superficial serd& mucho menor. En esta situacion, el valor maximo rara vez supera

las 12,5 Tn/ha*afio; y suele ser menos.
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Tabla 1: Niveles de pérdida de suelo en la ecuacion USLE (Universal Soil Loss Equation)

intensidad de amenazas pérdida de suelo (Tm/ha/afio)

Baja Menor a5
Moderada 5-25
Media 25-50
Alta 50-100
Muy alta 100-200
Critica Mas de 200

Fuente: Adaptado de FAO, UNESCO, PNUMA (1 980), citado por
EDESO (1 997), RAMOS (2001, 2009), VELASQUEZ, S (2 008) y
RAMIREZ, L (2 010)

2.2.6. EROSION HIDRICA POTENCIAL Y ACTUAL

(Susana, 2010) menciona, que la erosién hidrica potencial hace referencia al
desarrollo de sus factores en un area especifica por accion de mediadores como el
clima, suelo y relieve. En este caso de erosion se excluye la accion humana y

cobertura vegetal.

Por otro lado, cuando hablamos de erosion hidrica actual o real, involucra el fator

cobertura vegetal y manejo, y el factor de practicas de apoyo a la conservacion.

2.2.7. ECUACION UNIVERSAL DE PERDIDAS DE SUELOS REVISADA
(RUSLE)

La “Ecuacioén Universal de Pérdida de Suelos Revisada” por sus siglas RUSLE, es
una revision y actualizacion de USLE, utilizada ampliamente desde principios de la
década de 1960 y su primera version se describio en Agriculture Handbook N° 282,
publicado en el afio 1965; mientras que su segunda version principal se describio
en Agriculture Handbook N° 537, publicado en 1978. RUSLE es su tercera version
y se describe en el Manual de Agricultura N° 703, publicado en 1996 por el
Departamento de Agricultura de los Estados Unidos de América, Washington D.C.
y conserva -hasta cierto punto- la estructura de ecuaciones de USLE (Camacho et
al 2022).

La ecuaciéon RUSLE esta expresa y compuesta en el sistema métrico internacional

(SI) por los factores siguientes:
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A=R-K-LS-C-P (1)

Donde:

A : Es la pérdida de suelo promedio anual (ton-ha*-afio™).

R : Factor de erosividad de las lluvias (MJ-mm-ha*-hrt-afio™).

K : Es el factor de erodabilidad del suelo (ton-ha-hr-hat-MJ1-mm-).

LS : Factor topogréafico de la longitud L y pendiente S (adimensional).

C : Factor de cobertura vegetal del area de estudio (adimensional).

P : Es el factor de conservacion de la estructura del suelo (adimensional).

2.2.7.1. FACTOR DE EROSIVIDAD DE LA LLUVIA (R)

La energia cinética con la que precipita la lluvia produce erosion, desuniendo los
granulos de suelo, compactando la superficie y produciendo escorrentia superficial
cuando el suelo llega a la saturacion (supera su capacidad de infiltracion)
(Gonzales, 1991).

R=E'I3O (2)

Siendo E la energia de la lluvia determinada a su vez por la formula:
E =210,2+89-logl (3)

E : Es la energia cinética de la lluvia (julios/m2 por cm de lluvia)
I : Es la intensidad maxima de lluvia (cm/h)

30 . es la intensidad maxima en treinta minutos de lluvia (cm/h).

En muchos casos los escases de datos, nos induce a aplicar nuevas metodologias
para determinar este factor, en este caso Wischmeir y Smith (1978) desarrollan la

siguiente formula:

12
R = Z 1,735 x 10(1,5l0g10(Piz/p)—0,08188) (4)
i=1
Donde:
R : Factor de erosividad de lluvias (MJ-mm-ha-hrt.afio?).
Pi : Precipitacion mensual (mm).
p : Precipitacion anual en (mm).
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Tabla 2: Niveles de erosividad (R)

MJ*mm/Ha*Hrs*afio Factor R

0-50 Bajo
50-550 Moderado
550 - 1000 Alto
Mayor a 1000 Muy Alto

Fuente: indice de Fourier, citado por
(Moreno, 2017)

2.2.7.2. FACTOR DE ERODABILIDAD DEL SUELO (K)

El factor K expresa la vulnerabilidad del suelo al desprendimiento y transporte de
sus particulas, influenciada por las propiedades fisicas (textura, estructura, materia
organica, etc.) este factor se evalia en un rango de 0 a 1, el primero sefiala una
pequeia incidencia de erosion mientras que 1 sefiala suelos muy propensos a la
erosion por el recurso hidrico (SENAMHI, 2017).

Teniendo los datos de textura, estructura, permeabilidad y materia organica se
puede determinar el factor K, mediante la ecuacion de Wischmeier y Smith en 1978,

gue se presenta a continuacion:

100K = 2,1M***(107*)(12 —a) + 3,25(b — 2) + 2.5(c — 3) (5)
Donde:
M : (% limo + % arena muy fina) * (% limo + % arena - % arena fina)
a : % de materia organica
b : Parametro de tipo de estructura de suelo
Cc : Clase de permeabilidad

Asimismo, Sharpley y Williams (1990), nos dicen que teniendo los datos de textura
y materia organica en la capa superficial del suelo se puede determinar el factor K

en base a las siguientes ecuaciones:

Kusle = fcsand X fcl—si X f;)rgc X fhisand (6)
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KRusle =K factor = Kusle X 0;1317 (7)

Donde:
fosana = |02+ 03 X exp( ~0,256 X m, X (1-2-%) )
csand ) ) p ) S 100
Myt )0'3
fcl Si (mc + Mgir ( )
3 (1 0,25 X orgC ) 10
forge = orgC + exp[3,75 — 2,95 X orgC] (10)
_ M
_(4 0.7 (1-15%) 1
fhisand - - mg 551+229x (1 mg ( )
(1-1o5) + exp [=551 + 229X (1~ 175)
ms  : % de contenido de fraccion de arena (g de 0,5 — 2 mm)
msit  : % de contenido de fraccion de limo (g de 0,002 — 0,05 mm)
mc : % de contenido de fraccion de arcilla (g < 0,002 mm)

orgC : % de contenido de fraccion de carbono organico

2.2.7.3. FACTOR DE LONGITUD DE LA PENDIENTE E INCLINACION (LS)

Este factor representa longitud de la pendiente y esta vinculado con el factor de
inclinacion “S”, estos factores influyen considerablemente cuando la extension de

la pendiente es mayor que la velocidad de escurrimiento (Caycho, 2020).

Desmert y Groves (1996) presentan la siguiente metodologia para obtener el factor

LS, a través de estas ecuaciones:

m

Y
L= (22.13) (12)
__F 13
=1+ (13)
sinfs/0,0896 (14)

= 3(sinf)"® + 0,56
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Para su uso dentro de los SIG se hace uso de la ecuacion:

[Awjp + D210 — A ™

L(i.j) = xMDM+2(22,13)™ (15)
Donde:
L : Factor de longitud
B : pendiente a nivel de pixel
m . pendiente
F : factor en funcion de la pendiente
D : Tamano de pixel (cell cize)
X : Coeficiente de forma (x = 1 para sistemas pixeleados)
determinado L, se determina el factor S, mediante la siguiente ecuacion:
S 108Slnﬁ(l‘]) + 0,03 tan,[?(l-,]-) < 0,09 16
D=1 16.8sinf;) — 0,5  tanf ) = 0,09 (16)

Tabla 3: Clasificacion del factor LS

Factor LS Categorizacion
Bajo <15

Moderado 15-30

Alto 30-45

Muy Alto >45

Fuente: Instituto Espacial Ecuatoriano (IEE)
citado por (Moreno, 2017)

Tabla 4: Valores de LS en funcion a la pendiente

Grupos de pendientes en % Factor L.S
0-3 0,3
3-12 1,5
12-18 3,4
18-24 5,6
24-30 8,7
30-60 14,6
60-70 20,2
70-100 25,2
>100 28,5

Fuente: Tomado de Ramos Taipe (2001) citado por
(Caycho, 2020)
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2.2.7.4. FACTOR DE COBERTURA DE SUELO (C)

Conocido como factor de vegetacion, representa la efectividad que tiene la cubierta
vegetal para proteger al suelo de la energia de impacto de las gotas de lluvia y la
fuerza del flujo superficial, la cual es adimensional. En USLE, el factor C es
calculado usando ecuaciones empiricas que contienen mediciones de campo de la

cobertura del suelo (Camacho et all, 2022).

Para determinar el factor C a partir de datos de teledeteccion, utilizamos dos
métodos ampliamente utilizados basados en el indice de Vegetacion de Diferencia
Normalizada (NDVI). Varia de 1 a -1, representando los valores mas altos a una
zona con mayor cobertura vegetal (Almagro et all, 2019)

NIR — RED

— - 17
NDVI NIR + RED (7

Tabla 5: Clasificacion de los valores de NDVI

Clasificacion Valor
Nubes y agua (NA) <0,01
Suelo sin vegetacidn (SV) 0,01-0,1
Vegetacion ligera (VL) 0,1-0,2
Vegetacion mediana (VM) 0,2-0,4
Vegetacion alta (VA) >0,4

Fuente: (Lépez et all, 2015)

(Almagro et al ,2019) en su articulo de investigacion plantea las siguientes

ecuaciones para el calculo del factor C:

a) Enfoques de teledeteccion

—NDVI+ 1
Cra=0,1 (#) (18)
NDVI
Cri = e(_“(B—NDVI)) (19)
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El primer método utilizado para estimar el factor C fue propuesto por Durigon et al.
(2014) y adaptado por Colman (2018) (Cra), Y el segundo por van der Knijff et al.
(1999) (Cwk). El Cia y Cuk son calculado siguiendo las Ecuaciones (18) y (19),

respectivamente.

El Cia se basa en el resultado del NDVI en condiciones de clima tropical, con
precipitaciones mas intensas. En relacion con Cvk, Van der Knijff, Jones y
Montanarella (2000) concluyeron que, para las condiciones climéaticas Europeas,
los valores 2 y 1 son los mejores representantes de los parametros de la ecuacion

a 'y B, respectivamente.
b) Enfoque tradicional

Mediante la consulta de literatura del factor C de acuerdo al tipo de cobertura

vegetal.

2.2.7.5. FACTOR DE PRACTICAS DE MANEJO (P)

Conocido como medidas de conservacion, pone en evidencia la eficiencia del
control de la erosion lograda con la implementacion de las medidas de conservacion
de suelos. Este factor adopta diferentes valores en funcion del tipo de practica y
pendiente sobre la que se encuentra; y, cuando no se han implementado practicas

conservacionistas se le asigna el valor de 1 (Camacho et al, 2022).

2.2.8. TELEDETECCION

Es una técnica con la que se obtiene informacién a distancia sin interactuar con el
material, el Unico vinculo que establece con los objetos observados es mediante
sensores y plataformas ubicados en la superficie terrestre, marina o atmosfera, ya

sean satélites, aeronaves, servidores, etc.) (Alonso, 2014).

2.2.9. SISTEMA DE INFORMACION GEOGRAFICA

Este sistema permite integrar varias bases de datos geoespaciales e implementar
varias técnicas para el proceso de datos, relacionando con actividades del espacio,

vinculado con el trabajo SIG (Alonso, 2014).

Las ventajas que presentan los sistemas de informacion geogréaficas al momento

de determinar la erosién, son varias, algunas de esas son las siguientes:
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e Procesar abundantes datos permitiendo calcular variables relacionadas en
el modelo, obteniendo resultados en capas, factores o ecuaciones
matematicas.

e Ejecutar operaciones, distribuir los resultados espacialmente creando

escenarios posibles y con ello mostrar de una manera clara los resultados.

Para implementar estas técnicas de SIG y optimizar los resultados, es conveniente
hacer uso de software ArcGis, mediante sus herramientas o nuevas incorporadas

por el usuario (Zeiler, 1999) citado por (Caycho, 2020).

2.2.10. EL MODELO RASTER

Representa imagenes digitales mediante mallas divididas en filas y columnas
(pixels). Cada celda ha de ser rectangular, aunque no necesariamente cuadrada,
cada una de ellas representa un valor en el sistema proyectado. Los formatos mas

utilizados son: Jpg, png, tiff (Alonso, 2014).

2.2.11. MODELO VECTORIAL

Este modelo es representado mediante vectores, que en conjunto van formando un
todo, por ejemplo, a partir de un par de coordenadas y su altitud se generan puntos,
estos a su vez generan una linea, y estas agrupadas forman poligonos (Alonso,
2014).
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CAPITULO Il
3. MATERIALES Y METODOS
3.1. UBICACION

El proyecto se realizara en la cuenca del rio Tumbes, que forma parte de la vertiente
del pacifico.

3.1.1. UBICACION GEOPOLITICA

Tabla 6: Ubicacion politica de la cuenca del rio Tumbes

Regién Provincia Distritos
Pampas de Hospital, San Jacinto, San
Tumbes .
Tumbes Juan de la Virgen, Corrales, Tumbes
Zarumilla Matapalo

Fuente: (ANA, 2022) https://snirh.ana.gob.pe/observatorioSNIRH/

3.1.2. UBICACION GEODESICA

Tabla 7: ubicacién geodésica de la zona de estudio

ESTE(X) (m) NORTE(Y) (m)
561110,00 9613410,00
537925,00 9533175,00
596940,00 9569607,00
545209,00 9576797,00

Fuente: Elaboracién propia (2022)
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Figura 3: Mapa de ubicacion de la zona en estudio.
Fuente: Elaboracion propia
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3.2.

MATERIALES Y EQUIPOS

3.2.1. MATERIALES

>

Registro de precipitacion acumulada mensual (2000 — 2022).
Para célculo del factor R

Fuente:
e https://www.senamhi.gob.pe/?p=estaciones
e Proyecto Especial Binacional Puyango Tumbes (PEBPT)

Informacién vectorial de las cuencas hidrograficas de Tumbes (Shapefile).
Para delimitar la zona de estudio.

Fuente:
e https://snirh.ana.gob.pe/ObservatorioSNIRH/

Informacion raster de textura de suelos en formato GeoTif.
Para calculo del factor K

Fuente:
e https://soilgrids.org/

Modelo de elevacion digital (DEM) AsterDem.
Para el calculo del factor LS.

Fuente:
e https://geoservidorperu.minam.gob.pe/geoservidor/download raster.aspx

Capa vectorial de carreteras, centros poblados, departamentos, provincias y
distritos.
Para identificar zonas con riesgo de erosion hidrica.

Fuente:
e https://www.geogpsperu.com/

Imagenes satelitales LANDSAT en formato GeoTif.
Para célculo del factor C.

Fuente:
e hitps://earthexplorer.usgs.gov/ afios: 2000, 2005, 2010, 2015y 2020.

Libreta de apuntes

control de informacion.

Lapices, lapiceros, regla y borrador

Para apuntes pertinentes.
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3.2.2. EQUIPOS

Y V VYV V¥V

GPS Garmin E20
Disco externo 1TB

Smartphone
Laptop Hp Core i7

Impresora

3.2.3. SOFTWARE

YV V. V V V V

QGis

ArcGis

Google Earth Pro
Hec 4

R Studio
Paquete Office
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3.3. PROCEDIMIENTO METODOLOGICO
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Figura 4: Esquema metodoldgico de la erosién hidrica actual y potencial.
Fuente: Elaboracion propia.



3.3.1. RECOPILACION DE LA INFORMACION BASICA

Durante la etapa inicial, se llevo a cabo la recopilacion de informacion en la zona
de investigacion, la cual es fundamental para la creacion de los modelos

geoespaciales.

3.3.1.1. Precipitacién media mensual

Se requiere esta informacion para calcular el Factor de Erosividad (R), en un rango
de 23 afos de registros (2000 — 2022), esta informacién fue obtenida de manera
gratuita a través del Servicio Nacional de Meteorologia e Hidrologia (SENAMHI) y

el Proyecto Especial Binacional Puyango Tumbes (PEBPT).

La informacion por parte del SENAMHI se encontr6 disponible en la pagina web:

https://www.senamhi.gob.pe/?p=estaciones,por otro lado, el PEBPT brindd los

datos a través de correo electronico, asimismo se requirio la extraccion de data del
producto PISCO precm para generar dos estaciones virtuales en las areas mas
altas y alejadas de la zona de estudio para una mejor interpolacion, este producto
se obtuvo en la pagina web
https://iridl.Ideo.columbia.edu/SOURCES/.SENAMHI/.HSR/.PISCO/?Set-

Language=es en formato “.nc”, el script de programacion R fue empleado para la

extraccion de los datos de precipitacion, queda especificado en el (Anexo 10). Las

estaciones consideradas para el estudio se detallan en la (Tabla 8) y (Figura 5).

Tabla 8: Estaciones consideradas en el estudio.

Coordenadas Altitud
Estacién Tipo Provincia Distrito UTM (m.s.n.m)
Este (m) Norte (m) T
CamSp:(;r;ento Automatica-Met. Tumbes Tumbes 563348,76 9607466,65 17
La Cruz CO”"&Z‘;'O”""" Tumbes LaCruz  547834,86 9598948,00 6
ElTigre ~ convencional  p hes Pampas de  genao6 10 9579702,76 45
Met. Hospital
CaboInga  Automatica-Met. Tumbes San Jacinto  566404,90 9560507,87 231
~ -~ Contralmirante .
Canaveral Automatica-Met. Villar Casitas 538790,33 9564596,40 133
Matapalo Automética-Met. Zarumilla Matapalo 589005,60 9592898,63 62
V1 Virtual Tumbes San Jacinto  547718,00 9541864,00 972
. Pampas de
V2 Virtual Tumbes ) 584310,00 9567166,00 527
Hospital

Fuente: Elaboracion Propia
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Figura 5: Mapa de estaciones consideradas en el estudio
Fuente: Elaboracién Propia

Los datos de precipitaciones mensual total de las estaciones involucradas se

encuentran en el (Anexo 1).

Analisis de consistencia de datos de precipitacion

Una vez que se ha recolectado la informacion, es importante validarla, procesarla
y resumirla para crear un "producto elaborado" que pueda ser utilizado en el

estudio. Es por eso que previo a la utilizacion de estos datos se le debe realizar el

proceso descrito en la (Figura 6).
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Figura 6: Flujograma para el tratamiento de la informacién Hidrometereol6gica
Fuente: Adaptado de Hidrologia Estadistica, Maximo Villén Béjar

a) Analisis visual grafico

Segun (Villén, 2006) la informacion hidrolégica historica se representa en un gréfico de
coordenadas cartesianas, en el que se ubican los valores de la serie en el eje Y y el
tiempo (afios, meses, dias, etc.) en el eje X. Esta visualizacion inicial permite una
evaluacion preliminar de la calidad y precision de la informacion, antes de proceder a

un andlisis mas detallado mediante la técnica de doble masa. (Anexo 2).

HIDROGRAMA PRECIPITACION ESTACION "CAMPAMENTO SEDE"

—— Precipitacion acumulada mensual (mm)

E B ¥ o8 82 8
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e B8 B
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o
&

&

g 5, 2, %, 4 9 4 o 4,

% % % A % % A

&
-«
&

PERIGDO 2000-2022)

Figura 7: Andlisis visual de 23 afios de precipitacion histérica
Fuente: Elaboracién propia
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b) Analisis doble masa

En este apartado se agrupan las estaciones ploteando en el eje de las abscisas los
acumulados, de estos doble masa se selecciona la estacion mas confiable, la que
presenta el menor nimero de quiebres (y con esta estacidon se vuelven a elaborar
diagramas de doble masa colocando en el eje de las abscisas la estacion base y
en el de las ordenadas la estacion en estudio (Anexo 3).

Acumulado de 4

la eslacion
en estudio

»

n1 n2 n3 Acumulado de la

estacion base

Figura 8: Andlisis doble masa para obtener los periodos de estudio (en este caso nl, n2, n3)
Fuente: (Villén, 2006)

De estos graficos se sacan los periodos dudosos para cada estacion, la misma que

sera tratada con los criterios estadisticos.
c) Analisis estadistico

“Luego de obtener los graficos para el analisis visual y los datos de doble masa, se
identifican los periodos en los que se podrian presentar correcciones y se
determinan los periodos en los que los datos mantendran sus valores originales. A
continuacion, se realiza un analisis estadistico de la media y la desviacién estandar”
(Anexo 5). (Villon, 2006).

d) Completacion y extension

La complementacion de datos se refiere a llenar los espacios vacios que aparecen
en un conjunto de datos. Este proceso es considerado una forma especifica de
extension, ya que se alteran los calculos de los parametros poblacionales. El
modelo de regresién simple es el método matematico mas comun utilizado para
transferir informacion hidrolégica entre estaciones medidas; en este caso se utilizd

el programa HEC — 4 para dicho procedimiento (Anexo 6).
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3.3.1.2. Modelo Digital de Elevacion (DEM)

Se requiere esta informacion para calcular el Factor — LS, la informacion fue
extraida del Geoservidor del Ministerio del Ambiente (MINAM)
https://geoservidorperu.minam.gob.pe/geoservidor/download raster.aspx Se ha

generado un mapa topografico denominado ASTER GDEM (Aster Global Digital
Elevation Model utilizando 1,3 millones de imagenes estéreo obtenidas mediante el
radiometro japonés ASTER. Este mapa se encuentra disponible gratuitamente para
usuarios de todo el mundo y tiene una resolucién espacial de 30 metros. El mapa
hace referencia al geoide WGS84/EGM96, tal como se evidencia en la (Figura 9).

O, ’
< PERU | Ministerio
del Ambiente
SOTWT6 | SOTWTS | S01WT4

>~

$02W77 | S0 / 2

W ﬁn S0 3w71
] W82 | Soawse1
~
S04W82 | S0aW81 / SO4WT9 | SO4WT8 | S04WTT | S W71
P -
S05W82 | S0sW81 hm S05W78 | S0SW77 soks""’82 SOSWE1 | SO0, .71 ]soswro
: ~—]

S06W82 | SOEWS1 | SOBWBO0 | SO6W79 | SO6W78 | SO6WT7 [soowey ’/r/

SOTWS82 | S0O7TWe1 SO?M? SO7VV39 SOTW78 | SOTWT7 | SOTWT6 | SOTWT5 | SOTWT4

508W80 | S0BW79 | S08wW78 | S08W77 | S08W76 | S08WT5 | SoBWa

S0IWS0 | SOIW79 | SOIWTE | SDIWTT | SOOWTE | SO9WT S | SO9WT4 | SOSWT3

S10W79 | S10W78)S10W77|S10W76|S10W75 | S10W74 | S10W73 | S10WT72 S10W71

S11W79 | S11W78 | S11W77 [ S11W76 | S11W75 | S11W74 | S11w73 | S11w72 | s11w71 | s1awro

$12W78|512W77[S12W76 [S12W75|S12W74 | S12W73 | S12W72 [ S12W71 | S12W70 | S 12W88

S13W78|S13WT7 S13W76[S13W75|S13W74 S13WT3[S13WT72[S13W71[S13W70|S13W69

STAWTT [STAWTE|S14AWTS [ST14WT4|S14WT3[S14WT72|S14WT1[S514W70 §14W69

S15W77[S15W76|S15W75[S15W74|S15W73[S15W72{S15W71[S15W70|S15W869

. 2 S16W73 o
S16WT76|S16W75|S16W74 S16WT72|S16W71[S16W70

I A
S1TWTS |S1TWT4|S1TWT3[S1TWT2[S17W71[S17W70]S17W60

S18W73'S18W72 S18W71[S18W70

S19WT71/519W70

Figura 9: Mapa de cobertura de imagenes ASTER (DEM)
Fuente: Ministerio del Ambiente (MINAM)
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https://geoservidorperu.minam.gob.pe/geoservidor/download_raster.aspx

3.3.1.3. Textura (Arcilla, limo y arena) y materia organica (Mo)

Se requiere esta informacion para calcular el Factor — K, para este estudio se utilizé
la informacion provista por el SoilGrids de forma gratuita en la pagina web:

https://soilgrids.org/ “este servidor produce mapas de las propiedades del suelo

para todo el mundo a una resolucion espacial media (250 m de tamano de celda)”

(Poggio et al., 2021), la extension de descarga es en formato raster Geotiff.

< C (Y @ soilgridsorg G W aerwx 00 'l‘f 3

DOWNLOAD DATA

Figura 10: Interfaz de la pagina del SoilGrids
Fuente: SoilGrids

3.3.1.4. Iméagenes LANDSAT

Se requiere esta informaciéon para calcular el Factor — C, estas imagenes fueron
obtenidas de manera gratuita por el Servicio Geoldgico de los Estados Unidos

(USGS por sus siglas en inglés) en la pagina web: https://earthexplorer.usgs.gov/

.el criterio de descarga se realiz6 en dos temporadas (Tabla 9), en el rango de
estudio (2000 — 2022) cada 5 afios (Tabla 10), con una cobertura de nubes <20%.

Tabla 9: Temporadas de adquisicion de imagenes satelitales

Temporada Himeda (verano - otofio) Temporada Seca (invierno - primavera)

22 - dic., Enero, Febrero, Marzo 22 - jun., Julio, Agosto, Setiembre
Abril, Mayo, 21 - Jun. Octubre, Noviembre, 21 - Dic.
Fuente: Elaboracion propia
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Tabla 10: Caracteristicas de las imagenes satelitales utilizadas

Resolucion Fechadela e
Imagen Sensor . Escena Temporada Localizacion
Espacial Imagen

011 - 062

011 - 063 14/10/2000 s

011 ogs 31/05/2000 rumbes
Landsat 7 ETM + 30 mt X 30 mt .

011-062 25/12/2000 Peru

011 -063 Humeda

011 - 062

011 - 063 23/05/2000

011 - 062

011 - 063 07/10/2006 s

011 ogs 041272004 rumbes
Landsat 7 ETM + 30 mt X 30 mt ! ,

011-062 29/05/2005 Peru

011 - 063 Hameda

011 - 062

011 - 063 16/05/2006

011 - 062

011 - 063 02/10/2010 s

gﬂ : 823 19/09/2010 Tumbes -
Landsat 7 ETM + 30 mt X 30 mt ,

011-062 24/03/2010 Peru

011 - 063 Hameda

011 - 062

011 - 063 11/05/2010

011 - 062

011 - 063 24/10/2015 s

811 : 823 07/08/2016 Tumbes -
Landsat8  OLI/TIRS 30mtX30mt ,

011-062 10/02/2015 Peru

011 - 063 Hameda

011 - 062

011 - 063 13/02/2016

011 - 062

011 - 063 17/07/2020 s

811 : 825 02/08/2020 Tumbes -
Landsat8  OLI/TIRS 30mtX30mt ,

011-062 17/06/2020 Peru

011-063 Humeda

011 - 062

011 - 063 17/05/2021

Fuente: Servicio Geoldgico de los Estados Unidos (USGS)

Procesamiento digital de imagenes satelitales

Las imagenes satelitales tanto Landsat 7 y 8 han sido descargadas de la coleccién

2 nivel 1 (Landsat collection 2 level -1), incluyendo las siguientes correcciones:
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Iméagenes Landsat 7

Correccion atmosférica: Esto implica la eliminacion de los efectos de la
atmosfera en la imagen. Los gases atmosféricos y el polvo pueden causar
distorsiones en la imagen, lo que puede hacer que sea dificil interpretarla
correctamente

Correccion de la geometria: Esto implica ajustar la imagen para que sea
geogréaficamente precisa. Esto se hace corrigiendo los errores en la posicion
y la orientacion de la imagen.

Correccion topogréfica: Esta correccion se realiza para corregir las
variaciones topograficas en la imagen. Los cambios de elevacién pueden
causar distorsiones en la imagen, lo que puede hacer que sea dificil

interpretarla correctamente.

Imagenes Landsat 8

Presenta las mismas correcciones que las Landsat 7 incluyendo:

Correccion de la posesion del sol: Esta correccion se realiza para ajustar la
imagen a la posicion exacta del sol en el momento en que se tomo la imagen.
Correccion de banda espuria: Esta correccion se realiza para eliminar los
artefactos de las imagenes que pueden ser causados por la interferencia de

las sefales de la Tierra.

a) Correccion por bandeamiento

Esta correccion se les aplico a las imagenes del Landsat 7, en los afios 2005 y

2010, ya que el 31 de mayo de 2003, el Corrector de Escaneo Lineal (SLC), que

compensa el movimiento de avance del Landsat 7, fracaso. Sin un SLC operativo,

el Thematic Mapper Plus (ETM +) de la linea de visidn mejorada ahora traza un

patron de zig — zag a lo largo de la pista de tierra por satélite.

Para corregir este bandeamiento, se utilizé el Software libre Q-Gis haciendo uso de

la correccidn sin datos, cuya direccion es Raster > Analisis > Rellenar Sin Datos.
(Figura 11).
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Figura 11: Entorno de Q-Gis aplicando la correccion por bandeamiento.
Fuente: Elaboracion propia

Figura 12: Resultado de la correccién por bandeamiento.
Fuente: Elaboracién propia

Este procedimiento fue aplicado a todas las imagenes obtenidas del Landsat 7,

especificamente para la banda 3 y 4.
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3.3.2. APLICACION DEL MODELO (RUSLE)

Una vez que hemos descargado y registrado los datos espaciales geograficos en
la base de datos, tal como se indica en el punto 3.3.1, podemos comenzar a trabajar

en gabinete y, por ende, avanzar con la investigacion.

La metodologia RUSLE, que ha sido mencionada en diferentes secciones del
documento, se compone de 5 factores que deben ser tratados en procesos

individuales y posteriormente combinados mediante una multiplicacion final.

3.3.2.1. Obtencién del factor climético, erosividad (Factor R)

Para su determinacion se utilizé informacién de precipitaciones procedentes de las
estaciones detalladas en la (Tabla 8), una vez realizado el andlisis de consistencia
(Anexo 5) de la informacion se procedio a aplicar la ecuacion desarrollada por
(Wischmeier & Smith,1978) Ec.(4), La formula requiere de dos variables: la
precipitacion mensual y la precipitacion anual, que es la suma de las 12
precipitaciones mensuales de cada afo. Para agilizar el proceso, se emple¢ el

programa Excel (Anexo 9).

Una vez calculado el factor R para cada uno de los afos de estudio (23 afios), se
hizo uso del Software ArcGis 10.5 para realizar la interpolacion con la herramienta

IDW (Peso Inverso de la Distancia) con el siguiente proceso:

a) Se cargaron las estaciones al ArcMap, exportandolas en formato tipo “. Shp”,
seguidamente se realizd la interpolacion ArcToolbox > Spatial Analyst

Tools > Interpolation > IDW.

b) Realizada la interpolacion se obtiene un raster sobresaliente al area de
influencia por lo que es necesario recortar ArcToolbox > Spatial Analyst

Tools > Extraction > Extract By Mask.

c) Finalmente, para una mejor interpretacion se procedi6 a reclasificar en rangos
adecuados de acuerdo al minimo y mayor valor ArcToolbox > Spatial

Analyst Tools > Reclass > Reclassify. Mapas en (Anexo 15 - 38)
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Figura 13: Uso de ModelBuilder para calcular el Factor R - (afio 2000)
Fuente: Elaboracion propia

3.3.2.2. Obtencion del factor suelo (Factor K)

Para este estudio se requirié informacion de porcentaje de arena, arcilla y limo
(textura) y materia organica (M.O) como se precisa en el item 3.3.1.3, esta
informacion es primordial para hacer uso de las férmulas propuestas por Sharpley
y Williams (1990). Se utilizé el software ArcGis 10.5 desarrollando el siguiente

proceso:

a) Teniendo los archivos raster de la textura y materia organica, se procede a
realizar un “Buffer” (el doble del pixel) de la zona de estudio para no tener

pérdidas de informacion ArcToolbox > Analisis Tools > Proximity > Buffer.

b) EIl vector obtenido con el “Buffer” sera nuestra area de estudio, con este se
procede a recortar los raster ArcToolbox > Spatial Analyst Tools >
Extraction > Extract By Mask y le damos <Batch> para hacer un recorte

multiple.

c) Con los raster recortados se realiza una filtracion de los valores (“value” = 1)

ArcToolbox > Spatial Analyst Tools > Extraction > Extract By Attributes.
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d)

f)

g)

h)

)

k)

Al presentarse vacios de informacion en los raster, realizamos un relleno de
informacion ArcToolbox > Spatial Analyst Tools > Neighborhood > Focal
Statistics.

Seguidamente se realiza una conversion de decimales haciendo uso de la
calculadora réster ArcToolbox > Spatial Analyst Tools > Map Algebra >
Raster Calculator. Argumento de ecuacion: (Float(“Limo1C.TIF”)/10).

Teniendo todos estos procesos, calculamos “Fcsana” cON la Ec.(8) para ello
utilizamos la calculadora raster ArcToolbox > Spatial Analyst Tools > Map
Algebra > Raster Calculator. Argumento de ecuacion:
(0.2+0.3*Power(2.71828182845905,(0.256*"ARENA1D.TIF"*(1"LIMO1D.TIF"
/100)))).

Calculamos “Feisi“ con la Ec.(9) ArcToolbox > Spatial Analyst Tools > Map
Algebra > Raster Calculator. Argumento de ecuacion:
Power(("LIMO1D.TIF"/("ARCILLA1D.TIF"+"LIMO1D.TIF")),0.3)

Calculamos “Forc” con la Ec.(10) ArcToolbox > Spatial Analyst Tools > Map
Algebra > Raster Calculator. Argumento de ecuacion: (1-
(0.25*"CARBONO1D.TIF"/("CARBONO1D.TIF"+Power(2.71828182845905,(
3.75-2.95*'CARBONO1D.TIF")))))

Calculamos “Frisand“ con la Ec.(11) ArcToolbox > Spatial Analyst Tools >
Map Algebra > Raster Calculator. Argumento de ecuacion: (1-((0.7*(1-
"ARENALD.TIF"/100))/((1"ARENA1D.TIF"/100)+Power(2.71828182845905,(
5.51+22.9%(1-"ARENAL1D.TIF"/100))))))

Calculamos “Kusie” con la Ec.(6) ArcToolbox > Spatial Analyst Tools > Map
Algebra > Raster Calculator. Argumento de ecuacion:
"Fhisand.tif"*"Forgc.tif"*"Fcl-si.tif"*"Fcsand.tif"

Calculamos “Kiusie” con la Ec.(7) ArcToolbox > Spatial Analyst Tools > Map

Algebra > Raster Calculator. Argumento de ecuacion: "Kusle.tif"*0.1317

Finalmente recortamos el raster a nuestra area de estudio ArcToolbox >
Spatial Analyst Tools > Extraction > Extract By Mask. Mapa en (Anexo
39)
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Figura 14: Uso de ModelBuilder para calcular el Factor K

Fuente: Elaboracion propia.

=) FACTORK
(Tn.ha.h)/(MJ.mm.Ha)
[]0.01406 - 0.01483
[10.01484 - 0.0152
[ 0.01521 - 0.01548
[ 0.01549 - 0.01579
[ 0.0158 - 0.01633

Figura 15: Representacion grafica del Factor K
Fuente: Elaboracién propia

3.3.2.3. Obtencion del factor relieve (Factor—-LS)

Para hallar este factor, se utilizaron las imagenes ASTER GDEM obtenidas del
MINAN como se precisa en el item 3.3.1.2 , previo a esto también se pobo con el
DEM SRTM proporcionado por la USGS, pero las correcciones eran mayores ya
gue presentaba valores negativos. Teniendo esta informacion ya se puede hacer

uso de las formulas planteadas por Desmert y Groves (1996), Se utilizo el software

ArcGis 10.5 desarrollando el siguiente proceso:
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a)

b)

d)

f)

g9)

h)

)

Ya que la zona de estudio abarca dos cuadrantes (S04W81 y SO5W81) es
necesario unir ArcToolbox > Data Management Tools > Raster > Raster
Dataset > Mosaic To New Raster.

Una vez unidos los dos cuadrantes realizamos una correccion por relleno

ArcToolbox > Spatial Analyst Tools > Hydrology > Fill.

Realizado el relleno de informacion se procede a recortar de acuerdo al area
de estudio ArcToolbox > Spatial Analyst Tools < Extraction < Extract By
Mask.

Luego procedemos a calcular la pendiente en grados, este vendria a ser mi
valor de B (pendiente a nivel de pixel) ArcToolbox > Spatial Analyst Tools
> Surface > Slope.

Ya con el raster de pendientes se utiliza la Ec.(14) para encontrar “F”, cabe
resaltar que a B se le multiplica por 0.01745 para transformar de grados a
radianes ArcToolbox > Spatial Analyst Tools > Map Algebra > Raster
Calculator. Argumento de ecuacion:
(SINn("BETA.TIF"*0.01745)/0.0896)/(3*Power(Sin("BETA.TIF"*0.01745),0.8)
0.56)

Luego para encontrar “m” se hace uso de la Ec.(13) ArcToolbox > Spatial
Analyst Tools > Map Algebra > Raster Calculator. Argumento de ecuacion:
"F.TIF'/(1+"F.TIF")

Seguidamente calculamos la direccion del flujo con el raster corregido por “Fill”

ArcToolbox > Spatial Analyst Tools > Hydrology > Flow Direction.

Seguido de aquello calculamos la acumulacion del flujo ArcToolbox > Spatial

Analyst Tools > Hydrology > Flow Acumulation.

Por consiguiente, calculamos el Factor de longitud (L) de acuerdo a la Ec.(15)
ArcToolbox > Spatial Analyst Tools > Map Algebra > Raster Calculator.
Argumento de ecuacion:
(Power(("FLOW_ACUM.TIF"+30.79*30.79),("m.TIF"+1))Power("FLOW_ACU
M.TIF",("m.TIF" + 1))) / (Power(30.79,("m.TIF" + 2)) * Power(22.13,"m.TIF"))

Luego calculamos en factor S de acuerdo a la Ec.(16) ArcToolbox > Spatial

Analyst Tools > Map Algebra > Raster Calculator. Argumento de ecuacion:
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Con(Tan("BETA.TIF"*0.01745)<0.09,10.8*Sin("BETA.TIF"*0.01745)+0.03,16
8*Sin("BETA.TIF"*0.01745)-0.5)

k) Ahora teniendo “L” y “S” pasamos a calcular el Factor LS ArcToolbox >
Spatial Analyst Tools > Map Algebra > Raster Calculator. Argumento de
ecuacion: “FACTOR S.TIF"™"FACTOR L.TIF”.

l) Finalmente le damos el valor de celda (pixel) con el que se esté trabajando
(100 m X 100 m) ArcToolbox > Data Management Tools > Raster >
Resample. Mapa en (Anexo 40).
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Figura 16: Uso de ModelBuilder para calcular el Factor LS
Fuente: Elaboracién propia

5 @ FACTORLS
[C1<5BAJO
[15-10 MODERADO
[Z110-20 MEDIANO
[ 20-50 ALTO
[ 50-100 MUY ALTO
I >100 CRIMICO

Figura 17: Representacion gréfica del Factor LS
Fuente: Elaboracién propia
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3.3.2.4. Obtencion del factor cobertura vegetal (Factor C)

El factor cobertura vegetal se trabajo con las imagenes satelitales obtenidas del
Landsat 7 y 8 como se muestra en el item 3.3.1.4, para ello se utiliz6 la metodologia
planteada por (Almagro et al, 2019), este método nos dice que para obtener el NDVI
de cierto afio se debe considerar las estaciones secas y humedas, es decir que se
procesaron las imagenes satelitales en temporada humedad (verano y otofio) y
temporada seca (invierno y primavera) y con ello promediar el NDVI para dicho afio.
Se utilizo el software ArcGis 10.5 desarrollando el siguiente proceso:

a) Ya que el area en estudio abarca dos escenas es necesario realizar un
mosaico de ambas, cabe mencionar que en todo el proceso se va a trabajar
Unicamente con dos bandas (B3 yB4 para Landsat 7 y B4 y B5 para Landsat
8) ArcToolbox > Data Management Tools > Raster > Raster Dataset >
Mosaic To New Raster.

b) Seguidamente realizar el calculo del NDVI con la Ec.(17), este procedimiento
va a depender del satélite ArcToolbox > Spatial Analyst Tools > Map
Algebra > Raster Calculator. Argumento  de  ecuacion:
Float("B4_H_CT.TIF"-"B3_H_CT.TIF")/Float("B4_H_CT.TIF"+"B3_H_CT.

c) Teniendo los NDVI para cada temporada, le sacamos el promedio
ArcToolbox > Spatial Analyst Tools > Map Algebra > Raster Calculator.
Argumento de ecuacion: ("NDVI_S.TIF"+"NDVI_H.TIF")/2

d) Ahora calculamos el factor C de acuerdo con la Ec.(18) ArcToolbox > Spatial
Analyst Tools > Map Algebra > Raster Calculator. Argumento de ecuacion:
0.1*((-"NDVI_2000.TIF"+1)/2).

e) Finalmente le damos el valor de celda (pixel) con el que se esta trabajando
(100 m X 100 m) ArcToolbox > Data Management Tools > Raster >

Resample. Mapas en (Anexo 41 - 45).
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Figura 18: Uso de ModelBuilder para calcular el Factor C
Fuente: Elaboracion propia

= M FACTORC
<0.03149
[10.03149 - 0.03669
[10.03669 - 0.04189
[10.04189 - 0.04969
[ >0.04969

Figura 19: Representacion gréfica del Factor C — (Afio — 2000)
Fuente: Elaboracién propia
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3.3.2.5. Obtencién del Factor P

En varios estudios realizados en cuencas y microcuencas en el Peru, se da 1 como
valor para el factor P, debido a que no se cuenta con la informacion necesaria de
estas practicas o caso contrario no se hacen, es asi que se utilizé este valor 1 para
no reducir la precision de la ecuacion (Peralta, 2016) citado por (Morante &
Gonzales, 2019).

=] FACTORP
Value

=1

Figura 20: Representacion grafica del Factor P
Fuente: Elaboracién propia

3.3.2.6. Obtencion de la erosion hidrica actual y potencial

Para producir el mapa anual de erosiones, se emple6 el Software ArcGis, luego de
haber obtenido los factores R, K, LS, C y P necesarios para la ecuacion RUSLE,
todos ellos con una resolucion de celda de 100 metros, se llevo a cabo el modelado
geoespacial. Para integrar las variables, se utiliz6 la funcion Raster Calculator,
multiplicando los pardmetros obtenidos ArcToolbox > Spatial Analyst Tools >
Map Algebra > Raster Calculator. Mapas de erosion potencial en (Anexo 48 -

70).y mapas de erosion actual en (Anexo 72 - 94).
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Figura 21: Uso de ModelBuilder para calcular la Erosién Hidrica Actual_EA (Afio-2000)
Fuente: Elaboracion propia
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e
POTENCIAL
= [ EROSION POTENCIAL 2005
Tn/Ha*Afo
FACTORR I <5BAJA
I 5 - 25 MODERADA
[125 - 50 MEDIANA

150 - 100 ALTA
[ 100 - 200 MUY ALTA
I > 200 CRITICA

Figura 22: Uso de ModelBuilder para calcular la Erosién Hidrica Potencial_EP (Afio-2005)
Fuente: Elaboracion propia
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CAPITULO IV

4. RESULTADOS Y DISCUSION

4.1.

RESULTADOS DEL PROCESAMIENTO DE LAS VARIABLES
4.1.1. FACTOR R (EROSIVIDAD DE LA LLUVIA)

Se presenta en la (Tabla 11) la informacién correspondiente al factor de erosividad

de la lluvia para cada estacion y afio de estudio. Se puede observar que el valor

maximo se encuentra en la estacion "V1", con un registro de 24 385,52

Mj*mm/Ha*Hr*Afo en el afio 2001. Por otro lado, el valor minimo se evidencia en

la estacion "Cafaveral”, con un registro de 22,27 Mj*mm/Ha*Hr*Afio en el afio 2022.

Tabla 11: Factor R para cada estacion y por cada afio de analisis.

ARG ESTACIONES
CAMPAMENTO LA CABO <
SEDE CRUZ EL TIGRE INGA CANAVERAL MATAPALO Vi V2

2000 292,27 240,19 858,67 2 360,45 353,73 2 188,90 31313,14 397711
2001 1 660,42 247694 3470,26 5155,87 2 375,66 2 809,15 24 385,52 3745,73
2002 333543 1731,15 3670,06 6211,30 3 295,30 2 025,74 12 254,31 21 198,41
2003 231,43 55,84 553,01 135144 132,70 628,98 1337,01 888,59
2004 226,82 187,47 782,36 1162,72 261,72 878,69 845,09 1041,37
2005 333,25 234,94 873,91  2465,14 128,52 1 003,41 2 775,53 955,40
2006 3 706,68 1864,31 3964,09 465587 1871,13 7 990,93 12 579,33 4 461,76
2007 440,05 709,68 602,81  1967,93 792,88 2721,09 4724,42 1701,49
2008 2690,10 279296 323057 4950,48 2117,86 4 387,26 16 750,39 6 915,39
2009 1 422,66 16259 2054,24 560283 1 890,46 2527,21 7 705,43 11 106,78
2010 1779,07 1112,62 1678,63 594280 1082,47 2 849,35 6 084,53 407255
2011 150,12 446,37 709,48 6 776,67 771,47 1612,07 1266,04 9 061,62
2012 938,60 708,99 223361 7024,80 2 915,76 1 945,61 20 352,54 10870,92
2013 644,53 803,34 123815 2 306,02 1 706,08 4 226,96 570052 1136,38
2014 200,76 100,14 320,84 982,19 153,77 816,44 265,05 228,08
2015 5332,38 229422 3157,04 6486,17 3 255,67 4 879,16 11 824,13 4 244,38
2016 2 362,46 1439,27 3616,92 4 444,00 1 869,38 5189,62 6518,28 6693,13
2017 3 504,59 5063,11 2911,83 781591 1 667,03 4 966,16 7 238,23  9443,35
2018 115,27 197,95 674,30 357,29 112,44 763,05 142,66 266,06
2019 415,21 605,78 187449 3194,10 968,09 3 464,95 4 268,29 2883,75
2020 1 093,76 458,67 1029,32 865,52 327,01 1 395,44 2599,01 1420,74
2021 355,72 285,10 1527,19 152491 915,76 1 695,26 6111,29 189841
2022 407,20 113,15 304,99 1261,73 22,27 1177,93 3604,90 1 468,36

Fuente: Elaboracion propia

La (Figura 23), muestra los valores del factor R promedio por cada afio de estudio,

donde podemos observar que el valor maximo promedio obtenido 7 371,60

Mj*mm/Ha*Hr*Afo para el afio 2002, por otro lado, el valor minimo promedio 362,62

Mj*mm/Ha*Hr*Afo lo encontramos en el afio 2018.
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Figura 23: Factor R promedio para los 23 afios de estudio.
Fuente: Elaboracion propia.

Los resultados sobre el factor R promedio para las 8 estaciones meteoroldgicas
durante los 23 afios de estudio se encuentra en la (Tabla 12) y la (Figura 24). La
estacion "V1" presenta el valor maximo promedio de 7 063,64 Mj*mm/Ha*Hr*Afo,
mientras que el valor minimo promedio de 1 110,79 Mj*mm/Ha*Hr*Afo se registra
en la estacion "La Cruz". Ademas, se muestra una relacion consistente entre la
precipitacion total anual y el factor R, con un coeficiente de determinacion (R2 =

0,70) como se puede observar en la figura. (Figura 25).

Tabla 12: Valores promedio del Factor R, en las 8 estaciones meteoroldgicas.

ESTACION menm __ MPAMM i)
CAMPAMENTO SEDE 17 305,89 1 375,60
LA CRUZ 6 256,97 1110,79
EL TIGRE 45 479,70 1797,25
CABO INGA 231 835,55 3 689,83
CANAVERAL 133 317,84 1 260,31
MATAPALO 62 700,85 2701,88
Vi 972 806,56 7 063,64
V2 527 884,59 4 768,68

Fuente: Elaboracién propia.
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Figura 24: Factor R promedio por estacion meteoroldgica.
Fuente: Elaboracion propia.
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Figura 25: Relacion entre el factor R y la precipitacion

Fuente: Elaboracion propia
En la (Tabla 13) y la (Figura 26), se muestran los resultados del factor R por area
y porcentaje para la cuenca Tumbes (zona estudiada) con valores de agresividad
de la lluvia de 1 500 a 3 000 Mj*mm/Ha*Hr*Afio que abarca un area de 49,85% (82
919,95 Ha) siendo las zonas con altitud promedio y mayor a 6 000
Mj*mm/Ha*Hr*Afo con una area de 4,49% (7 468,83 Ha) para las zonas con mayor
altitud, con lo que se puede decir que el factor erosividad de la lluvia es un factor

determinante en esta cuenca.
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Tabla 13: Valores del Factor R promedio (2000-2022)

Nro. Rango Clasificacion Area (Ha)  Area (%)
1 < 1500 12 792,54 7,69
3 1500 - 3000 82 919,95 49,85
4 3000 - 4500 Muy Alto 51 184,91 30,77
5 4500 - 6000 11 961,70 7,19
2 > 6000 7 468,83 4,49
Total 166 327,93 100

Fuente: Elaboracion propia
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Figura 26: Factor R promedio
Fuente: Elaboracion propia

4.1.2. FACTOR K (ERODABILIDAD DEL SUELO)

La (Tabla 14) y (Figura 27), muestra la distribucion de los niveles de Factor K en
el dmbito de estudio, se aprecia que los valores de 0,01521 a 0,01548
Ton*ha*h/Mj*mm*ha son los que predominan con 29,54% (49 138,45 Ha) de los
suelos, por consiguiente, los valores de 0,00140 a 0,01483 Ton*ha*h/Mj*mm*ha
representan el 5,37% (8 929,21 Ha), todos estos valores bajo la clasificacion de

suelos de poca erodabilidad.

Tabla 14: Valores del Factor K representativos de la cuenca Tumbes.

Nro. Rango Clasificacion  Area (Ha) Area (%)
1 0.001406 - 0.01483 8929.21 5.37
2 0.01484 - 0.01520 28358.96 17.05
Muy poco
4 0.01549 - 0.01579 48229.31 29.00
5 0.0158 - 0.01633 31672.02 19.04
Total 166327.93 100.00

Fuente: Elaboracién propia
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Figura 27: Distribucion del factor K
Fuente: Elaboracion propia

La (Tabla 15) y la (Figura 28) presentan la clasificacion textural del suelo y sus
valores de erodabilidad en la cuenca. Se observa la distribucibn geométrica en
hectareas y se destaca que el 43,89% del area total esta compuesto por suelo
Franco Arcillo Arenoso (FAa) con un factor de 0,01560 y en menor proporcion el
24,70% representando un suelo Arcilloso con un factor de 0,01542, todo esto pone

en evidencia la alta erodabilidad de los suelos de textura fina.

Tabla 15: Distribucion del factor K en relacion con las clases texturales.

Nro. Textura Factor K Area(Ha) Area (%)
1 Franco Arcillo Arenoso  0,01560 72 995,86 43,89
2 Franco Arenoso 0,01535 52 254,93 31,42
3 Arcilloso 0,01542 41 077,14 24,70

Total 166 327,93 100,00
Fuente: Elaboracion propia
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Figura 28: Representacion gréfica de la textura de suelo y factor K.
Fuente: Elaboracion propia.
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4.1.3. FACTOR LS (TOPOGRAFIA)

La (Tabla 16) y la (Figura 29) reflejan los resultados del factor LS, donde un 77,91%
(129 585,66 Ha), evidencian valores bajos ubicados en la parte media y baja de la
cuenca, esto debido a que las zonas son llanas, mientras que un 0,01% (10,37 Ha)
presentan valores criticos en la parte alta de la cuenca en relacion a las areas

empinadas que se muestran en esa zona.

Tabla 16: Resultados del Factor LS en la zona de estudio.

Nro. Rango Clasificacion  Area (Ha)  Area (%)
1 <5 BAJO 129 585,66 77,91
2 5-10 MODERADO 32 405,70 19,48
3 10 - 20 MEDIANO 4 265,03 2,56
4 20 -50 ALTO 51,79 0,03
5 50 - 100 MUY ALTO 9,37 0,01
6 >100 CRITICO 10,37 0,01

Fuente: Elaboracion propia
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Figura 29: Representacion gréfica del factor LS
Fuente: Elaboracion propia

Por otra parte, podemos evidenciar en la (Figura 30), la relacion que existe entre
la variable dependiente (pendiente %) siendo explicada por la variable

independiente (Factor LS) con un coeficiente de determinacién de Rz =0,996.
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Figura 30: Relacién entre factor LS y la pendiente

Fuente: Elaboracién propia

4.1.4. FACTOR C (COBERTURA VEGETAL)

Teniendo en cuenta el indice Normalizado de Diferencias de Vegetacion (NDVI),

como se exhibe en la (Tabla 17) y la (Figura 31), se puede evidenciar que para el

rango de estudio la vegetaciéon mediana (VM) es la que se hace mas recurrente con

un valor maximo de 76,95% (127 984,87 Ha) para el afio 2010, por otra parte, para

el aflo 2005 se presento el valor minimo de 43,35% (72 100,60 Ha).

Tabla 17: Valores del NDVI para el afio 2000, 2005, 2010, 2015 y 2020.

Afio 200 Afio 2005
Nro.  Rango Clasificacion Area(Ha) Area (%) Nro.  Rango Clasificacion Area(Ha) Area (%)
1 <0.01 Nuves y Agua (NA) 8618.77 5.18 1 <0.01 Nuvesy Agua (NA) 19177.79 11.53
2 0.01-0.1  SuelossinVegetacion (SV)  10299.22 6.19 2 0.01-0.1  SuelossinVegetacion (SV)  29453.68 17.71
3 01-02 Vegetacion Ligera (VL) 29055.82 17.47 3 0.1-02 Vegetacion Ligera (VL) 40779.62 24.52
4 0.2-04 Vegetacion Mediana (VM)  99422.81 59.78 4 0.2-04 Vegetacion Mediana (VM) 72100.60 43.35
5 >0.4 Vegetacion Alta (VA) 18931.31 11.38 5 >0.4 Vegetacion Alta (VA) 4816.24 2.90
Total 166327.93 100 Total 166327.93 100
Afio 2010 Afio 2015
Nro.  Rango Clasificacion Area(Ha)  Area (%) Nro.  Rango Clasificacion Area(Ha) Area(%)
1 <0.01 Nuvesy Agua (NA) 4503.12 271 1 <0.01 Nuvesy Agua (NA) 2153.72 1.29
2 001-01 SuelossinVegetacion (SV)  2796.26 1.68 2 001-01 SuelossinVegetacion (SV)  2018.75 1.21
3 01-0.2 Vegetacion Ligera (VL) 12469.60 7.50 3 0.1-0.2 Vegetacion Ligera (VL) 23491.21 14.12
4 0.2-0.4  Vegetacion Mediana (VM)  127984.87 76.95 4 0.2-0.4  Vegetacion Mediana (VM)  104619.84 62.90
5 >0.4 Vegetacion Alta (VA) 18574.08 11.17 5 >0.4 Vegetacion Alta (VA) 34044.40 20.47
Total 166327.93 100 Total 166327.93 100
Afio 2020
Nro. Rango Clasificacion Area(Ha) Area (%)

1 <0.01 Nuvesy Agua (NA) 1493.54 0.90

2 0.01-0.1 SuelossinVegetacion(SV)  3022.17 1.82

3 01-0.2 Vegetacion Ligera (VL) 40416.46 24.30

4 0.2-0.4  Vegetacion Mediana (VM)  110177.57 66.24

5 >0.4 Vegetacion Alta (VA) 11218.20 6.74

Total 166327.93 100

Fuente: Elaboracion propia
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Figura 31: Representacion gréfica de los valores de NDVI

Elaboracion propia

En la siguiente (Tabla 18) y la (Figura 32) se revelan los registros que adquiere C
a lo largo del area de investigacion, teniendo como valor maximo 50,08% (83
292,48 Ha) con un valor de Factor C de 0,03149 a 0,03669 presente en el afio 2010,
por otra parte en menor proporcion con 0,79% (1 312,80 Ha) con un valor mayor a
0,04969 evidenciado en el afio 2020, todos estos bajo la clasificacion de alto,
relacionado con el tipo de cobertura (Anexo 13) donde el mayor porcentaje de la
cuenca es ocupada por bosque seco de montafia con un 34,64% del area total en

la parte media y alta, ademas en menor porcentaje 0,011% de estero en la parte

baja de la cuenca.
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Tabla 18: Valores del factor C para el afio 2000, 2005, 2010, 2015 y 2020.

Afo 200 Afio 2005
Nro. Rango Clasificaciéon Area(Ha) Area (%) Nro. Rango Clasificaciéon Area(Ha) Area (%)
1 <0.03149 28468.38 17.12 1 <0.03149 12883.73 7.75
2 0.03149- 0.03669 59130.94 35.55 2 0.03149- 0.03669 37430.72 22.50
3 0.03669- 0.04189 Alto 43233.00 25.99 3 0.03669- 0.04189 Alto 45498.48 27.35
4 0.04189- 0.04969 27488.38 16.53 4 0.04189- 0.04969 52998.42 31.86
5 >0.04969 8007.22 4.81 5 >0.04969 17516.59 10.53
Total 166327.93 100 Total 166327.93 100
Afio 2010 Afio 2015
Nro. Rango Clasificacion Area(Ha) Area (%) Nro. Rango Clasificacion Area(Ha) Area(%)
1 <0.0314% 33661.52 20.24 1 <0.0314% 55771.41 33.53
2 0.03149- 0.0366% 83292.48 50.08 2 0.03149- 0.03669 59415.04 35.72
3 0.03669- 0.0418% Alto 37039.22 22.27 3 0.03669- 0.04189 Alto 38488.80 23.14
4 0.04189- 0.04969 8000.10 4.81 4 0.04189- 0.04969 10605.47 6.38
5 >0.04969 4334.61 2.61 5 >0.04969 2047.20 1.23
Total 166327.93 100 Total 166327.93 100
Afio 2020
Nro. Rango Clasificacion Area(Ha) Area(%)
1 <0.03149 22899.87 13.77
2 0.03149- 0.03669 58274.94 35.04
3 0.03668- 0.0418% Alto 62497.26 37.57
4 0.04189- 0.04969 21343.06 12.83
5 >0.04969 1312.80 0.79
Total 166327.93 100
Fuente: Elaboracion propia
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Figura 32: Representacion gréfica de los valores del Factor C
Fuente: Elaboracion propia




En la (Figura 33), podemos apreciar un coeficiente maximo de determinacion R2
=0,997 para el afio 2010 y un coeficiente minimo de R2 = 0,949 para el afio 2020,
para todos los afios estudiados se les considera que existe una relacion entre la
variable dependiente (NDVI) siendo explicada por la variable independiente (Factor
C).
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Figura 33: Relacion entre el NDVI y el Factor C, para los afios 2000, 2005, 2010, 2015 y 2020.
Fuente: Elaboracion propia

4.1.5. FACTOR P (SUELO)

Como se puso en manifiesto en el item 3.3.2.5 se dio el valor de 1, para no reducir

la precision de la ecuacion.
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4.1.6. EROSION HIDRICA ACTUAL Y POTENCIAL

De las (Tabla 19 y 20) y de las (Figura 34 y 35), se observa la pérdida de suelo
por erosién hidrica actual y potencial, es oportuno aclarar que para este calculo de
la Gltima no se tomo en cuenta el uso factor ¢ ni tampoco el factor p, en este sentido
se aprecia que el nivel maximo promedio de erosién actual y potencial 14.36 y
420.44 Tn/Ha/Afo respectivamente se obtuvieron en el afio 2002 y el valor minimo
de erosion actual y potencial 0.02 y 18.32 Tn/Ha/Afo para el afio 2010 y 2018
respectivamente, cabe resaltar los 4 primeros valores maximos se dieron en el afio

2002, 2008, 2012 y 2017, presentando un escenario critico, debido a las altas

precipitaciones tal es el caso del nifio costero.

Tabla 19: Pérdida de suelo por erosion potencial

Pérdida de suelo por afio del
periodo 2000 - 2022 Tn/Ha*Afo

2000
2001
2002
2003
2004
2005
2006
2007
2008
2009
2010
2011
2012
2013
2014
2015
2016
2017
2018
2019
2020
2021
2022

101,89
301,07
420,44
41,13
41,52
68,31
253,71
84,94
289,16
261,18
180,25
190,63
348,38
102,87
21,91
260,54
223,56
296,51
18,32
124,98
58,96
97,43
57,55

Fuente: Elaboracién propia
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Tabla 20: Pérdida de suelo por erosién actual

Pérdida de suelo por afio del
periodo 2000 - 2022 Tn/Ha*Afio

2000
2001
2002
2003
2004
2005
2006
2007
2008
2009
2010
2011
2012
2013
2014
2015
2016
2017
2018
2019
2020
2021
2022

3,47
10,00
14,36
1,41
1,43
2,59
0,04
3,20
10,92
9,70
0,02
6,28
11,51
3,44
0,73
8,47
7,18
9,50
0,60
4,02
2,08
3,44
2,01

Fuente: Elaboracién propia
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Figura 34: Erosién Actual promedio para los 23 afios de estudio
Fuente: Elaboracion propia
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Figura 35: Erosion Potencial promedio para los 23 afios de estudio

Fuente: Elaboracion propia
La (Tabla 21) y la (Figura 36), exhiben la erosién hidrica actual y potencial, donde;
los rangos de erosion baja (< 5 Tn/Ha/Afo) alcanza un 58,16% para la erosion
actual (96 738,12 Ha) de forma contraria los niveles de erosion critica (>200
Tn/Ha/ARo) alcanza un 31,92% para la erosién potencial (53 085,80 Ha), si
resaltamos estos resultados con el mapa obtenido, podemos ubicar que la erosién

72



baja en mayor porcentaje se da en las zona media y baja de la cuenca, sin embargo
los niveles de erosion critica se desarrollan principalmente en la cabecera de la
cuenca, esto debido a las altas precipitaciones y pendientes que se involucran en
esa zona.

Tabla 21: Niveles de erosion hidrica actual y potencial a nivel de cuenca.

Nro. Rango Clasificacion — Erosion Ac'tual : Erosion Pot?ncial
Area(Ha) Area(%) Area(Ha) Area (%)
1 <5 Baja 96 738,12 58,16 13 487,34 8,11
2 5-25 Moderada 65 919,43 39,63 23 438,46 14,09
3 25-50 Mediana 2 410,35 1,45 20 475,90 12,31
4 50 - 100 Alta 438,03 0,26 25 463,62 15,31
5 100 - 200 Muy alta 412,49 0,25 30 376,80 18,26
6 > 200 Critica 409,51 0,25 53 085,80 31,92
Total 166 327,93 100 166 327,93 100

Fuente: Elaboracion propia

B EROSION POTENCIAL  ® EROSION ACTUAL

70.00

60.00 58.16%

50.00

39.63%
< 40.00

31.92%

rea (%

\

A

30.00

20.00

14.099

18.26%
1000 1%

15.31%
12.31%
I I1.45% Io_zs% 0.25% 0.25%
0.00 -

Baja Moderada Mediana Alta Muy alta Critica

Figura 36: Niveles de erosién hidrica actual y potencial a nivel de cunca.
Fuente: Elaboracién propia
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4.2. DISCUSION DE LOS RESULTADOS

Los resultados del factor R en este estudio de la cuenca del rio Tumbes fueron
obtenidos a través de 8 estaciones meteoroldgicas, cuyos valores oscilan entre 1
274,63 a 7 063,55 Mj*mm/Ha*Hr*Afo. ver (Anexo 38), (Moreno, 2017) considera
que valores mayores a 1000 Mj*mm/Ha*Hr*Afio toman la clasificacion de “muy alto”,
donde claramente podemos asumir que la agresividad por las lluvias esta presente
en toda la zona de estudio, haciéndose mas pronunciada en las zonas altas donde
se presentan moédulos pluviométricos anuales (MPA) que llegan a 800 mm ver
(Anexo 11), estando de acuerdo con (Atauje, 2018) donde sefala que, “en las
zonas de mayor altitud las precipitaciones son mayores”, a todo esto se puede
evidenciar que existe una relacion estrecha entre el factor r y la precipitacion
(R2=0,70) ver (Figura 25), tal como lo menciona (Ramirez, 2007) citado por (Atauje,
2018), “que existe una conexidon clara entre la erosividad y la cantidad de
precipitacion anual. Esta relacion se deriva de la definicion misma del indice de
erosividad; de la misma forma (Mendes et al., 2018) acotan que, “el factor R se ve
influenciado por la topografia y variacion climéatica regional, con mayor erosividad
asociada a las mayores altitudes”. Por otra parte, en el estudio realizado por (Dioses
& Pérez, 2018) para la cuenca del rio Piura, obtuvieron valores para el factor de
erosividad R de 1 500,67 a 10 582,07 Mj*mm/Ha*Hr*Afo, por lo que se puede inferir
gue estos resultados son similares a los de esta investigacion, ya sea porque
ambas cuencas se encuentran en la region hidrografica del Pacifico, el método
utilizado de Wischmeir y Smith (1978), el uso de los SIG y el registro de

precipitaciones.

Respecto al factor de erosionabilidad K, los valores resultantes oscilan en el rango
de 0,00140 a 0,01633 Ton*ha*h/Mj*mm*ha ver (Anexo 39), segun la clasificacion
USDA (1962), citado por (Amezquita, 1990) toma en cuenta que, para valores
menores a 0.0775 se la atribuye la clasificacion de “Muy poco erodable”, estos
resultados concuerdan con los obtenidos por (Camacho et al., 2022) para la cuenca
Cumbaza con valores que oscilan entre 0,0145 a 0,0168 Ton*ha*h/Mj*mm*ha, los
valores mas bajos de erosionabilidad corresponden a suelos de textura arcillo
arenoso y franco arcillo arenoso y los valores medios a suelos de textura franco,
concordando asi con los resultados obtenidos ver (Tabla 15) donde el valor

promedio para los suelos de textura fina (arcilloso) y modernamente fina (franco
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arcillo arenoso) fueron de 0,01542 y 0,01560 Ton*ha*h/Mj*mm*ha respectivamente,
sin embargo para suelos de textura gruesa (franco arenoso) fue de 0,01535
Ton*ha*h/Mj*mm*ha, esto a su vez da a entender que los suelos de textura fina van
a tender a ser mas erosionables debido a que su permeabilidad sera menor por su
contenido de microporos, es decir se produce una mayor escorrentia, lo contrario
sucede en los suelos de textura gruesa, este argumento concuerda con (Castillo &
Rojas, 2019) en su investigacion para la subcuenca Huancay, indicando que la
arcilla es mas resistente al agua, porque la arena posee mayor porosidad, entonces
el agua pude infiltrarse haciendo mas rapido el desprendimiento y transporte de

esta.

La distribucion espacial del factor LS en la zona de estudio generd datos
adimensionales que estan entre 0,030 a 224,91 ver (Anexo 40), presentandose los
valores mas altos precisamente en zonas con mayor longitud y pendiente, esto a
su vez lo explica (Velasquez, 2008) citado por (Valdez, 2014) dejando en manifiesto
que, “mientras mayor sea la longitud, mayor sera el recorrido de una gota de lluvia
hasta llegar al punto donde se encuentran el flujo junto al suelo desprendido” por
otra parte, segun la clasificacion del instituto espacial ecuatoriano (IEE) citado por
(Moreno, 2017) podemos apreciar (Tabla 16) que mas del 50% se encuentra bajo
la clasificacion de “Bajo” seguido de “Moderado” y solo el 0,01% (19,74 Ha) bajo la
clasificacion de “Muy Alto” a “Critico”, de esto podemos inferir que el factor LS
presenta una influencia poco considerada en las zona media y baja de la cuenca
con pendientes de 0 a 70 %. Los resultados de esta investigacion estan dentro del
rango obtenido por (Castillo & Rojas, 2019) con valores de 0 a 854 para la
subcuenca Huancay, de la misma forma (Alvarez, 2019) en su investigacion para
la subcuenca Ichu obtiene valores de 0,03 a 550,7, a su vez ambos concuerdan
gue los valores mas altos se presentan en la cabecera de cuenca, ademas estas
dos investigaciones utilizaron la metodologia planteada por Desmert y Grove (1996)
concluyendo asi que existe una relacion directa entre el factor LS y la pendiente (R2
=0,996) ver (Figura 30) tal como lo menciona(Mancilla, 2008) citado por (Atauje,
2018).

El valor del factor C varia en funcion del tipo de uso y la cubierta vegetal, siendo las
areas boscosas o de plantaciones forestales las que presentan el menor valor. Esto

se debe a que la presencia de estas coberturas vegetales proporciona un mejor
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amortiguamiento de las gotas de lluvia y una mayor capacidad de interceptacion.
Ademas, estas areas cuentan con una distribucion de raices mas efectiva, con
raices mas profundas que proporcionan un mejor soporte para el suelo, tal como lo
menciona (Alvarez, 2019). En ese contexto para nuestra zona de estudio se
obtuvieron valores de NDVI que van de 0,606 a - 0,437 ver (Tabla 17) evidenciando
gue la cubierta de vegetacién mediana es la que se hace presente con un mayor
porcentaje ver (Figura 31) de area, principalmente en la zona alta de la cuenca,
donde se presenta bosque subhimedo de montafia (Bshm) y bosque seco de
montafia (bsm) tal como lo menciona (MINAM, 2015) ver (Anexo 13), por otra parte
se puede apreciar que en los ultimos 5 afios considerados en el estudio se presentd
un aumento de suelos sin vegetacion en un 0,61%, esto sugiere que las areas en
cuestion sufrieron una pérdida significativa de suelo, ya que no contaban con la
proteccion y el amortiguamiento que ofrece la cubierta vegetal, esto es corroborado
por el investigador (Najera et al, 2016) citado por (Castillo & Rojas, 2019) llego a la
conclusiéon de que la presencia de una cubierta vegetal es el factor mas relevante
para disminuir la erosion del agua. Por lo tanto, es imperativo reducir la
deforestacion y fomentar la conservacion de los bosques. Respecto a valores del
factor C se obtuvieron rangos que van de 0,023 a 0,064 con una media de 0,037,
bajo la clasificacion de “Alto" de acuerdo con el investigador (Taco, 2021), por otro
lado, valores similares se obtuvieron en la investigacion realizada por (Almagro et
al., 2019) con valores que varian de 0,004 a 0,078 con una media de 0,023, donde
al igual que en esta investigacion utilizé la misma metodologia propuesta por
Durigon et al. (2014) y adaptado por Colman (2018), donde podemos inferir que existe
una relacion directa entre el NDVI y el factor ¢ (R2 = 0,949) ver (Figura 33) afirmado
por (Camacho et al., 2022) donde encuentran una relacion altamente significativa entre

los valores de NDVI determinados y los valores del Factor C en la subcuenca Cumbaza.

Através de la estimacion de la pérdida de suelo debido a la erosién hidrica potencial
y actual en la cuenca del rio Tumbes, se pudo identificar las areas con mayor
vulnerabilidad a la erosion. Los resultados mostraron que la erosion potencial (sin
cobertura vegetal) presenta un porcentaje mas alto de erosion critica (31,92%), lo
cual se debe a que este calculo no considerd la influencia de la cobertura vegetal
existente. Ademas, los resultados fueron fuertemente influenciados por la longitud

y el gradiente de pendiente, por lo que se observaron los valores mas altos en las
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zonas con pendientes pronunciadas y en la parte alta de la cuenca. En contraste,
en las zonas de la parte baja de la cuenca con pendientes planas, se evidencié una
menor erosion presente, con un porcentaje mas bajo de erosion de nivel bajo (< 5
Tn/Ha/Afo), representando solo el 8,11%. Se pudo observar la influencia del factor
LS en estos resultados, en lo que coincidimos con (Solano, 2016) ya que en su
estudio estimé que el 47,20% representan una erosion muy alta (> 200 Ton/ha/afio)
generada a partir del 5% en zonas altas, y ademas podemos constatar con
(Perales, 2019) en su estudio para la cuenca del rio Supte Grande obtuvo un
61,67% de erosién muy severa y un 20,80% de erosién potencial de nivel normal
(< 0,5 Tn°/ha/afio). Por otro lado podemos ver que en esta investigacion analizando
cada afio de los 23 en estudio se obtuvieron tasas de erosion que van de 420,44 a
18,32Tn/ha/afio para el afilo 2002 y 2018 respectivamente, representando un
escenario agravante si se llegara a disminuir la vegetacion actual de la cuenca, es
asi que la tasa de erosion potencial promedio fue de 167,18 Tn/Ha/Afio,
concordando este resultado con el obtenido por (Solano, 2016) que fue de 163,13
Tn/Ha/Aio de esta forma inferimos que si no se implementan mediadas de
conservacion de suelos y se sigue deforestando sin control los bosques de la

cuenca, se vislumbra un escenario catastrofico para el futuro de la zona en estudio.

Ahora bien considerando el uso actual de la tierra y cobertura vegetal, es decir la
erosion hidrica actual, se observa que un mayor porcentaje se encuentran niveles
de erosion baja a moderada que representan el 58,16% y 39,63% respectivamente,
particularmente estos valores se establecen en la parte baja y media de la cuenca,
por lo que podemos decir que la cubierta vegetal disminuye el impacto de la gota
de lluvia apaciguando la erosién conjuntamente con las pendientes llanas al
debilitar el recorrido de la misma, sin embargo en zonas sin 0 con poca cobertura
vegetal los niveles de erosién suben a muy alta y critica con 0,25% para ambos,
contrastando lo que se menciona con (Condori, 2021) en su estudio para la cuenca
Cairani, donde menciona que, el 31,35% y el 68,56% toman valores de erosion
hidrica actual leve y moderada, mientras que para la erosion alta y muy alta obtiene
valores de 0,09 a 0,00% respectivamente, es asi que podemos asumir que la
erosion actual o real como también se conoce contrarrestar las superficies con
erosion potencial tal como lo menciona (Solano, 2016). En cuanto a las tasas de

erosion encontradas ver (Tabla 20) podemos observar que la maxima 14,36
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Tn/Ha/Afo y la minima 0,02 Tn/ha/afio para el afio 2002 y 2010 respectivamente,
sobrepasando la tasa méxima permisible en la mayoria de los afios, como lo
menciona (PRODESNOS, 2011 Y Morga R.; 2006) citados por (Quifionez, 2019) Al
destacar que la tasa de erosion hidrica del suelo no deberia superar los 10
Ton/Ha/Afo, ya que este es el ritmo al cual se regenera el suelo, se concluye que
si la tasa de erosién es mayor, no se puede asegurar la conservacion del suelo, ya
que la erosién superaria la generaciéon del mismo, respecto a la tasa de erosion
hidrica encontramos estudios cercanos realizados a la zona de estudio,
especificamente en la vertiente del pacifico, tenemos a (Dioses & Pérez, 2018) en
su estudio para la cuenca Piura donde obtuvieron una tasa de erosién hidrica de
10,4 Tn/Ha/Afo para un periodo de estudio de 35 afios de estudio (1981 — 2016),
por otro lado a una escala mayor tenemos el estudio realizado por (Sabino, 2016)
para las regiones hidrolégicas en el Perl, obteniendo por resultado para la region
hidroldgica “pacifico 6”, una tasa de erosion hidrica de 30,9 Tn/Ha/Afo, son tasas
no muy distantes a la obtenida en nuestro estudio, la cual fue de 5,06 Tn/Ha/Afo,
la variacion mas lejana se puede inferir que se da porque nuestro estudio es a nivel

de cuenca a diferencia el de las regiones hidrologicas que es de todo el Pera.
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CAPITULO V

5. CONCLUSIONES

Se estimd la tasa de erosion hidrica en la cuenca del rio Tumbes, aplicando la
metodologia RUSLE con técnicas de teledeteccion, obteniendo asi una tasa de
erosion hidrica potencial (EP) de 167,18 Tn/Ha/Afio dentro de la clasificacion de
amenaza muy alta y una tasa de erosion hidrica actual (EA) de 5,06 Tn/Ha/Afio aun
por debajo de la tasa de erosién hidrica maxima permisible en la clasificacion de

moderada.

Se determinaron los factores que intervienen en el célculo de la erosién hidrica,
encontrandose para el factor de erosividad R valores promedios que van desde 1
274,63 a 7 063,55 Mj*mm/Ha*Hr*Afo con una clasificacion de “muy alto” para toda
la zona en estudio, el factor de erodabilidad K que va desde 0,00140 a 0,01633
Ton*ha*h/Mj*mm*ha con una clasificacion de “muy poco erodable” presentandose
los valores en textura arcillosa, franco arcillo arenoso y franco arenoso, el factor LS
tiene valores que van desde 0,030 a 224,91, encontrandose un area de 77,91%
(129 585,66 Ha) con clasificacion Baja, el factor C con valores desde 0,023 a 0,064
bajo la clasificacion de “Alto” para toda la zona de estudio con coberturas mas
influyentes de bosque subhumedo de montafia y bosque seco de montafia y por

ultimo factor P que se consideré la unidad.

Se determinaron los niveles de erosion hidrica real y potencial aplicando la
metodologia RUSLE con técnicas de teledeteccion en la cuenca del rio Tumbes,
indicando que el 8,11% (13 487,34 Ha) del area en estudio cuenta con erosion
hidrica potencial baja (< 5 Tn/Ha/Afo), el 14,09% (23 438,4 Ha) esta clasificada
como moderada (5 — 25 Tn/Ha/Afo), el 12,31% (20 475,90 Ha) del area de la
superficie considerada como mediana (25 — 50 Tn/Ha/Afo), el 15,31% (25 463,62
Ha) clasificada como Alta (50 — 100 Tn/Ha/Afo), el 18,26% (30 376,80 Ha) del area
considerada como muy alta (100 — 200 Tn/Ha/Afo) y el 31,92% (53 085,80 Ha) del
area en estudio considerada como critica (> 200 Tn/Ha/Afo); respecto a la erosion
hidrica actual o real el 58,16% (96 738,12 Ha) del area en estudio cuenta con
erosion hidrica actual baja (< 5 Tn/Ha/Afo), el 39,63% (65 919,43 Ha) esta
clasificada como moderada (5 — 25 Tn/Ha/Afo), el 1,45% (2 410,35 Ha) del area de
la superficie considerada como mediana (25 — 50 Tn/Ha/Afo), el 0,26% (438,03 Ha)
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clasificada como Alta (50 — 100 Tn/Ha/Afo), y el 0,25% (412,49 Ha) del area
considerada como muy alta (100 — 200 Tn/Ha/Afo) y critica (> 200 Tn/Ha/AfR0)
respectivamente, todo aquello bajo la clasificacion de la FAO.

Se identificaron las zonas que presentan mayor riesgo de sufrir erosion hidrica,
siendo aquellas en las que se combinan varios factores con valores elevados, ya
sea en zonas con pendientes pronunciadas, poca vegetacion, suelos de baja
calidad, elevadas precipitaciones y falta de medidas de conservacion de suelo.
Estas areas se localizan en las laderas y cimas de las montafias de la parte media
y alta de la cuenca, especificamente en los distritos de San Jacinto, Pampas de
Hospital y Matapalo alcanzando en su mayoria niveles de erosion mediana, alta,

muy alta y critica ver (Anexo 71y 94).
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CAPITULO VI

6. RECOMENDACIONES

Es importante enfocarse en las areas mas erosionadas a corto plazo,
especialmente en las partes altas de la cuenca que son mas propensas a perder
suelo y que presentan altas tasas de erosion, es por ello que se deben priorizar
estas zonas para abordar la problematica de la erosion.

Para reducir el factor LS y mitigar la erosion, se recomienda la construccién de
zanjas de infiltracién junto con la implementacién de una cobertura vegetal que se
cologue en contra de la pendiente. Esta medida tiene como objetivo disminuir la
velocidad del agua de escorrentia, retener la humedad y asi reducir su capacidad

de causar erosion.

La presencia de cobertura vegetal es crucial para reducir la erosion en una region,
por lo que se sugiere implementar programas de reforestacion en las partes altas
de la cuenca como estrategia de conservacion. De esta manera, se protegeria el
suelo contra la erosion mediante el enraizamiento y la caida de hojas de las plantas,

lo que también mejoraria la capacidad de infiltracion del suelo.

Se recomienda realizar medidas de conservacion y/o recuperaciones propuestas
en las zonas donde se encontrd erosion moderada a critica, con los surcos de
contorno, terrazas de absorcion y control de la escorrentia, la implementacion de
estas técnicas contribuira a mejorar las caracteristicas de la textura del suelo,
disminuir la pendiente, incrementar la capacidad de infiltracion e incrementar la
cantidad de materia organica. Esto no solo beneficiara al suelo, si no también tendra
un impacto positivo en la produccion, asi mismo, el mapa de erosién hidrica
potencial y actual de la cuenca del rio Tumbes deber ser tomado en cuenta como
una herramienta técnica para la planificacion territorial. De esta manera, se podria
evitar la implementacion de practicas agresivas en los territorios mas sensibles,

asegurando una utilizacion sostenible de los recursos naturales.
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CAPITULO VI
8. ANEXOS

Anexo 1: Registro de precipitacion acumulada mensual —anual en mm, pre tratamiento estadistico.

Estacion meteorolégica Campamento Sede: precipitacion acumulada mensual - anual, enero de 2000 a diciembre de 2022.

ESTACION: CAMPAMENTO SEDE LATITUD: 3°33'4.14" S DPTO. TUMBES

N° DE REGISTROS: 23 ANOS LONGITUD: 80°25'46.64" W PROV. TUMBES

PERIODO: 2000-2022 ALTITUD: 17 m.s.n.m DIST. TUMBES
ANO ENE. FEB. MAR. ABR. MAY. JUN. JUL. AGO. SET. OCT. NOV. DIC. TOTAL
2000 10.30 36.40 64.20 66.40 26.00 1.80 0.20 1.50 0.70 0.00 0.00 3.70 211.20
2001 33.00 70.30 194.60 56.80 1.00 0.40 1.30 0.00 0.70 0.10 2.40 0.70 361.30
2002 1.60 211.90 292.80 99.50 0.10 0.80 0.00 0.80 1.30 2.30 0.50 5.70 617.30
2003 22.90 28.00 12.10 6.50 3.10 0.90 3.10 0.50 0.00 0.00 0.00 60.80 137.90
2004 9.40 23.60 31.00 59.20 5.70 0.70 0.80 0.00 0.90 3.30 0.00 1.80 136.40
2005 4.60 5.10 59.30 19.20 0.00 0.00 0.00 0.30 0.00 0.40 0.00 6.50 95.40
2006 33.60 267.20 56.60 8.40 1.10 0.00 0.90 1.40 0.00 1.20 1.50 10.60 382.50
2007 70.70 4.00 58.10 4.00 3.00 0.20 0.40 1.10 0.00 0.30 3.50 2.40 147.70
2008 128.70 | 270.50 105.90 25.50 0.60 2.00 0.20 0.00 0.80 0.10 0.07 0.00 534.37
2009 117.50 | 168.70 27.30 20.50 5.50 1.40 0.00 0.80 1.00 0.00 3.20 3.00 348.90
2010 17.80 187.40 180.80 94.90 1.20 1.40 0.20 0.00 0.00 0.00 2.40 2.00 488.10
2011 21.80 43.90 3.80 38.50 13.30 0.00 7.50 0.00 0.00 0.00 0.20 1.00 130.00
2012 80.10 155.00 95.10 74.80 3.00 0.00 0.40 0.00 0.00 2.90 1.90 1.50 414.70
2013 15.30 43.90 105.10 26.00 2.20 1.60 1.00 0.00 0.00 4.70 0.00 0.00 199.80
2014 42.36 29.70 1.90 4.60 53.00 7.90 0.00 0.00 0.00 5.00 0.00 3.70 148.16
2015 11.40 38.00 330.60 25.40 39.40 1.30 0.00 0.00 0.30 6.50 1.20 3.00 457.10
2016 27.10 241.00 174.40 70.00 0.10 2.00 0.00 0.80 1.30 0.00 0.00 6.30 523.00
2017 143.90 90.90 337.40 58.60 35.00 0.20 0.00 0.30 0.90 2.90 0.10 0.70 670.90
2018 12.80 30.00 8.80 0.30 33.40 0.00 0.00 0.20 0.00 0.30 1.20 34.20 121.20
2019 66.30 87.70 34.30 17.80 0.30 0.30 0.20 0.90 0.00 1.10 0.40 23.20 232.50
2020 34.30 141.60 63.20 7.60 0.50 0.90 1.90 0.20 0.40 0.00 1.00 5.20 256.80
2021 65.70 12.80 76.10 12.90 13.40 2.40 1.10 0.90 0.10 6.30 3.70 10.70 206.10
2022 61.30 18.10 85.90 25.00 12.40 4.50 0.90 1.10 0.10 4.00 0.50 0.30 214.10
PROMEDIO 44.9 95.9 104.3 35.8 11.0 1.3 0.9 0.5 0.4 1.8 1.0 8.1 305.9
MAXIMO 143.9 270.5 337.4 99.5 53.0 7.9 7.5 15 1.3 6.5 3.7 60.8 670.9
MINIMO 1.6 4.0 1.9 0.3 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 95.4
DESVIACION 40.79 89.15 101.21 30.25 15.37 1.78 1.63 0.50 0.46 2.20 1.24 14.01 174.62

Fuente: PEBPT
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Estacion meteorolégica La Cruz: precipitacion acumulada mensual - anual, enero de 2000 a diciembre de 2022.

ESTACION: LA CRUZ LATITUD: 3°37'41.85" S DPTO. TUMBES

N° DE REGISTROS: 23 ANOS LONGITUD: 80°34'9.36" W PROV. TUMBES

PERIODO: 2000-2022 ALTITUD: 6 msnm DIST. LA CRUZ
ANO ENE. FEB. MAR. ABR. | MAY. JUN. JUL. AGO. SET. OCT. NOV. DIC. TOTAL
2000 14.70 | 38.40 51.80 | 54.40 | 58.10 | 1.90 0.10 0.90 0.70 0.00 0.00 1.80 | 222.80
2001 2470 | 35.20 | 215.50 | 37.30 | 5.20 0.00 0.90 0.80 0.80 0.00 2.80 2.20 | 325.40
2002 4.70 | 159.60 | 187.10 | 79.40 | 0.70 0.00 0.00 0.00 0.60 1.60 0.30 5.90 | 439.90
2003 25.30 | 22.40 13.90 | 13.70 | 0.70 0.70 2.20 0.30 0.70 0.00 0.40 |15.60 | 95.90
2004 13.20 | 50.60 16.40 | 38.80 | 9.80 0.10 0.90 0.00 0.60 0.10 0.00 0.50 | 131.00
2005 9.90 8.60 49.00 2.20 | 0.30 0.70 0.00 0.10 0.00 2.30 4.70 3.30 81.10
2006 21.10 | 186.80 | 117.20 | 2.90 | 0.00 0.00 1.30 0.60 0.10 0.00 3.80 6.30 | 340.10
2007 54.90 0.60 98.80 9.00 | 2.20 0.00 0.10 1.70 0.00 1.60 3.10 1.70 | 173.70
2008 116.00| 271.50 | 117.10 | 13.60 | 0.60 0.60 0.10 0.00 1.50 0.10 0.90 0.00 | 522.00
2009 87.60 | 168.60 | 12.60 8.10 | 2.80 0.00 0.00 0.20 2.50 0.20 2.00 1.20 | 285.80
2010 10.00 | 123.10 | 143.80 | 90.10 | 0.60 1.80 0.20 0.00 0.00 0.20 1.40 1.50 | 372.70
2011 5.20 72.70 2.30 37.40 | 1.10 0.20 3.50 1.70 0.00 0.10 0.70 0.60 | 125.50
2012 34.90 | 127.90 | 79.50 | 56.90 | 11.60 | 5.80 0.00 0.10 0.10 1.00 1.50 0.60 | 319.90
2013 19.40 | 40.40 | 114.40 | 13.60 | 2.60 2.20 0.90 0.00 0.10 1.90 0.00 3.80 | 199.30
2014 37.70 | 17.10 6.80 4.40 | 29.40 | 7.40 0.40 0.50 0.60 5.60 0.00 4.30 | 114.20
2015 3.90 37.40 | 215.20 | 55.60 | 21.20 | 0.00 1.30 0.20 0.00 8.20 1.30 0.00 | 344.30
2016 1745 | 95.90 | 175.71 | 52.43 | 0.02 1.88 0.34 0.13 0.33 0.06 0.00 2.23 | 346.49
2017 121.30| 77.40 | 405.00 | 85.40 | 34.50 | 1.00 0.10 0.80 0.50 1.20 0.70 1.00 | 728.90
2018 12.10 | 45.50 1.00 0.20 | 16.50 | 0.00 0.30 0.20 0.00 0.30 0.40 |43.00 | 119.50
2019 18.60 | 103.40 | 25.80 | 39.90 | 0.00 0.00 0.00 1.10 0.00 2.10 0.30 8.90 | 200.10
2020 11.60 | 82.10 62.30 0.20 0.00 0.10 | 14.20 | 170.50
2021 30.10 | 12.90 67.20 | 40.90 | 6.40 0.10 0.00 0.10 0.00 1.20 1.00 0.10 | 160.00
2022 7.70 17.50 35.80 | 11.70 | 0.20 0.00 0.00 0.10 1.10 2.00 0.50 0.50 77.10
PROMEDIO 30.5 78.1 96.3 34.0 9.3 11 0.6 0.4 0.5 13 11 5.2 256.4
MAXIMO 121.3 | 271.5 405.0 90.1 | 58.1 7.4 3.5 1.7 2.5 8.2 4.7 43.0 728.9

MINIMO 3.9 0.6 1.0 0.2 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 77.1

DESVIACION | 33.50 | 68.58 96.03 | 28.25 | 14.75 | 1.94 0.88 0.52 0.62 1.98 1.32 9.28 | 160.26

Fuente: SENAMHI
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Estacion meteorolégica El Tigre: precipitacion acumulada mensual - anual, enero de 2000 a diciembre de 2022.

ESTACION: EL TIGRE LATITUD: 3°48'8.4" S DPTO. TUMBES
N° DE REGISTROS: 23 ANOS LONGITUD: 80°27'24" W PROV. TUMBES
PERIODO: 2000-2022 ALTITUD: 45 msnm DIST. SAN JACINTO
ANO ENE. FEB. MAR. ABR. MAY. JUN. JUL. AGO. SET. OCT. NOV. DIC. TOTAL
2000 3.20 |111.80 | 134.00 | 112.90 | 101.40 | 6.00 0.30 0.00 0.60 0.00 0.00 9.90 | 480.10
2001 63.20 | 53.30 | 300.70 | 68.90 | 11.90 1.20 0.00 0.00 0.00 0.00 4.00 8.10 | 511.30
2002 7.80 ]198.30 | 338.30 | 213.60 | 3.30 0.00 0.00 0.00 0.80 0.60 0.00 | 23.20 | 785.90
2003 96.90 | 81.80 | 37.20 | 10.50 0.40 2.50 3.20 1.00 0.80 0.00 0.00 | 14.80 | 249.10
2004 10.90 | 124.10 | 53.30 | 72.50 5.60 0.00 2.20 0.00 1.00 1.50 0.40 0.70 | 272.20
2005 1.10 | 17.40 | 102.90 | 17.90 0.20 0.00 0.00 0.90 0.00 1.90 3.10 3.10 | 148.50
2006 53.50 | 306.50 | 112.10 | 5.00 0.70 1.30 1.50 1.50 2.40 0.70 4.00 5.50 | 494.70
2007 94.55 | 8.50 90.90 | 43.40 1.20 0.00 1.40 0.80 1.10 1.00 5.10 4.20 | 252.15
2008 138.20 | 328.70 | 181.10 | 58.00 | 12.70 2.90 0.70 0.50 1.30 2.70 2.60 0.00 | 729.40
2009 191.52 | 200.30 | 89.00 5.80 2.30 0.80 0.20 1.60 1.50 0.80 0.80 0.80 | 495.42
2010 94.70 | 178.10 | 218.10 | 121.80 | 5.10 5.00 2.70 0.30 0.90 0.30 1.10 6.60 | 634.70
2011 45.70 | 64.00 3.40 |114.80| 0.40 1.40 1.30 0.10 0.60 0.40 1.20 9.80 | 243.10
2012 135.90 | 280.50 | 190.30 | 112.30 | 24.80 | 10.70 0.40 0.30 0.10 2.00 4.40 3.50 | 765.20
2013 28.30 | 54.42 | 150.90 | 8.70 6.20 0.80 1.30 1.00 0.30 5.80 0.10 2.60 | 260.42
2014 85.50 | 54.82 | 12.10 7.20 51.00 | 22.10 1.70 2.00 1.20 6.10 1.10 | 15.80 | 260.62
2015 25.70 | 114.70 | 344.40 | 180.60 | 109.40 | 3.80 4.00 0.70 0.00 7.40 4.00 3.80 | 798.50
2016 33.00 | 327.30 | 247.70 | 129.30 | 0.60 6.80 0.00 0.60 0.00 0.40 0.60 |11.00 | 757.30
2017 144.90 | 276.30 | 326.80 | 249.71 | 111.40 | 3.50 0.70 2.40 1.20 3.10 0.00 0.30 | 1120.31
2018 34.10 | 113.60 | 4.40 0.50 24.70 0.00 0.30 0.50 0.50 0.30 0.80 | 65.50 | 245.20
2019 108.60 | 212.30 | 229.60 | 108.80 | 3.10 0.50 1.20 1.40 0.00 0.90 3.50 [32.30| 702.20
2020 13.80 | 118.50 | 140.60 0.00 0.00 0.30 0.50 |17.50 | 291.20
2021 67.20 | 37.30 | 192.30 | 44.10 | 13.90 1.50 0.10 0.70 0.20 4.80 2.10 5.50 | 369.70
2022 13.30 | 12.10 | 64.00 | 18.60 2.20 3.50 0.90 0.60 0.00 1.30 0.10 1.60 | 118.20
PROMEDIO 64.9 | 142.4 | 155.0 77.5 22.4 3.4 11 0.7 0.6 1.8 17 10.7 477.6
MAXIMO 191.5 | 328.7 | 344.4 | 249.7 | 1114 22.1 4.0 2.4 2.4 7.4 5.1 65.5 | 1120.3
MINIMO 11 8.5 3.4 0.5 0.2 0.0 0.0 0.0 0.0 0.0 0.0 0.0 118.2
DESVIACION | 53.36 | 105.24 | 107.44 | 71.90 | 36.57 4.98 1.11 0.67 0.63 2.17 1.71 | 14.40 | 264.98

Fuente: PEBPT
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Estacion meteorolégica Cabo Inga: precipitaciéon acumulada mensual - anual, enero de 2000 a diciembre de 2022.

ESTACION: CABO INGA LATITUD: 3°58'33.39" S DPTO. |TUMBES
N° DE REGISTROS: 23 ANOS LONGITUD: 80°24'6.54" W PROV. |TUMBES
PERIODO: 2000-2022 ALTITUD: 231 m.s.n.m DIST. SAN JACINTO
ANO ENE. FEB. MAR. ABR. MAY. JUN. JUL. AGO. SET. OCT. NOV. DIC. TOTAL
2000 6.60 | 177.90 | 274.30 | 183.60 | 83.90 6.00 0.00 0.00 0.00 0.00 0.80 6.60 | 739.70
2001 253.80 | 207.00 | 470.20 | 154.20 | 8.80 0.00 0.00 0.00 0.00 0.00 6.30 | 10.50 | 1110.80
2002 5.40 | 359.90 | 444.40 | 427.80 | 6.20 1.00 0.00 0.00 0.00 | 26.50 0.00 | 73.20 | 1344.40
2003 112.30 | 183.90 | 126.00 | 25.20 4.20 5.30 0.00 0.00 0.00 0.00 3.50 | 11.90 | 472.30
2004 28.40 | 151.40 | 119.40 | 34.00 5.30 4.00 0.00 0.00 0.00 4.70 0.00 0.00 | 347.20
2005 13.40 | 15.70 | 210.80 | 37.40 0.00 12.50 0.00 0.00 0.00 0.00 5.60 |16.10 | 311.50
2006 87.50 | 404.90 | 233.00 | 57.20 | 25.90 0.30 0.60 0.00 0.00 0.00 8.60 | 29.40 | 847.40
2007 94.60 | 33.80 | 227.20 | 93.40 0.40 0.30 0.00 0.00 0.00 0.00 0.00 8.40 | 458.10
2008 185.50 | 456.20 | 300.50 | 115.10 | 42.60 1.30 20.90 0.00 0.00 1.90 1.40 0.00 | 1125.40
2009 465.60 | 364.90 | 274.90 | 71.10 | 19.10 0.00 0.00 0.00 0.00 0.00 1.10 | 45.70 | 1242.40
2010 171.10 | 320.90 | 495.60 | 110.20 | 35.70 9.10 0.50 0.00 0.00 0.30 2.90 3.10 | 1149.40
2011 24,10 | 54.80 | 23.00 | 421.20 | 41.70 | 40.50 6.40 0.00 0.00 4.70 2.80 |13.50 | 632.70
2012 184.90 | 570.00 | 444.70 | 382.90 | 76.80 2.20 5.50 0.00 0.00 0.80 4.00 6.20 | 1678.00
2013 44.50 | 67.20 | 243.30 | 36.60 | 44.10 0.00 0.00 0.00 0.00 4.20 0.00 2.40 | 442.30
2014 63.10 | 77.50 | 53.00 | 27.30 | 175.60 | 23.80 0.30 0.00 0.20 6.80 2.90 9.80 | 440.30
2015 59.40 | 103.90 | 464.60 | 469.20 | 72.30 | 85.80 9.20 0.00 0.60 1.70 10.00 | 0.00 | 1276.70
2016 71.34 | 381.91 | 322.81 | 198.92 | 0.49 12.61 0.26 0.10 0.22 0.66 0.00 9.05 | 998.40
2017 312.60 | 369.20 | 493.40 1.40 1.90 1178.50
2018 71.60 | 83.50 | 19.20 | 24.10 | 80.70 0.00 0.00 0.00 0.00 0.00 37.50 | 69.80 | 386.40
2019 79.50 | 312.80 | 307.80 | 87.50 | 26.80 4.60 0.00 0.70 0.10 0.00 0.40 | 98.70 | 918.90
2020 49.80 | 99.50 | 158.10 | 27.60 | 33.20 4.90 3.40 0.00 0.00 0.10 0.40 | 44.00 | 421.00
2021 110.50 | 65.30 | 225.90 | 131.10 | 48.40 4.40 0.50 0.40 0.10 0.80 0.40 | 10.30 | 598.10
2022 38.10 | 24.40 | 171.90 | 52.20 2.00 1.60 2.20 0.70 0.00 0.10 0.30 | 40.40 | 333.90
PROMEDIO | 110.2 | 2125 | 265.4 | 144.0 37.9 10.0 2.3 0.1 0.1 2.4 4.0 23.1 802.3
MAXIMO 465.6 | 570.0 | 495.6 | 469.2 | 175.6 85.8 20.9 14 1.9 26.5 37.5 98.7 | 1678.0
MINIMO 54 15.7 19.2 24.1 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 311.5
DESVIACION |110.93| 162.81 | 149.29 | 145.52 | 41.42 | 19.42 4.87 0.35 0.41 5.73 8.02 | 27.48 | 401.32

Fuente: SENAMHI
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Estacion meteorolégica Cafiaveral: precipitacion acumulada mensual - anual, enero de 2000 a diciembre de 2022.

ESTACION: CANAVERAL LATITUD: 3°56'20.75" DPTO. TUMBES
N° DE REGISTROS: 23 ANOS LONGITUD: 80°39'2.1" W PROV. C.M.V.Z

PERIODO: 2000 - 2022 ALTITUD: 133 m.s.n.m DIST. CASITAS
ANO ENE. FEB. MAR. ABR. MAY. | JUN. JUL. AGO. SET. OCT. NOV. DIC. TOTAL
2000 1.14 74.73 61.05 | 100.44 | 26.22 | 3.52 | 0.00 0.00 0.00 0.00 0.00 5.53 | 272.63
2001 115.57 | 104.09 | 335.28 | 72.90 1.53 | 0.00 | 0.00 0.00 0.00 0.00 2.08 2.72 | 634.16
2002 12.47 | 184.98 | 410.33 | 240.20 | 1.68 | 0.00 | 0.00 1.18 0.51 0.48 0.01 1.83 | 853.68
2003 22.62 | 56.64 14.15 42.29 0.66 | 0.19 | 0.05 0.00 0.00 0.00 0.01 |12.54 | 149.13
2004 3.22 78.22 37.93 23.55 1.81 | 0.00 | 0.07 0.00 0.00 5.00 0.00 0.00 | 149.80
2005 2.11 9.36 48.07 12.23 0.01 | 0.03 | 0.00 0.00 0.00 0.00 0.20 2.01 74.02
2006 29.04 | 23547 | 61.36 4.79 0.03 | 1.19 | 0.06 0.00 0.00 0.00 0.35 1.89 | 334.18
2007 61.96 3.50 143.66 | 19.56 0.02 | 0.00 | 0.00 0.00 0.00 0.00 0.08 0.24 | 229.03
2008 124.74 | 301.04 | 126.37 8.18 051 | 0.11 | 0.92 0.00 0.00 2.22 0.08 0.00 | 564.17
2009 230.86 | 122.97 | 103.60 | 38.54 | 3.28 | 3.58 | 0.00 0.00 0.00 0.00 6.35 5.03 | 514.20
2010 46.46 | 134.79 | 147.78 | 75.20 0.17 | 0.04 | 0.59 0.00 0.00 0.01 0.02 2.71 | 407.78
2011 7.88 62.81 0.11 105.69 | 0.16 | 0.02 | 11.38 0.00 0.00 0.02 0.10 4.01 | 192.18
2012 71.17 | 213.37 | 296.68 | 94.05 | 16.64 | 0.26 | 0.03 0.00 0.00 0.02 0.77 0.11 | 693.10
2013 22,23 | 34.53 | 159.69 5.65 6.27 | 0.00 | 0.01 0.00 0.00 1.01 0.00 0.13 | 229.52
2014 14.90 | 43.99 7.36 4.98 25.36 | 0.46 | 0.03 0.00 0.00 1.58 0.00 0.24 98.90
2015 7.16 44.49 | 290.36 | 119.42 | 37.54 | 3.44 | 0.08 0.00 0.00 0.34 0.62 9.73 | 513.18
2016 21.42 | 124.27 | 217.36 | 106.05 | 0.04 | 2.56 | 0.00 0.16 0.00 0.00 0.00 1.43 | 473.30
2017 137.70 | 214.2 65.00 | 121.20 | 0.00 | 0.00 | 0.00 0.00 0.00 0.00 0.00 0.30 | 324.20
2018 9.40 6.10 18.70 1.70 19.50 | 0.00 | 0.00 0.00 0.00 0.00 42.60 | 20.70 | 118.70
2019 21.30 | 157.10 | 109.20 | 56.40 4.40 | 0.60 0.20 0.00 0.00 0.20 | 59.40 | 408.80
2020 58.80 | 38.30 68.30 4.50 0.20 | 1.00 | 0.10 0.00 0.00 0.20 0.00 | 15.60 | 187.00
2021 9.40 1.10 110.20 | 35.10 7.80 | 230 | 0.10 0.10 0.20 0.10 0.10 1.10 | 167.60
2022 4.30 6.10 11.90 11.00 140 | 0.20 | 0.10 0.10 0.00 0.10 0.00 [11.90| 47.10
PROMEDIO 45.0 92.6 123.7 56.7 6.9 1.0 0.6 0.1 0.0 0.5 2.3 6.9 332.0
MAXIMO 230.9 | 301.0 410.3 240.2 37.5 4.4 11.4 1.2 0.5 5.0 42.6 59.4 853.7

MINIMO 11 11 0.1 1.7 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 47.1

DESVIACION | 57.41 | 83.63 | 114.46 | 58.05 | 10.88 | 1.47 | 2.36 0.25 0.11 1.14 8.88 | 12.78 | 218.66

Fuente: SENAMHI
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Estacion meteoroldgica Matapalo: precipitacion acumulada mensual - anual, enero de 2000 a diciembre de 2022.

ESTACION: MATAPALO LATITUD: 3°40'57.94" S DPTO. TUMBES

N° DE REGISTROS: 23 ANOS LONGITUD: 80°11'54.64" W PROV. ZARUMILLA

PERIODO: 2000-2022 ALTITUD: 62 m.s.n.m DIST. MATAPALO
ANO ENE. FEB. MAR. ABR. MAY. JUN. JUL. AGO. SET. OCT. NOV. DIC. TOTAL
2000 14.10 | 104.50 | 279.90 | 94.60 | 154.60 | 6.20 2.40 3.50 2.80 0.40 0.10 | 27.30 | 690.40
2001 81.30 | 121.10 | 298.90 | 64.30 | 13.10 | 2.80 2.20 0.30 0.40 2.70 8.40 | 12.20 | 607.70
2002 61.50 | 233.80 | 246.20 | 152.90 | 7.30 0.20 0.60 3.60 3.20 14.00 2.50 | 74.70 | 800.50
2003 101.40| 121.60 | 36.80 | 23.50 7.40 4.70 5.40 1.70 3.50 1.60 3.60 | 55.90 | 367.10
2004 72.60 | 148.50 | 122.70 | 89.00 9.00 3.50 3.10 2.00 3.10 3.90 3.00 8.60 | 469.00
2005 27.30 | 47.20 | 143.90 | 29.90 1.80 3.70 0.60 1.40 1.70 5.40 1.50 7.60 | 272.00
2006 67.00 | 496.60 | 154.10 | 14.10 2.50 6.60 2.90 3.00 3.20 1.10 17.40 | 34.20 | 802.70
2007 227.70| 18.80 | 244.60 | 58.60 | 14.60 | 1.70 2.60 2.10 1.30 2.40 3.50 5.00 | 582.90

2008 269.00 | 409.70 | 229.60 | 75.30 7.90 |15.60| 3.50 2.20 1.80 6.30 7.30 0.70 | 1028.90
2009 270.30 | 229.40 | 117.60 | 29.60 | 16.20 | 2.10 | 0.90 3.40 5.50 1.50 9.00 | 27.70 | 713.20

2010 187.60 | 207.50 | 303.10 | 289.00 | 19.20 | 8.30 | 3.30 1.50 2.10 4.40 3.30 | 21.40 | 1050.70
2011 41.00 | 202.40 | 21.90 | 11490 | 6.20 7.30 | 4.90 2.40 1.60 3.40 5.50 | 15.30 | 426.80
2012 253.70 | 224.20 | 94.30 | 187.00 | 55.40 | 25.60 | 3.50 2.10 1.50 8.00 7.60 | 14.10 | 877.00
2013 115.80| 97.10 | 356.10 | 21.00 | 12.90 | 3.30 2.60 2.70 0.80 12.60 0.70 |14.50 | 640.10
2014 158.11| 99.90 | 1490 | 20.10 | 96.60 | 50.60 | 3.60 2.60 2.60 9.80 3.00 |19.50 | 481.31
2015 76.40 | 119.60 | 463.70 | 107.20 | 211.50 | 4.40 | 9.00 2.70 2.40 11.70 8.40 | 14.89 | 1031.89
2016 85.80 | 442.89 | 285.65 | 152.14 | 1.73 5.13 1.51 0.99 1.82 0.88 2.66 | 19.63 | 1000.83
2017 200.40 | 347.90 | 465.20 2.60 2.00 1018.10
2018 153.00 | 31.50 7.40 71.60 | 0.20 2.00 19.10 | 1540 | 4.20 14.70 | 91.10 | 410.20
2019 132.80 | 373.20 | 166.90 | 89.20 5.20 0.70 1.10 1.40 1.10 2.80 14.60 | 62.60 | 851.60
2020 19.60 | 181.20 | 186.00 | 104.90 | 17.10 | 6.70 | 8.50 0.80 1.90 1.10 7.30 | 47.60 | 582.70
2021 141.90| 108.20 | 236.30 | 62.80 | 17.80 | 6.00 | 4.90 2.90 0.80 9.60 3.10 | 11.10 | 605.40
2022 158.90| 63.10 | 147.60 | 39.00 6.10 5.20 | 12.20 1.10 0.60 1.80 0.50 2.90 | 439.00

PROMEDIO | 125.7 | 197.9 | 202.1 83.0 34.4 7.8 3.7 2.9 2.7 5.0 5.8 26.8 684.8
MAXIMO 270.3 | 496.6 | 465.2 | 289.0 | 211.5 | 50.6 12.2 19.1 154 14.0 17.4 91.1 | 1050.7
MINIMO 14.1 18.8 14.9 7.4 1.7 0.2 0.6 0.3 0.4 0.4 0.1 0.7 272.0

DESVIACION | 80.99 | 131.86 | 127.71 | 67.62 | 54.49 | 11.06 | 2.91 3.65 3.00 4.16 4.82 | 24.55 | 240.58

Fuente: SENAMHI
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Estacion Virtual V1: precipitacion acumulada mensual - anual, enero de 2000 a diciembre de 2022.

ESTACION: VIRTUAL 01 LATITUD: 4°8'40.96" S DPTO. TUMBES

N° DE REGISTROS: 23 ANOS LONGITUD: 80°34'12.21" W PROV. C.M.V.Z

PERIODO: 2000-2022 ALTITUD: 17 m.s.n.m DIST. CASITAS
ANO ENE. FEB. MAR. ABR. MAY. | JUN. JUL. AGO. SET. OCT. NOV. DIC. TOTAL
2000 9.13 | 298.35 | 244.93 | 196.65 | 28.31 | 3.74 | 0.00 0.24 0.00 0.50 0.00 | 13.74 | 795.58
2001 149.60 | 157.84 | 975.92 | 157.90 | 3.04 | 0.09 | 0.15 0.33 0.00 0.64 2.67 5.60 | 1453.78
2002 10.95 | 421.71 | 734.38 | 427.15 | 2.26 | 0.01 | 0.04 0.73 0.23 2.82 0.30 5.71 | 1606.29
2003 67.31 | 164.57 | 28.83 22.35 1.05 | 1.20 | 0.07 0.30 0.07 0.38 0.31 | 12.03 | 298.46
2004 19.88 | 126.45 | 85.12 32.73 3.51 | 0.00 | 0.11 0.20 0.06 5.00 0.08 1.87 | 275.01
2005 6.46 30.43 | 198.71 | 11.06 0.20 | 0.37 | 0.00 0.27 0.01 1.16 0.54 5.86 | 255.06
2006 57.44 | 619.84 | 24255 | 11.72 0.21 | 0.31 | 0.22 0.29 0.00 0.54 2.05 5.75 | 940.92
2007 98.38 | 14.03 | 317.39 | 30.10 1.10 | 0.03 | 0.00 0.25 0.04 1.07 0.32 2.19 | 464.89
2008 229.42 | 871.91 | 458.84 | 65.37 437 | 1.16 | 0.67 0.31 0.01 3.35 0.66 0.40 | 1636.46
2009 511.20 | 387.73 | 429.23 | 26.79 1.28 | 0.45 | 0.00 0.27 0.06 0.59 2.58 6.52 | 1366.70
2010 61.75 | 428.16 | 343.07 | 86.60 264 | 013 | 0.23 0.29 0.00 1.77 0.24 3.45 | 928.34
2011 20.55 | 93.79 6.11 150.76 | 0.94 | 0.52 | 3.47 0.28 0.00 1.30 0.96 7.40 | 286.10
2012 108.84 | 983.18 | 596.10 | 190.83 | 11.90 | 0.50 | 0.16 0.27 0.06 1.30 1.78 2.24 |1897.15
2013 4477 | 5595 | 35149 | 19.19 | 17.13 | 0.00 | 0.00 0.31 0.00 3.78 0.00 2.47 | 495.08
2014 34.84 | 72.59 30.86 9.81 2659 | 221 | 0.15 0.32 0.08 4.65 0.00 5.53 | 187.64
2015 23.96 | 90.52 | 603.69 | 131.72 | 36.84 | 1.51 | 0.22 0.25 0.00 3.03 1.61 9.25 | 902.59
2016 66.85 | 391.89 | 447.63 | 121.84 | 0.86 | 3.54 | 0.05 0.39 0.09 0.76 0.00 5.20 | 1039.11
2017
2018
2019
2020
2021
2022

PROMEDIO 89.5 306.4 358.5 99.6 8.4 0.9 0.3 0.3 0.0 1.9 0.8 5.6 644.8
MAXIMO 511.2 | 983.2 975.9 427.2 36.8 3.7 3.5 0.7 0.2 5.0 2.7 13.7 | 1897.2
MINIMO 6.5 14.0 6.1 9.8 0.2 0.0 0.0 0.2 0.0 0.4 0.0 0.4 187.64
DESVIACION |123.16 | 291.93 | 265.86 | 107.41 | 11.64 | 1.19 | 0.83 0.11 0.06 1.53 0.94 3.57 | 616.45

Fuente: SENAMHI
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Estacidn Virtual V2: precipitacion acumulada mensual - anual, enero de 2000 a diciembre de 2022.

ESTACION: VIRTUAL 02 LATITUD: 3°54'56.08" S DPTO. TUMBES

N° DE REGISTROS: 23 ANOS LONGITUD: 80°14'26.12" W PROV. ZARUMILLA

PERIODO: 2000-2022 ALTITUD: 527 m.s.n.m DIST. PAPAYAL
ANO ENE. FEB. MAR. ABR. MAY. | JUN. JUL. AGO. SET. OCT. NOV. DIC. TOTAL
2000 24.39 | 199.32 | 220.47 | 387.83 | 4791 | 9.31 | 0.05 0.44 0.59 1.34 2.07 | 25.34 | 919.05
2001 193.43| 93.33 | 331.38 | 340.96 | 9.68 | 1.18 | 0.53 0.47 0.58 1.96 20.66 | 19.20 | 1013.35
2002 13.38 | 327.91 | 333.84 | 993.96 | 4.56 | 0.97 | 0.28 0.55 0.31 9.81 4.37 | 32.31 | 1722.25
2003 137.07 | 136.73 | 32.56 61.96 2.64 | 453 | 0.52 0.47 0.54 2.36 3.30 | 47.01 | 429.68
2004 56.10 | 103.54 | 48.86 | 166.51 | 8.30 | 0.65 | 041 0.35 0.85 12.30 3.55 8.76 | 410.19
2005 11.26 | 20.74 | 137.42 | 41.85 0.99 | 1.98 | 0.00 0.42 0.14 3.78 7.52 | 28.63 | 254.72

2006 140.52 | 398.62 | 180.12 | 52.43 | 0.76 | 1.91 | 0.63 0.57 0.31 1.88 18.62 | 17.58 | 813.95

2007 196.55| 13.33 | 171.26 | 122.63 | 3.21 | 0.84 | 0.07 0.68 0.20 4.93 5.28 | 11.42 | 530.40

2008 259.04 | 586.81 | 279.94 | 304.50 | 10.17 | 3.06 | 0.95 0.65 0.37 7.99 8.04 2.40 |1463.93

2009 676.15| 247.00 | 172.26 | 8546 | 457 | 097 | 0.14 0.64 0.35 1.75 9.28 | 22.57 | 1221.15

2010 152.33 | 303.11 | 186.92 | 396.49 | 6.15 | 1.71 | 0.43 0.47 0.64 5.88 6.56 | 16.87 | 1077.53

2011 61.86 | 96.57 5.03 486.70 | 3.03 | 243 | 2.04 0.30 0.39 4.35 8.98 | 27.01 | 698.71
2012 241.95| 532.55 | 306.76 | 752.09 | 20.13 | 2.84 | 0.30 0.31 0.06 4.59 13.36 | 10.74 | 1885.67
2013 84.16 | 68.36 | 188.96 | 80.73 | 20.90 | 0.89 | 0.23 0.55 0.35 19.13 2.66 9.00 | 475.92
2014 70.29 | 67.34 19.16 31.54 | 42.00 | 10.50 | 0.43 0.48 0.52 16.36 3.73 | 33.98 | 296.34
2015 55.76 | 98.61 | 363.32 | 337.85 | 47.06 | 4.40 | 0.56 0.36 0.27 10.19 | 18.08 | 22.59 | 959.03
2016 148.00 | 383.95 | 188.04 | 530.20 | 1.63 | 10.21 | 0.24 0.41 0.97 2.35 2.83 | 20.07 | 1288.92
2017
2018
2019
2020
2021
2022
PROMEDIO | 148.4 | 216.3 186.3 304.3 13.8 3.4 0.5 0.5 0.4 6.5 8.2 20.9 672.2
MAXIMO 676.2 | 586.8 363.3 994.0 | 47.9 | 105 2.0 0.7 1.0 19.1 20.7 47.0 | 1885.7
MINIMO 11.3 13.3 5.0 315 0.8 0.7 0.0 0.3 0.1 1.3 2.1 2.4 | 254.72

DESVIACION |156.38 | 177.79 | 113.13 | 273.14 | 16.35 | 3.35 | 0.47 0.12 0.24 5.37 6.02 | 11.07 | 585.47

Fuente: SENAMHI
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lisis estadistico (saltos y tendencias).
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Anexo 2: Hidrogramas de los registros de precipitaci

HIDROGRAMA PRECIPITACION ESTACION "CAMPAMENTO SEDE"
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HIDROGRAMA PRECIPITACION ESTACION "LA CRUZ"
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HIDROGRAMA PRECIPITACION ESTACION "EL TIGRE"
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HIDROGRAMA PRECIPITACION ESTACION "CANAVERAL"
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HISTGRAMA PRECIPITACION ESTACION "MATAPALO"

Precipitacion acumulada mensual (mm)
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HIDROGRAMA PRECIPITACION ESTACION "v2"

Precipitacion acumulada mensual (mm)
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Anexo 3: Diagramas doble masa pre andlisis estadistico (saltos y tendencias).

Analisis doble masa de 8 estaciones ubicadas en la zona de la cuenca del rio Tumbes: Campamento sede, La cruz, El tigre, Cabo Inga, Cafiaveral, Matapalo, V1y V2

Estacion

) "Can;g:g:ento Estacion "La Cruz" | Estacion "El tigre" Estaclir?;;"ICabo "E:F:ZSL?QI" Estacion "Matapalo" Estacion "V1" Estacion "V2" Prgf&ﬁ:te%ﬁic?n
Afio anual
P. Anual | P. Acum | P. Anual | P. Acum | P. Anual | P. Acum | P.Anual | P. Acum | P.Anual | P. Acum | P. Anual | P. Acum | P.Anual | P. Acum | P.Anual | P. Acum acumulada
(mm) (mm) (mm) (mm) (mm) (mm) (mm) (mm) (mm) (mm) (mm) (mm) (mm) (mm) (mm) (mm) (mm)
2000 | 211.20 | 211.20 | 222.80 | 222.80 | 480.10 | 480.10 | 739.70 | 739.70 | 272.63 | 272.63 | 690.40 | 690.40 | 795.58 | 795.58 | 919.05 | 919.05 541.43
2001 | 361.30 | 572.50 | 325.40 | 548.20 | 511.30 | 991.40 | 1110.80 | 1850.50 | 634.16 | 906.79 | 607.70 | 1298.10 | 1453.78 | 2249.36 | 1013.35| 1932.40 | 1293.66
2002 | 617.30 |1189.80 | 439.90 | 988.10 | 785.90 | 1777.30 | 1344.40 | 3194.90 | 853.68 |1760.47 | 800.50 | 2098.60 | 1606.29 | 3855.65 | 1722.25 | 3654.65 | 2314.93
2003 | 137.90 | 1327.70 | 95.90 |1084.00 | 249.10 | 2026.40 | 472.30 | 3667.20 | 149.13 |1909.60 | 367.10 | 2465.70 | 298.46 | 4154.11 | 429.68 | 4084.33 | 2589.88
2004 | 136.40 | 1464.10 | 131.00 | 1215.00 | 272.20 | 2298.60 | 347.20 | 4014.40 | 149.80 |2059.40 | 469.00 | 2934.70 | 275.01 | 4429.12 | 410.19 | 4494.51 | 2863.73
2005| 95.40 |1559.50| 81.10 |1296.10 | 148.50 | 2447.10 | 311.50 | 4325.90 | 74.02 |2133.42| 272.00 | 3206.70 | 255.06 | 4684.18 | 254.72 | 4749.24 | 3050.27
2006 | 382.50 | 1942.00 | 340.10 | 1636.20 | 494.70 | 2941.80 | 847.40 | 5173.30 | 334.18 |2467.60 | 802.70 | 4009.40 | 940.92 | 5625.10 | 813.95 | 5563.18 | 3669.82
2007 | 147.70 | 2089.70 | 173.70 | 1809.90 | 252.15 | 3193.95 | 458.10 | 5631.40 | 229.03 | 2696.63 | 582.90 | 4592.30 | 464.89 | 6089.99 | 530.40 | 6093.58 | 4024.68
2008 | 534.37 | 2624.07 | 522.00 |2331.90 | 729.40 | 3923.35 | 1125.40 | 6756.80 | 564.17 | 3260.80 | 1028.90 | 5621.20 | 1636.46 | 7726.45 | 1463.93 | 7557.51 | 4975.26
2009 | 348.90 | 2972.97 | 285.80 | 2617.70 | 495.42 | 4418.77 | 1242.40 | 7999.20 | 514.20 |3775.00 | 713.20 | 6334.40 | 1366.70 | 9093.15 | 1221.15 | 8778.67 | S5748.73
2010 | 488.10 | 3461.07 | 372.70 | 2990.40 | 634.70 | 5053.47 | 1149.40 | 9148.60 | 407.78 |4182.79|1050.70 | 7385.10 | 928.34 |10021.50 | 1077.53 | 9856.20 | 6512.39
2011 | 130.00 |3591.07 | 125.50 |3115.90 | 243.10 | 5296.57 | 632.70 | 9781.30 | 192.18 |4374.96 | 426.80 | 7811.90 | 286.10 | 10307.59 | 698.71 | 10554.90| 6854.27
2012 | 414.70 | 4005.77 | 319.90 |3435.80 | 765.20 | 6061.77 | 1678.00 | 11459.30 | 693.10 |5068.07 | 877.00 | 8688.90 | 1897.15 | 12204.74 | 1885.67 | 12440.57 | 7920.61
2013 | 199.80 | 4205.57 | 199.30 |3635.10 | 260.42 | 6322.19 | 442.30 |[11901.60 | 229.52 |5297.59 | 640.10 | 9329.00 | 495.08 |12699.82 | 475.92 | 12916.50| 8288.42
2014 | 148.16 | 4353.73 | 114.20 | 3749.30 | 273.02 | 6595.21 | 440.30 [12341.90| 98.90 |5396.49 | 481.31 | 9810.31 | 187.64 |12887.46 | 296.34 |13212.84| 8543.41
2015 | 457.10 | 4810.83 | 344.30 | 4093.60 | 798.50 | 7393.71 | 1276.70 | 13618.60 | 513.18 |5909.67 | 1031.89 | 10842.20 | 902.59 |13790.06 | 959.03 |14171.87| 9328.82
2016 | 523.00 | 5333.83 | 346.49 | 4440.09 | 757.30 | 8151.01 | 998.40 |14617.00| 473.30 |6382.97 | 1000.83 | 11843.03 | 1039.11 | 14829.16 | 1288.92 | 15460.79 | 10132.23
2017 | 670.90 | 6004.73 | 728.90 |5168.99 | 1120.31 | 9271.32 | 1178.50 | 15795.50 | 324.20 | 6707.17 | 1018.10 | 12861.13| 0.00 |14829.16| 0.00 |15460.79| 10762.35
2018 | 121.20 | 6125.93 | 119.50 |5288.49 | 245.20 | 9516.52 | 386.40 |16181.90| 118.70 | 6825.87 | 410.20 |13271.33| 0.00 |14829.16| 0.00 |15460.79| 10937.50
2019 | 232.50 | 6358.43 | 200.10 |5488.59 | 693.70 |10210.22 | 918.90 |17100.80 | 408.80 | 7234.67 | 851.60 |14122.93| 0.00 |14829.16| 0.00 |15460.79| 11350.70
2020 | 256.80 | 6615.23 | 170.50 | 5659.09 | 291.20 |10501.42| 421.00 |17521.80| 187.00 |7421.67 | 582.70 |14705.63| 0.00 |14829.16| 0.00 |15460.79| 11589.35
2021 | 206.10 | 6821.33 | 160.00 |5819.09 | 350.00 |10851.42| 598.10 |18119.90| 167.60 |7589.27 | 605.40 |15311.03| 0.00 |14829.16| 0.00 |15460.79| 11850.25
2022 | 214.10 | 7035.43| 77.10 |5896.19| 0.00 |10851.42| 333.90 |18453.80| 47.10 |7636.37 | 439.00 |15750.03| 0.00 |14829.16| 0.00 |15460.79| 11989.15
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(01) Diagrama doble masa - Estacién "Campamento Sede"
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(02) Diagrama doble masa - Estacion "La Cruz"
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(03) Diagrama doble masa - Estacion "El Tigre"
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Precipitacion anual acum. (mm)
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(04) Diagrama doble masa - Estaciéon "Cabo Inga"
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(05) Diagrama doble masa - Estacién "Canaveral"
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(06) Diagrama doble masa - Estacion "Matapalo”
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Precipitacion anual acum. (mm)

(07) Diagrama doble masa - Estacién "V1"
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Diagrama doble masa referido al promedio anual acumulado de 8 estaciones: Campamento sede, La cruz, El tigre,
Cabo Inga, Cafiaveral, Matapalo, V1y V2.
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Precipitacion anual acum. (mm)

Diagrama doble masa referido a la estacion base "Campamento Sede": Campamento sede, La
cruz, El tigre, Cabo Inga, Cafaveral, Matapalo, V1y V2.
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Anexo 4: Tabla "t student" y “F de Fisher” utilizadas en el analisis estadistico
(saltos y tendencias).

Tabla t-Student e . v 1 T —
to
Grados de
libertad 0.25 0.1 0.05 0.025 0.01 0.005

1 1.0000 3.0777 6.3137 12.7062 31.8210 63.6559
2 0.8165 1.8856 2.9200 4.3027 6.9645 9.9250
3 0.7649 1.6377 2.3534 3.1824 4.5407 5.8408
4 0.7407 1.5332 2.1318 2.7765 3.7469 4.6041

5 0.7267 1.4759 2.0150 2.5706 3.3649 4.0321

6 0.7176 1.4398 1.9432 2.4469 3.1427 3.7074
7 0.7111 1.4149 .8946 2.3646 2.9979 3.4995
8 0.7064 1.3968 .8595 2.3060 2.8965 3.3554
9

0.7027 1.3830 .8331 2.2622 2.8214 3.2498

1
i
1
10 0.6998 1.3722 1.8125 2.2281 2.7638 3.1693
11 0.6974 1.3634 1.7959 2.2010 2.7181 3.1058
12 0.6955 1.3562 1.7823 2.1788 2.6810 3.0545
13 0.6938 1.3502 1.7709 2.1604 2.6503 3.0123
14 0.6924 1.3450 1.7613 2.1448 2.6245 2.9768
15 0.6912 1.3406 1.7531 2.1315 2.6025 2.9467
16 0.6901 1.3368 1.7459 2.1199 2.5835 2.9208
17 0.6892 1.3334 1.7396 2.1098 2.5669 2.8982
18 0.6884 1.3304 1.7341 2.1009 2.5524 2.8784
19 0.6876 1.3277 1.7291 2.0930 2.5395 2.8609
20 0.6870 1.3253 1.7247 2.0860 2.5280 2.8453
21 0.6864 1.3232 1.7207 2.0796 2.5176 2.8314
22 0.6858 1.3212 1.7171 2.0739 2.5083 2.8188
23 0.6853 1.3195 1.7139 2.0687 2.4999 2.8073
24 0.6848 1.3178 1.7109 2.0639 2.4922 2.7970
25 0.6844 1.3163 1.7081 2.0595 2.4851 2.7874
26 0.6840 1.3150 1.7056 2.0555 2.4786 2.7787
27 0.6837 1.3137 1.7033 2.0518 2.4727 2.7707
28 0.6834 1.3125 1.7011 2.0484 2.4671 2.7633
29 0.6830 1.3114 1.6991 2.0452 2.4620 2.7564
30 0.6828 1.3104 1.6973 2.0423 2.4573 2.7500
31 0.6825 1.3095 1.6955 2.0395 2.4528 2.7440
32 0.6822 1.3086 1.6939 2.0369 2.4487 2.7385
33 0.6820 1.3077 1.6924 2.0345 2.4448 2.7333
34 0.6818 1.3070 1.6909 2.0322 2.4411 2.7284
35 0.6816 1.3062 1.6896 2.0301 2.4377 2.7238
36 0.6814 1.3055 1.6883 2.0281 2.4345 2.7195
37 0.6812 1.3049 1.6871 2.0262 2.4314 2.7154
38 0.6810 1.3042 1.6860 2.0244 2.4286 2.7116
39 0.6808 1.3036 1.6849 2.0227 2.4258 2.7079
40 0.6807 1.3031 1.6839 2.0211 2.4233 2.7045
41 0.6805 1.3025 1.6829 2.0195 2.4208 2.7012
42 0.6804 1.3020 1.6820 2.0181 2.4185 2.6981
43 0.6802 1.3016 1.6811 2.0167 2.4163 2.6951
44 0.6801 1.3011 1.6802 2.0154 2.4141 2.6923
45 0.6800 1.3007 1.6794 2.0141 24121 2.6896
46 0.6799 1.3002 1.6787 2.0129 2.4102 2.6870
47 0.6797 1.2998 1.6779 2.0117 2.4083 2.6846
48 0.6796 1.2994 1.6772 2.0106 2.4066 2.6822
49 0.6795 1.2991 1.6766 2.0096 2.4049 2.6800

Fuente: Hidrologia Estadistica (Villon, 2006)
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Tabla t-Student Continuacion...

50 0.6794 1.2987 1.6759 2.0086 2.4033 2.6778
51 0.6793 1.2984 1.6753 2.0076 2.4017 2.6757
52 0.6792 1.2980 1.6747 2.0066 2.4002 2.6737
53 0.6791 1.2977 1.6741 2.0057 2.3988 2.6718
54 0.6791 1.2974 1.6736 2.0049 2.3974 2.6700
55 0.6790 1.2971 1.6730 2.0040 2.3961 2.6682
56 0.6789 1.2969 1.6725 2.0032 2.3948 2.6665
57 0.6788 1.2966 1.6720 2.0025 2.3936 2.6649
58 0.6787 1.2963 1.6716 2.0017 2.3924 2.6633
59 0.6787 1.2961 1.6711 2.0010 2.3912 2.6618
60 0.6786 1.2958 1.6706 2.0003 2.3901 2.6603
61 0.6785 1.2956 1.6702 1.9996 2.3890 2.6589
62 0.6785 1.2954 1.6698 1.9990 2.3880 2.6575
63 0.6784 1.2951 1.6694 1.9983 2.3870 2.6561
64 0.6783 1.2949 1.6690 1.9977 2.3860 2.6549
65 0.6783 1.2947 1.6686 1.9971 2.3851 2.6536
66 0.6782 1.2945 1.6683 1.9966 2.3842 2.6524
67 0.6782 1.2943 1.6679 1.9960 2.3833 2.6512
68 0.6781 1.2941 1.6676 1.9955 2.3824 2.6501
69 0.6781 1.2939 1.6672 1.9949 2.3816 2.6490
70 0.6780 1.2938 1.6669 1.9944 2.3808 2.6479
71 0.6780 1.2936 1.6666 1.9939 2.3800 2.6469
72 0.6779 1.2934 1.6663 1.9935 2.3793 2.6458
73 0.6779 1.2933 1.6660 1.9930 2.3785 2.6449
74 0.6778 1.2931 1.6657 1.9925 2.3778 2.6439
75 0.6778 1.2929 1.6654 1.9921 2.3771 2.6430
76 0.6777 1.2928 1.6652 1.9917 2.3764 2.6421
77 0.6777 1.2926 1.6649 1.9913 2.3758 2.6412
78 0.6776 1.2925 1.6646 1.9908 2.3751 2.6403
79 0.6776 1.2924 1.6644 1.9905 2.3745 2.6395
80 0.6776 1.2922 1.6641 1.9901 2.3739 2.6387
81 0.6775 1.2921 1.6639 1.9897 2.3733 2.6379
82 0.6775 1.2920 1.6636 1.9893 2.3727 2.6371
83 0.6775 1.2918 1.6634 1.9890 2.3721 2.6364
84 0.6774 1.2917 1.6632 1.9886 2.3716 2.6356
85 0.6774 1.2916 1.6630 1.9883 2.3710 2.6349
86 0.6774 1.2915 1.6628 1.9879 2.3705 2.6342
87 0.6773 1.2914 1.6626 1.9876 2.3700 2.6335
88 0.6773 1.2912 1.6624 1.9873 2.3695 2.6329
89 0.6773 1.2911 1.6622 1.9870 2.3690 2.6322
90 0.6772 1.2910 1.6620 1.9867 2.3685 2.6316
91 0.6772 1.2909 1.6618 1.9864 2.3680 2.6309
92 0.6772 1.2908 1.6616 1.9861 2.3676 2.6303
93 0.6771 1.2907 1.6614 1.9858 2.3671 2.6297
94 0.6771 1.2906 1.6612 1.9855 2.3667 2.6291
95 0.6771 1.2905 1.6611 1.9852 2.3662 2.6286
96 0.6771 1.2904 1.6609 1.9850 2.3658 2.6280
97 0.6770 1.2903 1.6607 1.9847 2.3654 2.6275
98 0.6770 1.2903 1.6606 1.9845 2.3650 2.6269
99 0.6770 1.2902 1.6604 1.9842 2.3646 2.6264
100 0.6770 1.2901 1.6602 1.9840 2.3642 2.6259

0 0.6745 1.2816 1.6449 1.9600 2.3263 2.5758

Fuente: Hidrologia Estadistica (Villon, 2006)
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Iskbla 5 VALORES F DE LA DISTRIBUCION F DE FISHER

my = greados de Erertad del numerador
d-a=P(FE£T, ..) nz = grados de Fberad del denominador
g g 1 2 3 4 5 8 T a @ 10 11 12 13 14 15 16 17 18 1@ 20
1 1010485 1560458 ZIOT0T 224553 ZI0WM ZIISSS ZIGTOT IIOSSS 40043 241002 2425040 43805 I44080 245300 40545 D40AGS DAGEIT 247 324 DATGSS 40010
2 13513 19000 TEISS 18347 19250 0 fEEZS 150333 1371 19305 15350 2 1B400 18412 15418 190424 18439 15433 150437 18440 TE443 1804340
k| LU RN -T BITT BT N k] 841 ooy L. PE ] p.p12 =Tna n.7ea DTS mTza BT 0. T .1 =no3 LT nunET L.
4 T.708 = 544 LR 0308 200 [R5 [N 6041 0.8a8 =504 o =3 |- B: B =oat 5T o.nms L ¥. P =naz nEE 2811 =003
5 n.ooa = Tne 5408 B1ER =030 4,850 4 ETe s 4772 4735 & T q.a7s 4.055 4 =30 s 4,004 4980 o TE R ] 4.050
5] n.8a7T =943 4T 4034 4.307 a.2m4 4207 £.147 4.0a8 4.000 & DT 4,000 3870 3 =00 3,838 3.azr 3 500 3 a0 3.0m4 1074
T B.081 4.73T 4347 4120 3 8T2 R amT ] 3.07T 037 303 3.ars 3 0540 el ] 3811 3484 2400 34T ] 34850
a 5,318 4.488 & o R 1] 3 000 R 3300 3.a3n 3.300 3 34T 3313 3204 3258 3 23T aze 320 3 a0T 3173 R 3450
a 81T 4280 3.med 3633 3402 3374 az8a3 3230 3478 43T 3102 3.073 3040 3 029 300 2809 -2 1 2 S 284 Z 8306
10 4.805 4103 3.7on 4TS 3320 3T a13s aorz 3.020 z 870 2 543 Z813 ZoaT -2 2045 . F ] Znaz 2 70 2T ZTTA
11 4D 3 503 35T 3anr 3 204 FooEs 3omz 284 2.non Znos 2 =10 -] =01 z 73g 2.TS .7 Znoa 2571 ] Z 080
12 4.T4T 115 ] 3450 o B-F ] 3106 -8 =] 2503 204 2786 z 783 27T 2.1 Z 060 Z eaT 2817 . 1 ] z 003 2 e Zams 3.7
13 4.067T 3 nog 3411 34T 3023 Z815 2 53z 2. 7T 2714 871 23 2004 ZOTT X 2.a%3 2815 z.488 2 4ima 2.a71 Za58
14 4.000 T3 3344 311z z 850 . FE] 2 7oa 2o 2.0 znoz 2 e Z.a34 00T Z 404 ] e z.Aa20 2413 00 Z 300
15 4.043 3002 3.7ET 3056 2801 2.TE0 2 7o7 2041 2000 3.2 2 T ZATS a8 Z 424 ] 2305 z3on 2 353 2340 Z3zn
16 4.484 3034 3.z3m 3007 znaz 274 2 maT 2 a1 2030 Z.A84 2 430 Zazs = 38T z 373 2.3z 2333 Z 34T 2 309 2 3276
7 4,451 3 08z R Z.865 Zom0 ZooEs 2 mna 204 Z.4B4 z.400 2413 z.301 Z3s3 z 38 5 ] z 209 z2T2 2 Py Z243 Z 230
18 4,418 3 800 ERT- -3 ] 2773 Zme1 2577 2510 2456 z412 2374 2342 314 Z 780 ] 2250 Z 233 2217 2203 481
18 4.301 3023 3137 zoEs Z.Ta0 ] 2544 2477 2423 z3Ta 2 340 2308 200 z 2n0 2234 2215 Za80 2 1m2 AT R EL]
20 4.351 3483 3.050 . 1] 2T . =] 23504 2847 2.383 =340 2310 zars Z 250 31 1 2203 R ZA0T 2 151 23T Z 124
21 4.325 40T 3072 2040 1.1 %] z.a73 2 400 2430 2,366 Z3z 2 zea 2280 2232 Z 18T 2ATE 2106 za38 2123 AT ] Z 086
72 4.301 3443 3045 2. b Z001 204 2 404 2357 2342 = 2T 2 78 Z220 Z a0 Z173 2131 Z131 Z A 2 o0 204 2071
23 4.278 3422 3.0E0 2T Z.na0 2 ] 2 442 2.37s z.320 z273 2 730 2204 zara Z 180 2138 T ] Z 081 2 0T 201 Z 00
24 4.200 2403 3,008 - ] a1 200 2423 2.3%s 2.300 -3-1. . 2210 Z103 R EL] z 130 2. 10 2008 Z070 2 oo 2040 0T
25 4242 3303 2 mE - ] z.n03 ] 2 405 2337 2202 z 230 2 150 R T Za36 Z 111 20 LT 08 2 oas 2oz Z 00T
26 4.225 = 308 28T 2T 3.1 zaT4 2 300 2 321 2265 =220 2 1 ] 18 - ] zom= Z 034 2 018 2003 1.880
27 4.210 3304 2 S 2T 2072 ] 2373 230 2250 j-3-1, 7] 2 1m0 - -] =803 Z 07D 20 2036 Z 0% 2 oog LK 1.874
2B 41846 3340 2547 T4 3.5 ] 2 2 308 2 231 2236 Z 480 2 131 L] Zoo8 Z on4 2,041 021 Z 003 1.meT LK ] 1.8458
0 4.803 3320 250 T 3.2 L] I ] 2 340 2.27s 2223 ZATT 2 130 Z104 zoTa Z oo 20T 007 1.508 1873 L] 1.845
30 4471 390 2.5a2 2680 Z034 Zaz1 2334 2 e 2211 R 1] 2 120 2 1 ] Z 063 Z 0aT 2013 1.8985 1.870 1S 18455 1.832
40 4.005 3233 2 mas 2608 z.448 233 2 zam 2. 1m0 2124 2077 2 oo 2003 1.974 1540 18924 1.804 1003 1_imen 1.a53 1.038
50 4.034 3 103 2.7 zam7 Z.400 22 2 188 2,130 2073 z02n 150 1892 1.821 1883 1871 1.050 1.031 1814 1.7 1.704
B0 4.001 R 2750 zazs z 300 2254 2187 2087 200 1.883 1.5z 1817 1.087 1m0 1,038 1015 1.780 1.7 1TeE 1.780
o 3.870 3 020 2.730 2503 z 340 2231 2 143 2,074 2T 1.808 150 1.083 1.063 1530 1012 1.780 1771 173 .77 1.722
BO 3.8960 = 111 271 e z3za Z214 2 120 2 o 1.998 1851 1910 AT 1.045 10T 1.7 1TT= 1702 1T T 1.703
=Tn} 3.847T 3 080 2 700 ZATI Z380 2201 2113 2043 1.500 1.830 1T 1.061 1.030 1803 1.7 1.7ar 1.737 1T 1.ToE 1.000
100 3.806 3007 2 =0 Za03 z 308 Z1m1 2103 203z 1.873 1.827 1_imama 1.050 1.018 1.782 1.7 1.7 1.720 1700 1.5 1.070
200 3.no0 3041 2 - z 208 2144 2 oo 1.8 1.82T 1070 1imET 1.001 1.708 174z 1717 1,084 1.074 1m0 L] 1.823
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El por rene F ¥ Ao,

Fuente: Hidrologia Estadistica (Villon, 2006)
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Iablag 5 VALORES F DE LA DISTRIBUCION F DE FISHER
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Fuente: Hidrologia Estadistica (Villon, 2006)
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Anexo 5: Analisis estadistico de saltos y tendencias

ANALISIS DE SALTOS:

1. CONSISTENCIA DE LA MEDIA

a. Calculo de la media y desviacion estandar para cada periodo, segun:

2

nq ny 1/
e =N _t £ 32
= S0 = Y (= 7))

2

ny Ny 1/
o . ot - 2
Xy = ijlsz(x)—[ Z(xj_xz)]

Ny 4 . nz—lj 4

]: =

b. Estadistica T

Calculamos la desviacion estandar de las diferencias de promedios.

o =[O = DS+ (np — DSF2
P ny+n, —2

Célculo de Tc

Hallar el valor de Tt en las tablas con:
N.C. = 95% de probabilidades
a=0.05

GL=n+n,-2

2. CONSISTENCIA DE LA DESVIACION ESTANDAR

Se realiza con la prueba “F” de |la forma que a continuacion se describe
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a. Calculo de las varianzas de ambos periodos.

ny
1 —
St =——= > (X))’ (25)
n,—1 i
1 <
—\2
Sp=—— > (y-X) (26)
n, =

b. Célculo del F calculado (Fc), como sigue:

Fo=305, i S100>S500 (27)

Fo=329 o §2(x) > S(x) (28)

T s2()

c. Célculo del F tabular (Ft), con:

a=0.05
Nc = 95%
G.L.LN.=n;—1
G.L.D.=n,—1

d. Conclusiones
F. < F; (95%) Aceptar HP (muestra consistente)

F. > F; (95%) Aceptar HA (muestra inconsistente)

3. CORRECCION DE LOS DATOS

Si la media y la desviacion estandar resultan estadisticamente diferentes, entonces
se corrige mediante una ecuacion que permite mantener los parametros del periodo

mas confiable, dicha ecuacion se expresa como:

a) Siel periodo 1 es el dudoso y el periodo 2 el confiable, entonces:

. x1—X —
xl :< 1S 1>52 +X2 (29)

1
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b) Sien cambio, el periodo 1 es el confiable y el periodo 2 el dudoso corregible,
entonces la expresion (29) se convierte en la (30).

, x1 - XZ I
x1 = S Sl + X1 (30)

2

Donde:

x,= Dato a corregir
x,= Dato corregido
S= Variancia

X= Media

ANALISIS DE TENDENCIAS:

1. TENDENCIA EN LA MEDIA

Latendencia en la media Tm,, . puede expresarse en forma general por el siguiente

polinomio:
Tmy,, = Ay + Byt + Cput? + Dt + -, (31)
Y en forma particular por la ecuaciéon de regresion lineal simple:
Tmy, = Am + Bt (32)

Donde:

Tm, .= Proceso no estacionario, esto es, la informacion hidrometeoroldgica
corregida por saltos.

t = Tiempo
p=1,23...., = Numero de afios del registro

=1, 2, 3,..., w= Periodo basico e igual a 365, 52 0 12, segun que la serie
sea diario, semanal o anual, respectivamente.

A, By, Cp,.. = coeficientes de los polinomios de regresion, que deben ser
estimados con los datos.
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a) Calculo de los parametros de la ecuacion de simple regresion lineal.

A, =T—iB, (33)

By = R (34)

R= ' (35)
St-Stm
Donde:
1w 1w
Ty = EZ T = ;Z X i (36)
i=1 i=1
1 n
F=->¢ 37)
e
1 n
i=1
n (T . —T )2 1
Stm — ( l—l(nm_l 1 m) )i (39)
it —0)* 1
Sy =( — )2 (40)
Donde:

T,,=promedio de las tendencias Tm, o promedio de los datos corregidos de
saltos X'(t).

t= promedio del tiempo t.
Stm= desviacion estandar de la tendencia de la media Tm

S¢= desviacion estandar del tiempo.
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b) Evaluacién de la tendencia Tm

1. Célculo del estadistico t segun:

(=2 41)
V1 —R?

Donde:
t.= valor del estaditico t calculado.
n= numero de datos
R= coeficiente de correlacion

2. Caélculo de t tabular

El valor critico de t, se obtiene de la tabla t de student, con 95% de probabilidad
o con un nivel de significacion del 5% es decir:
GL=n-2

a = 0.05
3. Los criterios de aceptacion o de rechazo de la hipétesis planteada se

establecen segun las condiciones siguientes:
Si:

|T,| < T.(ed =95%) Aceptar HP (prueba no significativa)
|T,| > T.(ed =95%) Aceptar HA (prueba significativa)

En el primer caso, la muestra es consistente, sin saltos ni tendencias; en cambio
en el segundo caso, la tendencia es significativa y entonces se procede a

eliminarla, tal como se explica a continuacion.
2. TENDENCIA EN LA DESVIACION ESTANDAR

La tendencia en la variancia generalmente se presenta en los datos semanales o
mensuales, mas no en los anuales. Esta tendencia, al igual que la media, puede

ser aproximada por la ecuacioén polinomial siguiente:

TS,. = As + Bs + Cst? + Dgt> 4+ (42)
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Donde:

TS, .= Tendencia en la variancia
™=1,2,...,n
n= Longitud del registro en afos

Ag, Bg, C, Ds= Son coeficientes del polinomio de regresion y se estiman a
partir de los datos de la muestra.

A. Analisis estadistico de saltos y tendencias a los registros pluviométricos de

la estacion “Campamento Sede”.

(01) Diagrama doble masa - Estacion "Campamento Sede"
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ANALISIS DE SALTOS:

1. CONSISTENCIA DE LA MEDIA

a. Calculo de la media y desviacion estandar para cada periodo, segun la figura

anterior.
+  DATOS CONFIABLES - + DATOS DUDOSOS
Periodos Muestrales Periodos Muestrales
ENTRE LOS ANOS 2000 - 2011 ENTRE LOS ANOS 2012 - 2022
Tamafio de la muestra(nl)= 144 Tamarfio de la muestra (n2)= 132
Media de la muestra X, = 24.94  |[Mediadelamuestra X, =  26.09
Deswviacion Stand.(S1) = 55.08 Desviacion Stand(S2)= 54.94
Grados de libertad(GL1)= 143 Grados de libertad(GL2)= 131
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b. Estadistica T

PRUEBA "T" DE STUDENT
Desviacion estandar ponderada 55.02
Desviacion de las diferencias de los promedios 6.63
Célculo del T, calculado (Tc) segun: 0.17
Calculo del valor critico de t, tabular Tt: 1.97
Grados de libertad 274.00

Conclusion:
[t.|= o017 <

Tt= 197 HOMOGENEIDAD OK

En este caso, siendo las medias estadisticamente iguales, no se debe realizar
proceso de correccion.

2. CONSISTENCIA DE LA DESVIACION ESTANDAR

PRUEBA "F" DE FISHER
Célculo de F calculado (Fc)segun : 1.01
Calculo del F tabular( valor critico de Ft) Ft 1.33

Conclusion:

Fr= 101 < F, =133 HOMOGENEIDAD OK

No se debe realizar el proceso de correccion

ANALISIS DE TENDENCIAS:

1. TENDENCIA EN LA MEDIA

t T Tm*t
Prom 138.5 25.49 3428.50
DESEST 79.82 54.92 8361.00

a) Calculo de los parametros de la ecuaciéon de simple regresion lineal.

= Numero de meses

276.00
T,, = Promedio de las tendencias Tm, o promedio de los datos corregidos de saltos X't 25.49
t=  Promediodel tiempot 138.5
Stm =  Desviacién estandar de la tendencia de la media Tm 54.92
St = desviacion estandar del tiempo t 79.82
t* T, = Promediode tendenciasy tiempo 3428.50
R = -0.0233
Bm = -0.0160
Am = 27.7072

Ecuacién de regresion lineal: 27.707 +-0.016.t Tm,,

B "'L"’-. T Bmt
b) Evaluacién de la tendencia Tm
Célculo del T, calculado (Tc) segun: 0.39
Calculo del valor critico de t, tabular Tt: 1.97
Grados de libertad 274.00
Conclusion:
[t.l = 039 = Tt=

1.9687 HOMOGENEIDAD OK
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R no es significativo, en este caso, la tendencia no es significativa y no hay que

corregir.

2. TENDENCIA EN LA DESVIACION ESTANDAR

Afo Periodo (t) Sp t*Sp Periodo (t) Sp t*Sp
2000 1] 25118 25.12 Prom 12.00 4691 | 553.89
2001 2| 57412 | 114.82 DESEST 6.78 2093 | 47473
2002 3| 99463 | 29839
2003 4 18.164 72.66
2004 5 18.114 90.57
2005 6| 17100 | 102.60
2006 7] 76114 | 532.80
2007 8 24.526 196.21
2008 9 84.104 756.94
2009 10| 55054 | 550.54
2010 11| 72168 | 793.84
2011 12| 15739 | 18887
2012 13 52.891 687.58
2013 14 31.024 434.33
2014 15| 18542 | 27814
2015 16| 93279 | 1492.46
2016 17 80.556 1369.46
2017 18 99.986 1799.74
2018 19| 14155 | 268.95
2019 20| 29567 | 59134
2020 21| 42444 | 89132
2021 22 25.679 564.93
2022 23 27.735 637.91

a) Calculo de los parametros de la ecuacion de simple regresion lineal.

1= NUmero de meses 23.00
Sp= Desviacion estandar del afio p, es decir de los datos mensuales del afio p. 46.91
Sep = Desviacién estandar de la Desviacién estandar del afio p. Sp 29.93
t= Promedio del tiempo t 12.00
St = desviacién estandar del tiempo t 6.78
m = Promedio de desviacidn estandary tiempo 553.89
R = -0.0445
Bs = -0.1963
As = 49.2658
Ecuacion de regresion lineal: 49.266 +-0.196.t T,=A;+Bg«t

b) Evaluacién de la tendencia Tm

Calculo del T, calculado (Tc) segun: 0.20
Calculo del valor critico de t, tabular Tt: 2.08
Grados de libertad 21.00

Conclusioén:

lt.l = 020 = Tt= 2.0796 HOMOGENEIDAD OK

R no es significativo, en este caso, la tendencia no es significativa y no hay que

corregir.
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B. Analisis estadistico de saltos y tendencias a los registros pluviométricos de

la estacion “La Cruz”.

(02) Diagrama doble masa - Estacion "La Cruz"
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ANALISIS DE SALTOS:

1. CONSISTENCIA DE LA MEDIA

a. Calculo de la media y desviacion estandar para cada periodo, segun la figura

anterior.
DATOS CONFIABLES DATOS DUDOSOS
Periodos Muestrales Periodos Muestrales
ENTRE LOS ANOS 2000 - 2011 ENTRE LOS ANOS 2012 - 2022
Tamaro de la muestra(nl)= 144[Tamafio de la muestra (n2)= 127
Media de la muestra X; = 21.64|Media de la muestra Xz = 21.89
Desviacion Stand.(S1) = 47.24][Desviacion Stand(S2)= 49.60
Grados de libertad(GL1)= 143||Grados de libertad(GL2)= 126

b. Estadistica T

PRUEBA "T" DE STUDENT
Desviacion estandar ponderada 48.36
Deswviacion de las diferencias de los promedios 5.89
Calculo del T, calculado (Tc) segun: 0.04
Calculo del valor critico de t, tabular Tt: 1.97
Grados de libertad 269.00
Conclusion:
|t.| = 0.04 < Tt= 1.9688 HOMOGENEIDAD OK

En este caso, siendo las medias estadisticamente iguales, no se debe realizar
proceso de correccion.
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2. CONSISTENCIA DE LA DESVIACION ESTANDAR

PRUEBA "F" DE FISHER

Calculo de F calculado (Fc)segin : 1.10
Calculo del F tabular( valor critico de Ft) Ft 1.33
Conclusion:

Fc= 110 s F, =133 HOMOGENEIDAD OK

No se debe realizar el proceso de correccion

ANALISIS DE TENDENCIAS:

1. TENDENCIA EN LA MEDIA

t Tmpz Tm*t
Prom 138.5 21.36 2805.62
DESEST 79.82 47.92 7465.01

a) Calculo de los pardmetros de la ecuacion de simple regresion lineal.

i= Nimero de meses 271.00
Tn= Promedio de las tendencias Tm, o promedio de los datos corregidos de saltos X't 21.36
t=  Promediodel tiempot 138.5
Stm = Desviacion estandar de la tendencia de la media Tm 47.92
St = desviacion estandar del tiempot 79.82
t * T,, = Promedio de tendencias y tiempo 2805.62
R = -0.0400
Bm = -0.0240
Am = 24.6926
Ecuacion de regresion lineal: 24.693 +-0.024.t Tm,, = A, + Bt

b) Evaluacion de la tendencia Tm

Célculo del T, calculado (Tc) segun: 0.66
Calculo del valor critico de t, tabular Tt: 1.97
Grados de libertad 269.00
Conclusion:
|t.| = 0.66 < Tt= 1.9688 HOMOGOiNE'DAD

R no es significativo, en este caso, la tendencia no es significativa y no hay que
corregir.
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2. TENDENCIA EN LA DESVIACION ESTANDAR

Afo Periodo (t) Sp t*Sp

2000 1] 24458 24.46 Periodo(t) | Sp t*Sp
2001 2| 60976 121.95 Prom 12.00 40.42 474.60
2002 3| 67.902 20371 DESEST 6.78 26.89 448.18
2003 4]  9.564 38.26

2004 5| 16993 84.97

2005 6] 13713 82.28

2006 7| 59.925 419.47

2007 8| 30697 245.58

2008 9| 84.403 759.63

2009 10| 51819 518.19

2010 11| 54341 597.75

2011 12| 22200 266.40

2012 13| 41317 537.12

2013 14| 33.031 462.43

2014 15| 12203 184.39

2015 16| 61391 982.26

2016 17| 54.879 932.95

2017 18| 116363 | 2094.53

2018 19] 16920 321.49

2019 20| 30.217 604.33

2020 21| 33.678 707.23

2021 22| 21682 477.00

2022 23] 10.848 249.50

a) Calculo de los parametros de la ecuaciéon de simple regresion lineal.

i= Ndmero de meses 23.00
TS = Promedio de las tendencias Tm, o promedio de los datos corregidos de saltos X't 40.42
t= Promedio del tiempo t 12.00
Sts = Desviacion estandar de la tendencia de la media Tm 26.89
St = desviacion estandar del tiempo t 6.78
t* T, = Promedio de tendenciasy tiempo 474.60
R = -0.0571
Bs = -0.2263
As = 43.1337
Ecuacion de regresion lineal: 43.134 +-0.226.t T’ - A’ * B’I

b) Evaluacién de la tendencia Tm

Célculo del T, calculado (Tc) segun: 0.26

Calculo del valor critico de t, tabular Tt: 2.08

Grados de libertad 21.00
Conclusion:

HOMOGENEIDAD

=02 < Tt= 207
|t.| = 0.26 Tt= 2.0796 oK

R no es significativo, en este caso, la tendencia no es significativa y no hay que

corregir.
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C. Andlisis estadistico de saltos y tendencias a los registros pluviométricos de

la estacion “El Tigre”.
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ANALISIS DE SALTOS:

1. CONSISTENCIA DE LA MEDIA

N2

a. Calculo de la media y desviacion estandar para cada periodo, segun la figura

anterior.

DATOS CONFIABLES
Periodos Muestrales
ENTRE LOS ANOS 2000 - 2009

DATOS DUDOSOS
Periodos Muestrales
ENTRE LOS ANOS 2010 - 2022

Tamafo de la muestra(nl)= 120

Tamafo de la muestra (n2)= 152

Media de la muestra X, 36.82

Media de la muestra X3 43.20

Desviacion Stand.(S1) = 72.34

Desviacion Stand(S2)= 79.40

Grados de libertad(GL1)= 119

Grados de libertad(GL2)= 151

b. Estadistica T

PRUEBA "T"

DE STUDENT

Desviacion estandar ponderada

Grados de libertad

<

|t.| = 0.68

Desviacion de las diferencias de los promedios
Calculo del T, calculado (Tc) segun:
Calculo del valor critico de t, tabular Tt:

Conclusion:

Tt= 1.9688

76.37
9.33
0.68
1.97

270.00

HOMOGENEIDAD OK

En este caso, siendo las medias estadisticamente

proceso de correccion.
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2. CONSISTENCIA DE LA DESVIACION ESTANDAR

PRUEBA "F" DE FISHER

Calculo de F calculado (Fc)segun : 1.20
Calculo del F tabular( valor critico de Ft) Ft 134
Conclusion:

Fc= 120 s F,= 134 HOMOGENEIDAD OK

No se debe realizar el proceso de correccion

ANALISIS DE TENDENCIAS:

1. TENDENCIA EN LA MEDIA

t Tmpz Tm*t
Prom 138.5 39.80 5423.27
DESEST 79.82 74.50 11956.79

a) Calculo de los pardmetros de la ecuacion de simple regresion lineal.

1= Numero de meses 272.00
Tm = Promedio de las tendencias Tm, o promedio de los datos corregidos de saltos X't 39.80
t= Promedio del tiempot 138.5
Sem = Desviacion estandar de la tendencia de la media Tm 74.50
St = desviacion estandar del tiempo t 79.82
m: Promedio de tendencias y tiempo 5423.27
R = -0.0150
Bm = -0.0140
Am = 41,7445
Ecuacion de regresion lineal: 41.744 +-0.014.t Tm,, = A, +B,t

b) Evaluacion de la tendencia Tm

Calculo del T, calculado (Tc) segun: 0.25
Calculo del valor critico de t, tabular Tt: 1.97
Grados de libertad 270.00
Conclusioén:
|t.| = 025 s Te=19688 MO NEDAD

R no es significativo, en este caso, la tendencia no es significativa y no hay que

corregir.
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2. TENDENCIA EN LA DESVIACION ESTANDAR

Afo Periodo (t) Sp t*Sp

2000 1 55.939 55.94 Periodo (t) Sp t*Sp
2001 2 85.515 171.03 Prom 12.00 67.21 799.61
2002 3 116.204 348.61 DESEST 6.78 33.08 629.37
2003 4 33.900 135.60

2004 5 39.866 199.33

2005 6 29.231 175.38

2006 7 89.980 629.86

2007 8 35.560 284.48

2008 9 104.078 936.70

2009 10 76.464 764.64

2010 11 79.558 875.14

2011 12 36.372 436.46

2012 13 94.362 1226.70

2013 14 43.734 612.28

2014 15 27.368 410.53

2015 16 106.171 1698.74

2016 17 112.276 1908.69

2017 18| 125.893 2266.07

2018 19 35.648 677.32

2019 20 86.022 1720.44

2020 21 58.197 1222.13

2021 22 55.346 1217.61

2022 23 18.150 417.44

a) Calculo de los parametros de la ecuaciéon de simple regresion lineal.

i= Ndmero de meses 23.00
Ty = Promedio de las tendencias Tm, o promedio de los datos corregidos de saltos X't 67.21
t= Promedio del tiempo t 12.00
Sts= Desviacion estandar de la tendencia de la media Tm 33.08
St = desviacién estandar del tiempo t 6.78
t* Ty = Promedio de tendenciasy tiempo 799.61
R = -0.0308
Bs = -0.1502
As = 69.0121
Ecuacion de regresion lineal: 69.012 +-0.15.t T,=A+B1

b) Evaluacién de la tendencia Tm

Calculo del T, calculado (Tc) segun: 0.14

Calculo del valor critico de t, tabular Tt: 2.08

Grados de libertad 21.00
Conclusion:

HOMOGENEIDAD
OK

lt.|= 014 < Tt= 2.079

R no es significativo, en este caso, la tendencia no es significativa y no hay que

corregir.
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D. Analisis estadistico de saltos y tendencias a los registros pluviométricos de

la estacion “Cabo Inga”.

(04) Diagrama doble masa - Estacién "Cabo Inga"
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ANALISIS DE SALTOS:

1. CONSISTENCIA DE LA MEDIA

a. Calculo de la media y desviacion estandar para cada periodo, segun la figura

anterior.
DATOS CONFIABLES DATOS DUDOSOS
Periodos Muestrales Periodos Muestrales
ENTRE LOS ANOS 2000 - 2011 ENTRE LOS ANOS 2012 - 2022
Tamafio de la muestra(nl)= 144[Tamafo de la muestra (n2)= 125
Media de la muestra  X; = 67.93[Media de la muestra X = 69.38
Deswvacion Stand.(S1) = 122.91|[Desviacion Stand(S2)= 122.63
Grados de libertad(GL1)= 143||Grados de libertad(GL2)= 124

b. Estadistica T

PRUEBA "T" DE STUDENT
Desviacion estandar ponderada 122.78
Deswviacion de las diferencias de los promedios 15.01
Calculo del T, calculado (Tc) segun: 0.10
Calculo del valor critico de t, tabular Tt: 1.97
Grados de libertad 267.00
Conclusion:
|tc| = 0.10 < Tt= 1.9689 HOMOGENEIDAD OK

En este caso, siendo las medias estadisticamente iguales, no se debe realizar
proceso de correccion.
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2. CONSISTENCIA DE LA DESVIACION ESTANDAR

PRUEBA "F" DE FISHER
Calculo de F calculado (Fc)segun :
Calculo del F tabular( valor critico de Ft) Ft
Conclusion:

1.00
133

Fc= 10 < F,=133  HOMOGENEIDAD OK

No se debe realizar el proceso de correccion

ANALISIS DE TENDENCIAS:

1. TENDENCIA EN LA MEDIA

t Tmpz Tm*t
Prom 138.5 66.86 8685.90
DESEST 79.82 121.46 17954.62

a) Calculo de los pardmetros de la ecuacion de simple regresion lineal.

i= Nimero de meses

269.00
T.= Promedio de las tendencias Tm, o promedio de los datos corregidos de saltos X't 66.86
t=  Promediodel tiempot 138.5
Sim = Desviacidn estandar de latendencia de lamedia Tm 121.46
St= desviacion estandar del tiempo t 79.82
t * T,,, = Promedio de tendencias y tiempo 8685.90
R = -0.0593
Bm = -0.0902
Am = 79.3491

Ecuacion de regresion lineal: 79.349 +-0.09.t

b) Evaluacion de la tendencia Tm

Tm,, = A, + Byt

Célculo del T, calculado (Tc) segun: 0.97
Calculo del valor critico de t, tabular Tt: 1.97
Grados de libertad 267.00
Conclusioén:
HOMOGENEIDAD
|t.| = 0.97 < Tt= 1.9689

OK

R no es significativo, en este caso, la tendencia no es significativa y no hay que

corregir.
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2. TENDENCIA EN LA DESVIACION ESTANDAR

Afo Periodo (t) Sp t*Sp

2000 1| 96.373 96.37

2001 2| 150.615 301.23 Periodo (t) sp t*sp
2002 3| 182.294 546.88 Prom 12.00 111.91 1291.87
2003 4| 63.641 254.56 DESEST 6.78 56.80 995.50
2004 5| 51.488 257.44

2005 6| 59.255 355.53

2006 7| 124.656 872.59

2007 8| 69.425 555.40

2008 9| 148.566 1337.10

2009 10| 166.347 1663.47

2010 11| 159.914 1759.06

2011 12| 117.472 1409.66

2012 13| 207.760 2700.88

2013 14| 69.214 969.00

2014 15| 51.292 769.38

2015 16| 172.488 2759.80

2016 17| 138.792 2359.47

2017 18| 223.441 4021.94

2018 19| 34.899 663.07

2019 20| 115.475 2309.49

2020 21|  49.028 1029.60

2021 22| 72.206 1588.54

2022 23| 49.244 1132.61

a) Calculo de los parametros de la ecuaciéon de simple regresion lineal.

1= Numero de meses 23.00
7_"5 = Promedio de las tendencias Tm, o promedio de los datos corregidos de saltos X't 111.91
t= Promedio del tiempot 12.00
Sts= Desviacion estandar de la tendencia de la media Tm 56.80
St =  desviacion estandar del tiempo t 6.78
t+ T,= Promedio de tendencias y tiempo 1291.87
R = -0.1325
Bs = -1.1092
As = 125.2186
Ecuacién de regresion lineal: 125.219 +-1.109.t T.=A+B1

b) Evaluacién de la tendencia Tm

Calculo del T, calculado (Tc) segun: 0.61

Calculo del valor critico de t, tabular Tt: 2.08

Grados de libertad 21.00
Conclusion:

HOMOGENEIDAD

= 0.61 < = 2.07
It.| = 0.6 Tt= 2.0796 oK

R no es significativo, en este caso, la tendencia no es significativa y no hay que

corregir
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E. Analisis estadistico de saltos y tendencias a los registros pluviométricos de

la estacion “Canaveral”.

(05) Diagrama doble masa - Estacién "Cafiaveral"
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ANALISIS DE SALTOS:

1. CONSISTENCIA DE LA MEDIA

a. Calculo de la media y desviacion estandar para cada periodo, segun la figura

anterior.
DATOS CONFIABLES DATOS DUDOSOS
Periodos Muestrales Periodos Muestrales
ENTRE LOS ANOS 2000 - 2008 ENTRE LOS ANOS 2009 - 2022
Tamario de la muestra(nl)= 108[Tamafo de la muestra (n2)= 167
Media de la muestra  X; = 30.19Media de la muestra X, = 26.20
Desviacion Stand.(S1) = 71.55||Desviacion Stand(S2)= 54.45
Grados de libertad(GL1)= 107||Grados de libertad(GL2)= 166

b. Estadistica T

PRUEBA "T" DE STUDENT
Desviacion estandar ponderada 61.72
Deswviacion de las diferencias de los promedios 7.62
Calculo del T, calculado (Tc) segun: 0.52
Calculo del valor critico de t, tabular Tt: 1.97
Grados de libertad 273.00
Conclusion:
|tc| = 0.52 < Tt= 1.9687 HOMOGENEIDAD OK

En este caso, siendo las medias estadisticamente iguales, no se debe realizar
proceso de correccion.
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2. CONSISTENCIA DE LA DESVIACION ESTANDAR

PRUEBA "F" DE FISHER

Calculo de F calculado (Fc)segun : 1.73
Calculo del F tabular( valor critico de Ft) Ft 1.33
Conclusion:

NO HOMOGENEIDAD
Fc=173 > F,=133 (CORREGIR LA
PRECIPITACION)

En este caso, siendo las medias estadisticamente diferentes, se debe corregir la

informacion

CORRECCION DE SALTOS:

_ PERIODO 1 Ene 2.11 4.83
ANO MES PP xt'
— lom) X (mm) Feb 9.36 1034
Feb 74.73 60.09 Mar 48.07 39.80
Mar 61.05 49.68 Abr 12.23 12.53
Abr 100.44 79.66 May 0.01 3.23
May 26.22 23.17
2000 Jun 3.52 5.90 2005 Jun 0.03 3.25
Jul 0.00 0.00 Jul 0.00 0.00
Ago 0.00 0.00 Ago 0.00 0.00
Set 0.00 0.00 Set 0.00 0.00
Oct 0.00 0.00
Nov 0.00 0.00 Oct 0.00 0.00
Dic 5.53 7.44 Nov 0.20 3.37
Eng iéig; Z;ii Dic 2.01 4.75
Fe . R
Mar 335.28 258.39 Ene 29.04 2533
Abr 72.90 58.70 Feb 235.47 182.42
May 1.53 4.39 Mar 61.36 49.92
2001 Jun 0.00 0.00 Abr 4.79 6.87
A{”' g-gg g-gg May 0.03 3.25
go . .
Set 0.00 0.00 2006 Jun 1.19 413
Oct 0.00 0.00 Jul 0.06 3.27
Nov 2.08 4.81 Ago 0.00 0.00
Dic 2.72 5.29
Ene 12.47 12.72 Set 0.00 0.00
Feb 184.98 144.00 Oct 0.00 0.00
Mar 410.33 315.50 Nov 0.35 3.49
.\A/.Z; 29020 e Dic 1.89 4.66
2002 Jun 0.00 0.00 Ene 61.96 50.38
Jul 0.00 0.00 Feb 3.50 5.89
e =28 222 Mar 143.66 112.56
Oct 0.48 3.59 Abr 19.56 18.11
Nov 0.01 3.23 May 0.02 3.24
Dic 1.83 4.61
Ene 22.62 20.43 2007 Jun 0.00 0.00
Feb 56.64 46.33 Jul 0.00 0.00
Msr 14.15 13.99 Ago 0.00 3.23
Abr 42.29 35.41
May 0.66 3.72 Set 0.00 0.00
2003 Jun 0.19 3.37 Oct 0.00 0.00
Jul 0.05 3.26 Nov 0.08 3.28
Ago 0.00 0.00 -
Set 0.00 0.00 Dic 0.24 3.40
Oct 0.00 0.00 Ene 124.74 98.16
Nov 0.01 3.23 Feb 301.04 232.33
Dic 12.54 12.77
Ene 322 5.67 Mar 126.37 99.39
Feb 78.22 62.75 Abr 8.18 9.45
Mar 37.93 32.09 May 0.51 3.61
Abr 23.55 21.14
May o 260 2008 Jun 0.11 3.31
2004 Jun 0.00 0.00 Jul 0.92 3.93
Jul 0.07 3.28 Ago 0.00 0.00
Ago 0.00 0.00
Set 0.00 0.00 Set 0.00 0.00
Oct 5.00 7.03 Oct 2.22 4.91
Nov 0.00 0.00 Nov 0.08 3.28
Dic 0.00 0.00 o 0.00 0.00
ic . .
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ANALISIS DE SALTOS (CON AL INFORMACION CORREGIDA):

1. CONSISTENCIA DE LA MEDIA

a. Célculo de la media y desviacion estandar para cada periodo, segun la figura

anterior.
DATOS CONFIABLES DATOS DUDOSOS
Periodos Muestrales Periodos Muestrales
ENTRE LOS ANOS 2000 - 2008 ENTRE LOS ANOS 2009 - 2022
Tamafio de la muestra(nl)= 108 Tamafio de la muestra (n2)= 167
Media de la muestra X, = 25.19Media de la muestra X, = 26.20
Desviacion Stand.(S1) = 54.91|Desviacion Stand(S2)= 54.45
Grados de libertad(GL1)= 107|/Grados de libertad(GL2)= 166

b. Estadistica T

PRUEBA "T" DE STUDENT
Desviacion estandar ponderada 54.63
Deswviacion de las diferencias de los promedios 6.75
Calculo del T, calculado (Tc) segun: 0.15
Calculo del valor critico de t, tabular Tt: 1.97
Grados de libertad 273.00
Conclusion:
|tc| = 0.15 < Tt= 1.9687 HOMOGOiNEIDAD

En este caso, siendo las medias estadisticamente iguales, no se debe realizar
proceso de correccion.

2. CONSISTENCIA DE LA DESVIACION ESTANDAR

PRUEBA "F" DE FISHER

Calculo de F calculado (Fc)segun : 1.02
Calculo del F tabular( valor critico de Ft) Ft 1.33
Conclusion:

HOMOGENEIDAD
OK

F, =102 S F,= 133

En este caso, siendo las medias estadisticamente iguales, no se debe realizar el
proceso de correccion
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ANALISIS DE TENDENCIAS:

1. TENDENCIA EN LA MEDIA

t Tmpz Tm*t
Prom 138.5 25.80 3390.89
DESEST 79.82 54.53 8031.34

a) Calculo de los pardmetros de la ecuacion de simple regresion lineal.

i= Nimero de meses 274.00
Tn=  Promedio de las tendencias Tm, o promedio de los datos corregidos de saltos X't 25.80
t= Promediodel tiempot 1385
Stm = Desviacion estandar de latendencia de la media Tm 54.53
St = desviacidn estandar del tiempo t 79.82
t+ T, = Promedio de tendencias y tiempo 3390.89
R = -0.0420
Bm = -0.0287
Am = 29,7755
Ecuacion de regresion lineal: 29.776 +-0.029.t TmM =4, tB,t

b) Evaluacion de la tendencia Tm

Célculo del T, calculado (Tc) segun: 0.69

Calculo del valor critico de t, tabular Tt: 1.97

Grados de libertad 272.00
Conclusion:

HOMOGENEIDAD

|t.| = 0.69 Tt= 1.968 oK

R no es significativo, en este caso, la tendencia no es significativa y no hay que

corregir.
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2. TENDENCIA EN LA DESVIACION ESTANDAR

Afio Periodo (t) Sp t*Sp

2000 1| 28058 28.06

2001 2| 76.349 152.70 Periodo (t) Sp t*Sp
2002 3| 102.864 308.59 Prom 12.00 46.45 524.29
5003 Al 1ee 0.66 DESEST 6.78 29.17 417.94
2004 5| 19.007 95.03

2005 6] 11139 66.83

2006 7| s52.085 364.60

2007 8| 33.408 267.26

2008 9| 71443 642.99

2009 10| 73.046 730.46

2010 11| 55572 611.29

2011 12| 33365 400.38

2012 13| 98948 | 128632

2013 14| 45597 638.36

2014 15| 13.707 205.60

2015 16| 85372 1365.95

2016 17] 71182 1210.09

2017 18| 53217 957.91

2018 19 13237 251.51

2019 20| 53.475 1069.49

2020 21| 25118 527.47

2021 2| 31898 701.75

2022 23[ 5019 115.43

a) Calculo de los parametros de la ecuaciéon de simple regresion lineal.

i= Ndmero de meses 23.00
Ts = Promedio de las tendencias Tm, o promedio de los datos corregidos de saltos X't 46.45
t= Promedio del tiempo t 12.00
Srs = Desviacion estandar de la tendencia de la media Tm 29.17
St = desviacidn estandar del tiempo t 6.78
t* Ty= Promedio de tendencias y tiempo 524.29
R = -0.1671
Bs = -0.7188
As = 55.0721
Ecuacion de regresién lineal: 55.072 +-0.719.t T,=A+B1

b) Evaluacién de la tendencia Tm

Célculo del T, calculado (Tc) segun: 0.78

Calculo del valor critico de t, tabular Tt: 2.08

Grados de libertad 21.00
Conclusioén:

HOMOGENEIDAD

= 0.78 < = 2.0796
.| Tt oK

R no es significativo, en este caso, la tendencia no es significativa y no hay que

corregir

127



F. Analisis estadistico de saltos y tendencias a los registros pluviométricos de

la estacion “Matapalo”.

(05) Diagrama doble masa - Estacién "Matapalo"
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ANALISIS DE SALTOS:

1. CONSISTENCIA DE LA MEDIA

a. Calculo de la media y desviacion estandar para cada periodo, segun la figura

anterior.
DATOS CONFIABLES DATOS DUDOSOS
Periodos Muestrales Periodos Muestrales
ENTRE LOS ANOS 2000 - 2011 ENTRE LOS ANOS 2012 - 2022
Tamafio de la muestra(nl)= 144/Tamafio de la muestra (n2)= 132
Media de la muestra  X; = 54.25|Media de la muestra Xz = 60.14
Desviacion Stand.(S1) = 92.08|[Desviaciéon Stand(S2)= 100.54
Grados de libertad(GL1)= 143[(Grados de libertad(GL2)= 131

b. Estadistica T

PRUEBA "T" DE STUDENT

Desviacién estandar ponderada 96.22
Desviacion de las diferencias de los promedios 11.59
Calculo del T, calculado (Tc) segun: 0.51
Calculo del valor critico de t, tabular Tt: 1.97
Grados de libertad 274.00
Conclusion:
|tc| = 0.51 < Tt= 1.9687 HOMOGENEIDAD OK

En este caso, siendo las medias estadisticamente iguales, no se debe realizar
proceso de correccion.
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2. CONSISTENCIA DE LA DESVIACION ESTANDAR

PRUEBA "F" DE FISHER
Calculo de F calculado (Fc)segun : 1.19
Calculo del F tabular( valor critico de Ft) Ft 1.32

Conclusion:

Fc=119 s F, =132

HOMOGENEIDAD OK

No se debe realizar el proceso de correccion

ANALISIS DE TENDENCIAS:

1. TENDENCIA EN LA MEDIA

t Tmpz Tm*t
Prom 138.5 57.07 7885.24
DESEST 79.82 96.09 15744.08

a) Calculo de los pardmetros de la ecuacion de simple regresion lineal.

NUmero de meses

268.00
Tm = Promedio de las tendencias Tm, o promedio de los datos corregidos de saltos X't 57.07
t= Promedio del tiempo t 138.5
Stm = Desviacion estandar de la tendencia de la media Tm 96.09
St =  desviacion estandar del tiempo t 79.82
t * T,, = Promedio de tendencias y tiempo 7885.24
R = -0.0024
Bm = -0.0029
Am = 57.4632

Ecuacion de regresion lineal: 57.463 +-0.003.t Tmy,, = A, +B,t

b) Evaluacion de la tendencia Tm

Célculo del T, calculado (Tc) segun: 0.04
Calculo del valor critico de t, tabular Tt: 1.97
Grados de libertad 266.00
Conclusion:
|t.| = 0.04 < Tt= 1.9689 HOMO%iNE'DAD

R no es significativo, en este caso, la tendencia no es significativa y no hay que
corregir.
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2. TENDENCIA EN LA DESVIACION ESTANDAR

Afo Periodo (t) Sp t*Sp

2000 1 87.075 87.07 Periodo (t) Sp t*Sp
2001 2 87.587 175.17 Prom 12.00 93.40 1154.19
2002 3 92.882 278.64 DESEST 6.78 40.87 878.14
2003 4 41.567 166.27

2004 5 54.091 270.45

2005 6 41.033 246.20

2006 7 142.351 996.46

2007 8 89.148 713.19

2008 9| 138.433 1245.90

2009 10 94.947 949.47

2010 11 121.575 1337.33

2011 12 61.458 737.50

2012 13 94.610 1229.92

2013 14| 102.914 1440.79
2014 15 51.082 766.24
2015 16| 135.912 2174.59
2016 17| 143.087 2432.49
2017 18| 206.344 3714.19
2018 19| 48.399 919.58
2019 20 111.381 2227.62
2020 21 69.581 1461.20
2021 22 74.890 1647.57
2022 23 57.764 1328.58

a) Calculo de los parametros de la ecuaciéon de simple regresion lineal.

1= Ndmero de meses 23.00
T; = Promedio de las tendencias Tm, o promedio de los datos corregidos de saltos X't 93.40
t=  Promedio del tiempot 12.00
Sts= Desviacion estandar de latendencia de la media Tm 40.87
St = desviacidn estandar del tiempo t 6.78
t«T;= Promedio de tendenciasy tiempo 1154.19
R = 0.1206
Bs = 0.7269
As = 84.6730
Ecuacién de regresion lineal: 84.673 +0.727.t T.=A+B1

b) Evaluacién de la tendencia Tm

Calculo del T, calculado (Tc) segun: 0.56
Calculo del valor critico de t, tabular Tt: 2.08
Grados de libertad 21.00
Conclusion:
|t,| = 0.56 < Tt= 2.079 HOMOGOiNE'DAD

R no es significativo, en este caso, la tendencia no es significativa y no hay que

corregir
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G. Andlisis estadistico de saltos y tendencias a los registros pluviométricos de

la estacion “V1”.

(06) Diagrama doble masa - Estacién "V1"
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ANALISIS DE SALTOS:

1. CONSISTENCIA DE LA MEDIA

a. Calculo de la media y desviacion estandar para cada periodo, segun la figura

anterior.
DATOS CONFIABLES DATOS DUDOSOS
Periodos Muestrales Periodos Muestrales
ENTRE LOS ANOS 2000 - 2009 ENTRE LOS ANOS 2010 - 2016
Tamarfio de la muestra(nl)= 120j[Tamafio de la muestra (n2)= 84
Media de la muestra X; = 75.78[Media de la muestra X = 68.29
Deswviacion Stand.(S1) = 176.45(Desviacion Stand(S2)= 163.77
Grados de libertad(GL1)= 119||Grados de libertad(GL2)= 83

b. Estadistica T

PRUEBA "T" DE STUDENT
Desviacion estandar ponderada 171.35
Desviacion de las diferencias de los promedios 24.38
Calculo del T, calculado (Tc) segun: 0.31
Calculo del valor critico de t, tabular Tt: 1.97
Grados de libertad 202.00
Conclusioén:
|tc| = 0.31 < Tt= 19718 HOMOGENEIDAD OK

En este caso, siendo las medias estadisticamente iguales, no se debe realizar
proceso de correccion.
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2. CONSISTENCIA DE LA DESVIACION ESTANDAR

PRUEBA "F" DE FISHER

Célculo de F calculado (Fc)segun : 1.16
Calculo del F tabular( valor critico de Ft) Ft 141
Conclusion:

Fc= 116 s F,=141 HOMOGENEIDAD OK

No se debe realizar el proceso de correccion

ANALISIS DE TENDENCIAS:

1. TENDENCIA EN LA MEDIA

t Tmpz Tm*t
Prom 102.5 72.69 7055.61
DESEST 59.03 170.97 19448.82

a) Calculo de los pardmetros de la ecuacion de simple regresion lineal.

1= NUmero de meses 204.00
T.= Promediode las tendencias Tm, o promedio de los datos corregidos de saltos X't 72.69
t=  Promedio del tiempot 102.5
Stm = Desviacion estandar de latendencia de la media Tm 170.97
St = desviacion estandar del tiempo t 59.03
t* T, = Promedio de tendencias y tiempo 7055.61
R = -0.0392
Bm = -0.1134
Am = 84.3190
Ecuacion de regresion lineal: 84.319+-0.113.t Tm,, =4, +B,t

b) Evaluacion de la tendencia Tm

Calculo del T, calculado (Tc) segun: 0.56

Calculo del valor critico de t, tabular Tt: 1.97

Grados de libertad 202.00
Conclusion:

HOMOGENEIDAD

= 0. < Tt= 1971
|t.| = 0.56 Tt= 1.9718 oK

R no es significativo, en este caso, la tendencia no es significativa y no hay que

corregir.
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2. TENDENCIA EN LA DESVIACION ESTANDAR

Afio Periodo (t) Sp t*Sp

2000 1| 111198 | 111.20 Periodo (1) | Sp *sp
2001 2| 277747 | 55549 Prom 9.00 146.63 | 1298.29
2002 3| 249501 | 74830 DESEST 5.05 9226 | 1146.17
2003 4] 48307 | 19323

2004 5| 40944 | 204.72

2005 6] 56560 | 33936

2006 7| 184.078 | 128855

2007 8] 92202 | 737.62

2008 9] 270444 | 2433.99

2009 10] 200229 | 2002.29

2010 11] 147.875 | 1626.62

2011 12| 47.8%6 | 574.75

2012 13| 311.951 | 4055.37

2013 14] 99515 | 1393.21

2014 15] 22079 | 33118

2015 16] 171658 | 2746.53

2016 17| 160.490 | 2728.34

2017

2018

2019

2020

2021

2022

a) Calculo de los parametros de la ecuacion de simple regresion lineal.

i= Numero de meses 17.00
Ty = Promedio de las tendencias Tm, o promedio de los datos corregidos de saltos X't 146.63
t= Promedio del tiempo't 9.00
Sts = Desviacion estandar de la tendencia de la media Tm 92.26
St = desviacidn estandar del tiempo t 5.05
t* Ty= Promedio de tendenciasy tiempo 1298.29
R = -0.0458
Bs = -0.8376
As = 154.1668
Ecuacion de regresidn lineal: 154.167 +-0.838.t T,=A+Bt

b) Evaluacién de la tendencia Tm

Célculo del T, calculado (Tc) segun: 0.18

Calculo del valor critico de t, tabular Tt: 2.13

Grados de libertad 15.00
Conclusion:

HOMOGENEIDAD

= 0.18 < = 2.1314
.| Tt oK

R no es significativo, en este caso, la tendencia no es significativa y no hay que

corregir
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H. Analisis estadistico de saltos y tendencias a los registros pluviométricos de

la estacion “V2”,

(08) Diagrama doble masa - Estacién "V2"
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Precipitacion anual acum. (mm)

2000.0

0.0 >

0.0 2000.0 4000.0 6000.0 8000.0 10000.0 12000.0

Pr ion p lio anual acumulada (mm)

~——&— Estacion "V2" = c-eieeee Lineal (Estacion "V2")

N1 N2

ANALISIS DE SALTOS:

1. CONSISTENCIA DE LA MEDIA

a. Calculo de la media y desviacion estandar para cada periodo, segun la figura

anterior.
DATOS CONFIABLES DATOS DUDOSOS
Periodos Muestrales Periodos Muestrales
ENTRE LOS ANOS 2000 - 2009 ENTRE LOS ANOS 2010 - 2016
Tamarfo de la muestra(nl)= 120[Tamafio de la muestra (n2)= 84
Media de la muestra X; = 73.16[Media de la muestra X = 79.55
Deswviacion Stand.(S1) = 148.64||Desviacion Stand(S2)= 149.18
Grados de libertad(GL1)= 119|(/Grados de libertad(GL2)= 83

b. Estadistica T

PRUEBA "T" DE STUDENT
Desviacion estandar ponderada 148.86
Desviacion de las diferencias de los promedios 21.18
Calculo del T, calculado (Tc) segun: 0.30
Calculo del valor critico de t, tabular Tt: 1.97
Grados de libertad 202.00
Conclusion:
|tc| = 0.30 < Tt= 19718 HOMOGENEIDAD OK

En este caso, siendo las medias estadisticamente iguales, no se debe realizar
proceso de correccion.
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2. CONSISTENCIA DE LA DESVIACION ESTANDAR

PRUEBA "F" DE FISHER

Calculo de F calculado (Fc)segun : 1.01
Calculo del F tabular( valor critico de Ft) Ft 1.39
Conclusion:

Fc= 101 s F, =139 HOMOGENEIDAD OK

No se debe realizar el proceso de correccion

ANALISIS DE TENDENCIAS:

1. TENDENCIA EN LA MEDIA

t Tmpz Tm*t
Prom 102.5 75.79 7673.48
DESEST 59.03 148.52 17684.43

a) Calculo de los pardmetros de la ecuacion de simple regresion lineal.

Ndmero de meses 204.00
T.= Promedio de las tendencias Tm, o promedio de los datos corregidos de saltos X't 75.79
= Promediodel tiempot 102.5
S¢m = Desviacion estandar de la tendencia de la media Tm 148.52
St = desviacion estandar del tiempo t 59.03
t* T, = Promedio de tendencias y tiempo 7673.48
R = -0.0108
Bm = -0.0272
Am = 78.5765
Ecuacion de regresion lineal: 78.577 +-0.027.t Tm'p,t =4, +B,t

b) Evaluacion de la tendencia Tm

Calculo del T, calculado (Tc) segun: 0.15
Calculo del valor critico de t, tabular Tt: 1.97
Grados de libertad 202.00
Conclusion:
|t.| = 0.15 < Tt= 19718 HOMO%iNE'DAD

R no es significativo, en este caso, la tendencia no es significativa y no hay que
corregir.
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2. TENDENCIA EN LA DESVIACION ESTANDAR

Periodo (t) Sp t*Sp
Prom 9.00 129.29 1168.56
DESEST 5.05 76.48 998.13

Afo Periodo (t) Sp t*Sp
2000 1 125.042 125.04
2001 2 130.561 261.12
2002 3| 295.592 886.78
2003 4 51.568 206.27
2004 5 52.461 262.30
2005 6 38.940 233.64
2006 7 120.337 842.36
2007 8 73.811 590.49
2008 9 191.690 1725.21
2009 10 198.063 1980.63
2010 11 138.455 1523.01
2011 12 138.244 1658.93
2012 13| 253.396 3294.14
2013 14 57.205 800.88
2014 15 24.919 373.79
2015 16 129.862 2077.79
2016 17 177.833 3023.17
2017

2018

2019

2020

2021

2022

a) Calculo de los parametros de la ecuaciéon de simple regresion lineal.

1= NUmero de meses 17.00
T; = Promedio de las tendencias Tm, o promedio de los datos corregidos de saltos X't 129.29
t= Promedio del tiempo t 9.00
Sts Desviacion estandar de |a tendencia de la media Tm 76.48
St = desviacion estandar del tiempo t 5.05
t« T, = Promedio de tendenciasy tiempo 1168.56
R = 0.0128
Bs = 0.1932
As = 127.5545
Ecuacién de regresion lineal: 127.555 +0.193.t T,=A+Bg
b) Evaluacién de la tendencia Tm
Célculo del T, calculado (Tc) segun: 0.05
Calculo del valor critico de t, tabular Tt: 2.13
Grados de libertad 15.00
Conclusion:
HOMOGENEIDAD
|t.| = 0.05 < Tt= 21314 oK

R no es significativo, en este caso, la tendencia no es significativa y no hay que

corregir
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Anexo 6: Completaciéon y extension de datos

1. Modelo de regresion lineal simple
Yi =a+ bx (43)

Dénde:

yi = Variable hidrolégica dependiente.
xt = Variable hidrolégica independiente
ay b = Parametros de la ecuacion.

b= lexi Yi _zxizyi
lexf—(z xi)2

(44)

a=y,-bx (45)

Doénde:

N: = Tamafio del registro comun a ambas series o tamafios del registro corto.

Y Xlszi

N, N,

Y, =

lexi Yi _zxi Zyi
\/_lexiz _(in )2__leyi2 _(Z Yi )2_

(46)

Ny

3t(y) ZJN;[Z(% _yl)zJ (47)

i=1

1 il —\2
St Jl\ll( b -x) j (48)
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Dénde:

Y, Y X = Son los estimados de las medias de los periodos comunes, de
tamarfio N1 de las variables y:, X:.

Sty) » Sty = Son los estimados no sesgados de las desviaciones estandar,
de yt y xt de los periodos comunes de tamafio N1.

r = Coeficiente de correlacion.

La ecuaciéon de completacién o extension resulta:
—_ v S1(y) ( _*)
Ve = Vit X=X (49)
1(x)
Ddnde:

xt = Serie de registro “largo” de tamafio N = N1 + N>
N; = Tamafio del registro comun.
N2 = Tamafio del registro no comun.

. Criterios de confiabilidad

. Célculo del estadistico Tc, segun
Te= r—5— (50)

. Calculo de Tt
a=0.05yG.L.=N1-2.

Criterios de decision
Si| Tc | = Tt — r no es significativo, por lo tanto, no hay correlacién significativa.

Si| Tc| > Tt — r es significativo, por lo que si existe correlacion significativa entre

las variables y: y xi, y se puede usar la expresion (50).
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3. Datos de salida. Completaciéon y extension con Software HEC — 4

1

PRECIPITACION (MM)

CUENCA: RIO TUMBES (formato para completar datos)

CAMSEDE(101) CRUZ(102) ELTIGRE(103) CABOINGA(184) CAMAVER(185) MATAPA(186) V1(107) v2(108)
UNIFORM RANDOM NUMBER GENERATOR REPEATABLE INITIAL STATE = 5]

IYRA IMNTH IANAL MXRCS NYRG NYMXG NPASS IPCHQ IPCHS NSTA NCOMB NTHDM NCSTY IGMRL NPROJ IYRPJ MTHP] LYRPJ
20080 1 1 23 e 1 1 a a a a @ a @ a @ <] @

MAXIMUM VOLUMES OF RECORDED FLOWS
STA 1 2 3 4 5 6 7 8 ] 1@ 11 12 1-M0 6-MO 54-MO AV MO
18l 14398 2758 33740 9958 5300 790 750 158 13@ 658 370 6a8e 33740 67210 199548 2549
182 12138 27158 48500 9818 5818@ 748 358 17@ 258 820 4789 4308 40508 72580 173188 2176
183 19158 32878 34448 24978 11148 2218 408 240 248 748 518 6558 34448 112010 359958 4839
le4 46568 57200 49568 46920 17560 8580 2090 148 19@ 2650 3750 9878 57088 167280 581760 6860
les 23@9a@ 23236 3155 186068 3758 590 1146 41 368 7ea 4260 5948 315568 69600 226800 2658
lee 27038 49668 46528 289%@ 21156 5868 1226 191@ 1548 1406 1740 911e 49668 183670 4197280 5877
le7 51128 98328 97599 42718 3680 370 350 78 28 508 270 137@ 98320 189820 611878 7269
188 676l1@ 58688 36330 99400 4790 1858 280 78 1lea 191@ 2870 4708 99400 188060 632630 7579

MINIMUM VOLUMES

STA 1 2 3 4 5 6 7 8 9 18 11 12 1-MO 6-MO 54-MO AV MO
1el 16@ 400 19e 3e 5] 2] a %] 2] e e 2] e 78 75168
lez 39@ 68 lee 28 @ <] a @ a e a a e 12@ 64718
le3 11e 850 340 5@ 28 <] a @ a e a a e 14e 118180
le4 54@ 1576@ 1920 2418 a 9 a @ %] a @ [ a 38 197650
185 418 11@ 18 170 @ %] a @ %] a @ e a @ 65880
le6 1418 1880 1490 740 17@ 208 68 38 48 48 18 70 1@ 1200 193000
187 658 1406 618 98a 28 8 a 28 2] 48 e 48 e 158 177350
188 1138 1330 588 3158 88 78 a 38 18 13@ 210 248 e 618 192558
FREQUENCY STATISTICS
sTA ITEM 1 2 3 E s [ 7 8 =l 1@ 11 12
1@1 MEAN 3_482 3.756 3.778 3._.343 2_s@89 1.631 1_2e3 @._973 e._700 1.57@ 1.372 2._4s52
STD DEV 8_4s4a 8.589 8._552 e._s528 a_se1 e.892 1.@813 1.891 1.142 1.828 1_@18 e._718
SKEW -8.567 -©.424 -©.835 -1.169 -@.138 -©.844 -©.228 -©.343 @._863 -©.254 -8.485 -0.471
IMCRMT 44.89 95.90 1@4.32 35.76 11.e1 1.33 ©.87 e.a7 e.37 1.s8@ 1.3 8.13
YEARS 23 23 23 23 23 23 23 23 23 23 23 23
182 MEAN 3.299 3.698 3.711 3.294 2.358 1.187 1.@58 1.117 e.9561 1.498 1.558 2.248
STD DEV ©._485 ©.516 e._683 e.579 @._866 1.867 1._@ez e.893 1.857 ©.921 ©_8598 ©.735
SKEW ©.382 -1.209 -©.866 -1.993 -©.996 ©.@88 -©.266 -©.764 -©.305 -©.343 -9.826 -9.441
INCRMT 3@8.52 78 .07 96 .27 34_e0 o._3e 1.11 8.57 e._az2 e_4a6 1.3@ 1.13 5.18
YEARS 23 23 23 22 22 22 22 23 22 23 23 23
103 MEAN 3.598 3.997 4_ees 3.607 2._789 2. @1 1.616 1.439 1.233 1.870© 1.789 2._698
STD DEV 2.535 e.a40 e.523 e.sl8 e.761 ©.899 ©.853 e.s896 1.e1e e.764 e.861 2.c4@
SKEW -©.984 -8.858 -1.461 -©.784 @.238 -8.745 -1.@839 -1.187 -8.672 -©8.998 -8.897 -9.801
IMNCRMT 64.85 142.37 154.96 77.5@ 22 .39 3.38 1.1@ e.73 e.63 1.84 1.72 1@.7e
YEARS 23 23 23 22 22 22 22 23 23 23 23 23
1e4a MEAN 3.839 4.168 4.320 3.967 3.211 2.374 1.312 -©.293 -©.266 1.436 1.966 2.962
STD DEV 8._47s e_az2s e._377 e._422 a._739 e.871 1.876 1.e84 1.867 1.837 e_9as 8._775
SKEW -©.521 -©.537 -1.513 ©.313 -@.877 -8.275 ©.522 1.568 1.359 ©.324 _-©.328 -©.999
IMCRMT 11e@.16 212.46 265.39 143.99 37.92 1e.e1 2.26 e.14 e.13 2.42 a.a4 23.14
YEARS 23 23 23 22 22 22 22 23 23 22 22 22
185 MEAN 3.354 3._7es 3_.807 3_4s65 2_4as57 1.479 8.947 e.e82 -@.546 8.694 1.576 2_388
STD DEV ©.500 ©.574 ©._586 ©.548 a._780 1.@98 1_@73 1.082 e._8084 1.@85 1._@25 e._81@
SKEW ©.350¢ -©.974 -1.246 -©.386 -@.727 -©.200 ©.747 1.633 3.e00 2.946 ©.284 -©.566
IMCRMT A42._43 88.29 112_@8 52.49 7.82 1.66 1.17 e._34 e._17 e.82 3.28 7.62
YEARS 23 23 23 23 22 23 23 23 23 23 23 23
lae6 MEAM 3.992 4.2 4.183 3.777 3.167 2.618 2.452 2.327 2.294 2.539 2.579 3.242
STD DEV 2.354 @.327 2.399 2.393 2.558 2.535 a2.342 2.318 2.326 a.41a 2.494 2.465
SKEW -@.791 -8.728 -1.162 -a.429 8.574 -8.564 -8.253 2.386 2.453 -8.289 -1.172 -@.809
INCRMT 125.65 197.89 282 .06 83.82 34.35 7.75 3.7e 2._87 2.66 4.98 5.8@ 26.75
YEARS 22 23 23 22 22 22 22 23 23 22 22 22
1a7 MEAM 3.689 4.269 4.356 3.760 2.496 1.483 a.732 1.49a -8.157 2.153 1.392 2.647
STD DEV 2.494 a.5e8a 2.549 @2.498 2.663 2.933 @.984 e.114 1.241 2.362 2.9232 @2.355
SKEW 2.193 -2.428 -1.35@ 2.0e6 a.19a -2.6l1@ -2.146 1.669 e.41@ a.1a9 -8.730 -1.293
INCRMT 89.49 3ec.41 258.51 99 .56 8.36 e.92 .34 e.32 e.1e 1.92 a.83 5.59
YEARS 17 i7 i7 i7 i7 17 17 i7 17 i7 i7 i7
l1as MEAM 3.981 4,163 4.119 4.294 2.848 2.374 1.354 1.673 1.57a 2.686 2.812 3.258
STD DEV 2.454 8.452 a.483 @.A57 a.542 a.383 a.715 e.119 e.276 a8.355 2.311 a.296
SKEW -©.425 -B2.666 -1.594 -@.213 a.122 2.479 -1.655 -8.275 -@.618 @.157 2.233 -1.38@
INCRMT 148_37 216.33 186.26 3e4.33 13.75 3.44 e8.45 .48 e.44 6.54 8.18 2a.91
YEARS 17 i7 i7 i7 i7 17 17 i7 17 i7 i7 i7
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Continuacion...

FREQUENCY STATISTICS AFTER ADJUSTMENTS

sTA ITEM 1 2 3 a s
181 MEAN  3.462 3.756 3.778 3.343 2.589 1
STD DEV  ©.464 ©.589 ©.552 ©.528 ©.881 ©
SKEW -®.567 -©.424 -@.835 -1.189 -8.138 -@
INCRMT 44.89 95.90 184.32 35.76 11.e1 1
182 MEAN  3.299 3.698 3.711 3.261  2.323 1
STD DEV  ©.485 ©.516 ©.603 ©.587 0.856 1
SKEW ©.382 -1.289 -©.866 -1.893 -0.896 @
INCRMT 3B8.52 78.87 96.27 34.880 9.3@ 1
183 MEAN  3.598 3.997 4.9 3.573 2.770 2
STD DEV ~ ©.535 ©.448 ©.523 ©.626 ©0.749 ©
SKEW -©.984 -8.858 -1.461 -8.784 ©.238 -8
INCRMT ©4.85 142.37 154.96 77.58 22.39 3
184 MEAN  3.839 4.168 4.32@ 3.985 3.234 2
STD DEV  ©.475 ©.428 ©.377 ©.421 ©.738 ©
SKEW -©.521 -8.537 -1.513 ©.313 -0.877 -©
INCRMT 118.16 212.46 265.39 143.99 37.92 18
185 MEAN  3.354 3.788 3.887 3.465 2.446 1
STD DEV  ©.508 ©.574 ©.586 ©.548 ©.764 1
SKEW ©.358 -8.974 -1.246 -8.386 -8.727 -8
INCRMT 42.43 88.29 112.88 52.49 7.82 1
186 MEAN  3.990 4.200 4.183 3.788 3.191 2
STD DEV ~ ©.346 ©.327 ©.399 ©.387 ©.557 ©
SKEW -8.791 -8.728 -1.162 -8.429 8.574 -8
INCRMT 125.65 197.89 202.86 83.02 34.35 7
l1a7 MEAN 3.877 4.127 4.323 3.895 2.554 1
STD DEV 8.494 8.663 e.588 8.529 8.6338 a.
SKEW 8.193 -8.428 -1.358 @.8e6 a.19 -a8.
INCRMT 89.49 386.41 358.51 99.56 8.36 a.
les MEAN 4.809 4.142 4.111 4.243 2.896 2.
STD DEV 8.415 8.457 8.5a85 8.586 8.522 a.
SKEW -8.425 -8.e66 -1.594 -8.213 a.122 a.
INCRMT 148.37 216.32 186.26 304.33 13.75 S
RAW CORRELATION COEFFICIENTS FOR MONTH 1
STA 1e1 162 183 1e4 185 186 1687 168
WITH CURRENT MONTH
161 1.eee ©.787 ©.791 ©.777 ©.651 ©.722 ©.879 0.892
182 @.787 1l.eee @.782 ©.711 0.780 ©@.644 08.761 @.734
163 ©.791 ©.7e2 1.e00 ©.876 ©.765 ©.821 ©.9%6 0.909
184 @.777 @.711 @.876 1.6 0.823 0.741 08.947 8.944
185 @.651 @.7e@ ©.765 0©.823 1.e00 ©.589 0.946 @.89%6
166 ©.722 ©8.644 ©.821 ©.741 ©.589 1.000 ©.828 0.801
1e7 ©.879 @.761 @.986 ©.947 ©.946 ©.828 1.000 @.978
168 ©.892 ©.734 ©.989 ©.944 ©.896 ©.801 ©.978 1.000
WITH PRECEDING MONTH AT ABOVE STATION
161 ©.ee8 -8.837 ©.878 ©.093 0.e97 -0.130 -0.227 -0.312
182 -8.151 -8.e35 -8.122 -0.854 -0.836 -0.191 -8.232 -8.357
163 -0.231 ©.e30 -8.917 0©.152 0.829 -0.076 -0.1380 -0.240
164 -8.178 -8.154 -8.151 ©.834 -8.825 -8.174 -8.857 -8.190
1@5 -0.189 -@.14e -8.091 ©.067 ©.134 -0.215 -0.119 -0.360
166 -8.289 -8.193 -8.257 -0.020 -0.216 -8.292 -8.253 -0.308
107 -9.205 -©.328 -0.240 ©.064 ©.098 -0.296 -0.107 -0.268
168 -0.164 -8.339 -0.272 ©.055 ©.094 -0.271 -0.112 -8.220
RAW CORRELATION COEFFICIENTS FOR MONTH 3
STA 1e1 la2 103 le4 185 186 1e7 108
WITH CURRENT MONTH
lel 1.9e0 ©.934 ©.918 ©.886 @.778 0.908 ©.865 0.899
182 ©.934 1.e00 ©.902 ©.874 ©.726 0.889 ©.847 0.880
183 ©.918 ©.%82 1.0e@ ©.941 @.855 0.870 ©.920 0.943
le4 ©.886 ©.874 ©.941 1.000 @.833 0.805 ©.909 0.928
185 @.778 ©.726 ©.855 ©.833 1.000 0.688 ©.936 0.919
le6 ©.908 ©.889 0.870 ©.805 ©.688 1.000 ©.752 0.817
187 ©.865 ©.847 ©.920 ©.989 ©.936 0.752 1.800 0.946
188 ©.899 ©.880 0.943 ©.928 ©.919 0.817 ©.946 1.000
WITH PRECEDING MONTH AT ABOVE STATION
lel @.332 ©.212 8.273 ©.336 ©.302 0.186 ©.272 0.292
162 @.341 @.176 8.273 8.363 8.366 0.215 ©8.232 8.254
183 ©.482 ©.273 0.365 ©.469 @.412 ©.285 ©.348 0.351
le4 ©.424 ©.298 0.374 0.541 8.505 0.247 ©.424 8.39%
185 ©.481 ©.260 ©.344 0.476 8.331 0.177 ©.319 @8.324
le6 ©.186 ©.884 0.165 ©.207 @.185 0.892 ©.853 0.081
187 ©.484 ©.273 0.274 ©.432 8.329 0.145 8.331 e.3e1
188 ©.383 ©.297 0.327 ©.429 @.323 0.150 ©.374 0.353

-631
.892
.844
.33

-187
.867
.8388
11

.eas
-879
. 745
.38

-363
.852
.275
.81

-479
.899
.2088
.66

611
-524
-564
-75

. 488

RAW CORRELATION

RAW CORRELATION
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FPROF 000R

N@ R

STA

181
182
183
184
185
1e6
1a7
108

181
182
183
1e4
185
186
1a7
108

STA

181
102
183
led
185
1086
167
108

161
102
183
le4
185
1086
107
108

7
L2832 a.
.813 1.
.228 -a.
.87 e.
. BB 1
.979 a
. 266 -a
.57 a2
.618 1.
.833 a.
.B39 -1.
.l1e a.
. 299 -8
.B53 1
.522 1.
.26 a
.947 a2
.873 i
. 747 1
A7 a2
.42 2
.338 %}
.253 a2
.7e 2
752 1.
.943 @
146 1
34 e.
343 1
679 @
.655 -8
.45 8

1e1

.oee
.925
881
.862
.839
869
.904
929

D000 OO

.183
178
.183
.271
213
.252
.281
.265

[N R R~

101

200
842
780
647
757
781
786
828

oD mmE

683
612
626
534
500
528
545
.561

[ BRI o R R

973
891
343
a7

-117
.893
764
.4z

439
896
1e7
73

-293
.884
568
.14

-882
.ee2
-633
.34

.327
-318
- 386
.87

496
.11e
.6b69

.676

.275
.48

162

925
eee
878
812
820
873
891
988

[~ RIS R )

133
134
223
353
254
184
195
155

[N R R~

102

.842
200
917
739
882
916
880
.892

[ R R~ > > B

8.523
8.553
8.580
8.467
8.423
8.461
8.384
8.489

[N

er®

®eRE

(NS

QWO

NEON

ie

1.57@
1.e2e

-@.254

1.80

1.498
©.921

-8.343

1.3@

.87e
. 764
-998
.84

412
.a2a
.324
.42

NO R

.694
. @85
. 946
82

[N o]

.547
-483
.289
a8

pRON

137
332
189

POON

.672

.157
.54

OO N

i
NREEN WORRER ~AOOFR

[+

[+

NOEN

1e3 1e4 1e5
WITH CURRENT MONTH
8.881 ©.862 0.839
8.878 ©.812 ©.820
1.000 ©.921 @.856
8.921 1.eee@ 0.889
68.856 ©.889 1.000
8.923 0.818 @.79%
8.937 08.956 0.967
8.968 ©.947 0.966
WITH PRECEDING MONTH
8.336 ©.319 @.552
8.308 ©.259 ©0.444
8.355 @.31@ 0.442
8.497 ©0.446 @.585
68.401 ©.316 @.541
8.358 ©.299 0.388
8.328 08.314 9.399
8.325 0.276 0.368

103 104 1685
WITH CURRENT MONTH
8.788 0.647 0.757
8.917 ©.739 0.882
1.00@ ©.829 0.869
0.829 1.e00 0.845
0.869 ©.845 1.000
8.932 0.694 0.743
0.899 0.895 0.882
8.919 ©.886 0.836
WITH PRECEDING MONTH
8.577 ©.655 @.467
8.653 0.668 0.482
8.649 0.625 0.449
8.521 0.551 @.514
8.545 0.601 0.436
8.547 0.577 0.472
8.517 ©.502 0.491
8.513 ©.505 0.589

COEFFICIENTS FOR MONTH 2

COEFFICIENTS FOR MONTH 4

11 12
.372  2.452
.ele  @.718
.485  -@.471
.e3 8.13
.558  2.248
.898  @.735
.B26 -@.441
.13 5.18
.789  2.698
.861  @.648
.897 -@.se1
.72 1e.7e
.972  2.955
.885  @.758
.328 -@.999
.84 23.14
.576  2.388
.e25  @.81@
.284 -@.566
28 7.62
.552 3.211
.498  @.477
.172  -@.8e9
.88 26.75
.418 2.785
.829 a8.364
738 -1.293
83 5.59
.817 3.274
282 8.314
.233 -1.38@
.18 28.91
186 1e7
8.869 8.904
8.873 ©0.891
©8.923 0.937
©8.818 ©.956
@8.7% @.967
1.08@ @.845
8.845 1.000
B8.887 8.985
AT ABOVE STATIOI
8.156 ©.428
8.178 ©8.354
8.163 @.316
@8.315 @.492
@8.21e ©.400
8.128 8.3087
B8.253 B8.358
8.262 8.344
186 187
8.781 0.786
8.916 ©.880
8.932 9.899
0.694 ©.895
8.743 0.882
1.008 ©.819
8.819 1.0@0
8.893 0.970
AT ABOVE STATION
B.468 ©8.439
8.544 9.348
8.551 8.353
8.481 8.461
8.378 0.317
8.417 98.313
8.354 08.475
8.357 0.460

0O OO OO0

D m o

[ IR R R R R

168

.929
.9e8

968

.947
.966

887

.985

aea

400

333

.327
.480

385

.308

357

.348

108

.828
892
919
386
836
893
.970
.0ee

.391
332
367
478
284
308
.451
.439
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RAW CORRELATION COEFFICIENTS FOR MONTH 5

STA

181
182
183
184
185
186
187
108

161
102
103
184
185
186
187
188

200003

-0.
-8.
a.
-0.
-8.
-8.
a.
a.

.6ee
.761
.625
.588
.399
.743
.638
677

1e1

'
D000 006

253
a17
189
124
289
189
183
161

RAW CORRELATION

STA

101
102
103
184
185
106
187
108

101
102
103
184
185
106
187
108

.318
.328
.199

.527
.393
586

0000000

.89 -
.66
.116
.67
-8.
a.
-0.
-8.

181

0ee

582

8/ -
281
131

258 -@.

RAW CORRELATION

STA

1e1
182
1e3
le4
1@5
1ee
1a7
1e8

1e1
162
1e3
184
1@5
1@e
187
1es

RAW CORR

STA

181
1@2
183
184
1@5
186
187
1e8

le1
1@2
1e3
le4
1@5
106
1e7
108

@

[

@

-8.

.6ee
.589
.122
.175
. 257
@36
. 237

000000

.Bee
.664
.486
.241
. 387

.744
.743

D000 00O

lel

|
DO O ®

472

112 -@.
a4e -o.
@32 -o.
848 @.
275 -@.
149 -@.
153 -@.
ars -e.

ELATION

1e1

533

.@33 o.
@27 a.
.1e1  e.
-0.
-@.
-0.
-0.

113 -@.
le2 -a.
014 -8.
828 -@.
148 a.

200009 ®

00000 @k ®

oo R R R )

200006 ®

141

RAW CORRELATION COEFFICIENTS FOR MONTH &

182 183 1e4 185 106 187 188 sTA  1e1 12 183  1e4 185 186 187 188
WITH CURRENT MONTH WITH CURRENT MONTH
761 ©.625 ©.588 ©8.399 ©.743 ©6.638 0.677 181 1.e08 0.173 ©.431 0.156 0.189 0.278 0.199 0.291
680 ©0.815 ©.579 ©.546 0.890 ©.828 0.884 102 ©.173 1.800 ©.560 0.383 0.868 ©.695 0.484 0.549
.815 1.800 ©.745 ©.498 ©.880 ©.924 0.946 183 ©.431 ©.560 1.860 ©.398 0.339 @.788 0.743 0.779
.579 0.745 1.888 ©.514 08.720 0.724 08.744 184 ©.156 ©.383 ©.398 1.800 ©.313 ©.432 0.538 0.638
546 0.499 ©.514 1.888 0.707 ©.686 B0.719 185 ©.189 ©.868 ©.339 0.313 1.860 ©.266 0.789 0.638
.899 ©0.88@ ©.729 ©.707 1.800 ©.875 ©.989 186 ©6.270 0.695 ©.788 0.432 0.266 1.888 0.567 0.605
828 0.924 ©.724 0.686 ©.875 1.808 0.987 187 ©.199 ©.484 ©.743 0.538 0.789 ©.567 1.880 0.929
884 0.946 ©.744 0.719 ©.909 ©.987 1.000 188 ©.291 0.549 8.779 0.638 0.638 ©.665 0.929 1.800
WITH PRECEDING MONTH AT ABOVE STATION WITH PRECEDING MONTH AT ABOVE STATION
055 -9.133 -0.845 -8.855 -0.281 -0.844 -8.135 101 ©.171 ©.112 ©.282 0.112 0.868 ©.231 08.573 0.535
.125 ©0.877 ©.837 ©.945 -8.860 ©.172 0.862 182 ©.837 ©.221 8.172 0.243 -8.114 ©.188 0.325 0.277
.289 ©.246 ©.182 ©.894 0.182 ©.322 8.255 183 ©.325 ©.167 ©.374 0.487 -0.088 ©.307 0.495 0.469
.054 -0.069 ©.085 -0.104 -0.833 ©.121 0.884 104 ©.137 0.835 ©.846 0.119 -9.873 ©.871 0.173 0.145
.385 -0.311 ©.882 -8.197 -8.351 -0.859 -8.180 105 -0.143 -0.237 -8.879 0.066 ©.218 -0.892 -0.854 -0.060
116 ©.827 ©.113 08.814 ©.837 0.252 8.153 186 ©.243 ©.209 ©.235 0.386 0.858 ©.201 0.359 0.372
380 0.265 ©.192 ©8.102 ©.202 ©.293 0.233 187 ©.282 ©.894 ©.213 ©.328 0.124 0.178 0.162 0.158
338 0.238 ©.182 0.980 ©.175 ©.277 0.203 188 ©.287 ©.129 ©.276 0.358 0.158 ©.227 0.284 0.244
COEFFICIENTS FOR MONTH 7 RAW CORRELATION COEFFICIENTS FOR MONTH 8
182 183 14 185 186 187 188 STA  1e1 182 183  1e4 185 186 187 188
WITH CURRENT MONTH WITH CURRENT MONTH
318 ©.328 ©.199 ©8.582 ©.527 0.393 0.586 101 1.060 ©.326 ©.167 ©.435 ©0.543 ©.150 0.021 @.361
.80 ©0.459 0.885 ©0.378 ©.366 ©.563 0.539 102 ©.326 1.808 ©.192 0.167 0.825 -0.892 -0.025 -0.854
459 1.880 0.280 ©.562 ©.629 ©.354 0.316 103 ©.167 ©.192 1.080 ©.354 ©0.000 ©.299 0.474 @.329
.85 0.280 1.880 ©8.392 B.655 ©.768 ©.581 104 ©.435 0.167 ©.354 1.800 ©0.462 -0.138 0.176 -8.151
378 0.562 ©.392 1.000 ©.418 0.669 0.646 105 ©.543 0.825 ©.080 0.462 1.860 -©.853 0.339 0.357
366 0.629 0.655 ©.418 1.000 ©.660 0.489 106 ©.150 -9.892 ©.290 -0.138 -8.853 1.800 -0.135 ©.885
.563 ©.354 ©.768 ©.669 ©.660 1.800 0.730 167 ©.621 -9.825 ©.474 0.176 ©.339 -9.135 1.808 ©.413
.539 ©.316 ©.581 @.646 ©.489 ©.780 1.080 108 ©.361 -8.854 ©.329 -8.151 ©.357 ©.885 ©.413 1.000
WITH PRECEDING MONTH AT ABOVE STATION WITH PRECEDING MONTH AT ABOVE STATION
807 0.845 -9.069 -8.115 ©.178 -0.253 -0.245 101 -0.144 -9.449 -0.389 -8.357 -0.184 -0.257 -0.590 -@.457
.121 8.135 0.142 -8.228 0.168 ©.884 0.159 102 ©.168 0.141 ©.057 -0.869 -0.089 ©.881 0.108 @.173
.62 ©.235 ©.260 -9.832 ©.286 -0.011 0.034 103 -0.314 -0.105 ©.386 0.870 -0.041 -0.827 0.001 -0.869
.192 ©.586 0.461 ©.197 ©.684 ©.439 0.417 104 -0.076 -9.407 -0.130 ©.093 -0.032 ©.113 0.069 -£.881
.898 0.827 ©.318 ©8.150 ©.150 ©.836 -0.020 105 -0.091 -§.468 -0.382 -0.180 -0.181 -0.218 -0.390 -£.160
855 0.490 ©.319 0.019 ©.452 0.263 0.317 106 -0.357 -9.842 ©.241 -0.886 -0.854 -0.140 -0.243 ©.604
.146 0.488 0.431 -8.837 0.558 ©.342 0.328 107 -8.241 -8.159 -8.229 0.256 -8.157 -0.162 0.102 ©.219
@88 0.139 ©.278 -8.314 @.177 0.028 0.008 108 -8.163 -8.178 -8.832 -8.181 -0.891 -0.238 -0.308 -0.218
COEFFICIENTS FOR MONTH 9 RAW CORRELATION COEFFICIENTS FOR MONTH 10
182 13  1e4 1e5 1@s 187 188 STA  1e1 182  1e3 184 185 186 187  1@8
WITH CURRENT MONTH WITH CURRENT MONTH
589 -8.122 ©.175 ©.257 -0.e36 0.237 ©.472 181 1.808 ©.787 ©.745 0.481 ©.477 ©.669 ©.658 0.704
000 0.226 -8.145 -0.8380 ©.813 ©8.545 ©.392 102 ©.707 1.80@ ©.787 0.374 0.284 ©.707 ©.669 0.715
226 1.080 -9.219 ©.112 ©.587 ©.136 0.858 183 0.745 ©.787 1.880 ©.558 ©.519 0.788 ©.767 0.770
145 -9.219 1.860 ©.879 -0.072 @.199 @©.278 184 ©0.401 ©.374 ©.558 1.000 ©.740 ©.663 ©.837 0.805
.30 ©.112 0.079 1.900 -0.038 ©.354 -@.1e4 105 ©8.477 ©.284 ©.519 ©.749 1.808 ©.554 ©.862 0.822
P13 ©.507 -9.872 -0.838 1.900 ©.462 0.846 1866 ©.669 ©.7867 06.708 ©.663 0.554 1.000 0.813 0.867
.545 B.136 £.199 ©.354 B8.462 1.800 ©.194 167 ©.658 ©.669 0.767 ©.837 ©.802 ©.813 1.000 0©.960
.392 @.958 ©.270 -8.184 ©.846 ©.194 1.808 168 @6.784 ©.715 6.776 ©0.885 ©.822 0.867 0.968 1.000
WITH PRECEDING MONTH AT ABOVE STATION WITH PRECEDING MONTH AT ABOVE STATION
316 -p.435 ©.189 ©.100 -8.216 -0.757 ©.956 101 -8.088 -9.896 -8.944 ©.389 ©.305 -8.220 B.111 -8.349
193 -p.182 -0.835 -8.138 -0.287 -0.203 ©.234 102 -8.211 -@.356 -8.162 ©.477 ©.217 -0.132 0.079 -2.490
995 0.146 -0.331 -0.174 ©.591 -8.185 @.4p0 103 -8.879 -0.201 ©.913 ©.489 ©.120 -0.099 -0.002 -8.372
243 B.456 ©.616 ©.178 8.825 ©.184 -9 157 104 ©.193 ©.894 8.155 ©.248 ©.399 -8.851 ©.289 ©.168
310 -9.244 ©.154 ©.558 0.196 0.311 @.237 185 ©.328 ©.295 ©.091 ©.843 0.354 -0.043 0.207 ©.150
@70 B.085 -8.377 -0.258 ©.723 -B.180 @.p3y 106 -0.188 -0.278 ©.868 ©.235 0.438 -6.104 0.851 -0.393
218 -B.006 ©.289 ©.239 ©.145 B8.057 -@. 153 107 0.833 -0.118 0.876 ©.274 0.213 -0.824 0.077 0.010
111 9.354 ©.475 - 011 -B.298 9.336 .0 133 108 -0.147 -0.176 ©.098 ©.256 ©.225 -8.066 0.088 -8.875
COEFFICIENTS FOR MONTH 11 RAW CORRELATION COEFFICIENTS FOR MONTH 12
162 163 le4 1685 1e6 187 188 STA 181 102 103 1084 1@5 106 107 108
WITH CURRENT MONTH WITH CURRENT MONTH
-664 0.486 ©.241 @.387 ©.533 ©8.744 0.743 101 1.080 ©.599 @.7@4 ©.511 ©.607 ©.739 0.66@0 ©.799
-00e @.542 0.479 @.547 @.449 0.8061 @.81e 102 ©.599 1.000 ©.740 ©.682 ©.489 ©.780 ©.394 0.621
-542 1.8@8 ©.356 ©8.354 8.601 0.359 0.765 193 ©.704 ©.740 1.080 ©.639 B.636 ©.838 0.641 0.765
479 ©8.356 1.80@ ©.469 @.494 B8.563 0.670 104 B8.511 ©.682 0.639 1.900 ©.685 0.644 0.385 0.556
-647 ©0.354 ©.469 1.800 ©.552 0.773 ©.592 105 ©.607 @.489 0.636 ©.685 1.90@ ©.577 ©.792 0.677
-449 ©.001 ©.494 0.552 1.86@ ©.796 ©.836 166 ©.739 @.780 0.838 @.644 0.577 1.800 0.674 0.747
-861 @.559 8.563 @.773 8.796 1.008 ©.906 107 ©.660 @.394 0.641 ©.385 0.792 ©.674 1.800 0.828
810 ©0.765 0.670 ©.592 0.836 0.906 1.000 188 ©.799 @.621 @.765 ©.556 0.677 ©.747 ©.828 1.000
WITH PRECEDING MONTH AT ABOVE STATION WITH PRECEDING MONTH AT ABOVE STATION
838 -0.014 -0.234 -0.242 9.865 -0.202 -6.193 181 ©.849 ©.852 -0.814 ©.282 ©.322 0.342 0.823 -0.115
845 -0.024 -0.426 -0.440 0.068 -0.362 -0.328 102 -8.119 -8.171 -0.254 ©.120 ©.209 6.205 -8.289 -9.367
le@ @.260 -0.161 -0.163 ©.187 ©.847 ©.885 103 9.879 -0.192 -0.037 ©0.219 0.154 ©.236 -0.277 -0.237
b LLIER B2y <0.3E5 QG0 6.8 b 194 9.281 ©.136 -0.154 ©0.057 ©0.247 @.261 ©.153 0.028
098 -0.209 -0.412 -0.246 ©.093 -8.387 -0.332 185 ©9.304 ©.237 ©.809 ©.280 ©.276 ©.266 ©.303 0.200
141 -@.004 -0.243 -0.234 0.897 -0.165 -0.158 186 ©.871 -8.175 -9.338 ©.182 ©.188 ©.348 -8.876 -0.189
2 <00y By B-AT QLS 9.5 0.2 107 -0.170 -0.091 -0.444 ©.322 -9.833 -0.220 -0.872 -0.135
CHEL (LIEKS (LIS BLeEE) WLl 0.1y (LI 108 -9.221 -0.040 -0.450 ©.270 ©.083 -0.157 -0.077 -8.179
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RECORDED AND RECONSTITUTED FLOWS

STA YEAR
18l 26ee
181 28e1
181 2002
181 20e3
181 28e4
181 20e5
181 2006
1el 20e7
181 2068
181 2009
181 2@1e
181 2011
181 2012
181 2813
18l 2814
181 2815
181 2016
1e1 2@17
181 2018
181 2019
181 2820
181 2821
181 2822

STA
182
182
182
182
182
182
182
182
102
102
102
102
102
102
102
182
182
182
182
182
182
182
182

STA
1e3
183
1e3
1e3
1e3
183
183
1e3
1e3
183
183
1e3
1e3
183
183
1e3
1e3
183
183
1e3
1e3
183
183

YEAR
2000
2ee1
2002
2083
2804
20885
20806
2887
2008
20089
2010
2011
2012
2013
2014
20815
2016
2017
2018
20819
2020
2821
2822

YEAR
20808
2001
2002
2003
2804
2005
2086
2ee7
2008
2009
2e18
2011
20812
2013
2014
2015
2ele
2017
2018
2019
2820
2021
2022

1
le3e
3308

168
2298
948
468
3368
7a78
12878
11758
1788
2188
gele
1538
4248
1148
2718
14398
1288
6638
3438
6578
6138

1
1478
2478

470
2538
1328

998
2118
5498

11668
8760
1leee

520
3450
1948
3770

398
1748

12138
1218
1868
1168
3e1e
778

328
6320
788
9690
1690
11@
5358
9460
13820
19150
9478
4578
13590
2830
8550
2570
3300
14450
3410
18868
1380
6720
1330

2
3648
7838

211%@
28080
2360

51@
26728
400

27850

16870

18748
4390

155ee
4398
2978
3gee

24160
9a9%e
3eee
877e

14168
1288
1818

2
3840
3520

15968
2240
5868

868
18688

27158
16860
12318
7276
12798
4840
1716
3748
9598
7748
4558
1@34e
8210
1290
1758

11186
5330
19838
818e
12418
1748
30658
85e
32870
20036
17818
6480
28050
5448
5430
11470
32730
27638
11366
21230
11858
3730
1216

3
6428
19468
29280
1218
31ee
593e
5668
5818
18598
2738
180680
380
951e
18518
198
33068
17448
33748
88e
343e
6328
7618
8598

3
518@
21558
18718
139@
1648
4908
11728
9888
11718
1260
14380
230
7950
11448
680
21528
17578
48580
1ee
2588
6238
6720
3588

13468
3ee7e
3383e
3720
5338
108290
11218
9a9e
18118
8900
21818
348
19838
15890
1210
34448
24778
32680
440
22968
14868
19238
6400

3730
7948
1370
388e
228
298
L
1360
81@
9e1e
3740
5690
1360
440
5568
5248
8548
20
3990
1346E
4898
1178

4
11290
6890
21360
1858
7250
1798
580
4340
58080
580
12186
11486
11236
870
720
180660
12936
24978
58
18880

2445E
4418
1868

2608

2480
620
5108
10940
60
11148
2470
31e
578E
1390
220

6
180
48
8e

70

28
200
148
148

168
798
138
200

20

3e

248
458

6
19@

]

1@
78

60
180

580
220
748

19@
1ee

2E
1@

600
120

258

138
8
290
80
568
148
1870
80
2210
380
680
350
@
5@
1292E
15@
350

142

228
el

138

1@

20
350

90
48
130

3208
228

158
148
78

278
13e

48
13@
17@
400

70

128
459E
1@
9@

8
158

178

20

17@

50

28

1@

20
11@

e
70
60

9
78
78

15@

1lee

248
118
138
158
98
6@
1@

120

120
5@

20

18
8
1@
230

330

48
128

290
478
500
658
290
11@

630
468

1@

16@

158

208

11
a
248
58

158
358

328
248

20
198

128

1@
120
48
168
378
58

11

280
30
40

470
38e
318

200
140

70
150

138

70
40
30

1lee
50

11

400

48
310
400
516
268

118
120

1@
11@
400

60

80
350

210
1@

12
378

578
6ase
180
650
1868
248
8
3ee
200
160
158

378
3ee
638
7@
3428
2320
528
1e7e
EL

12
18e
2208
598

1568

2328
1488
78
31@
558
420

8@
668
9se
358
260

1588
33e
11e8@

3@

6558
3238
1758
55@
16@

TOTAL
21128
36130
61730
13790
13640

9548
38258
14778
53448
34890
48818
13600
41478
19988
14820
45718
52300
67890
12120
23258
256880
208610
21418

TOTAL
22280
32548
43998

9598
13168

8l11e
34018
17378
52200
285860
37276
12550
31990
19930
11420
34438
34630
72898
11958
200180
18482
16008

7718

TOTAL
48018
51138
78598
24918
27228
14858
49478
25228
72948
49548
63478
24318
76528
26040
26060
79858
75738
112830
24520
70228
33886
36970
11820
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STA
le4
104
1084
le4
le4
le4
le4
le4
1084
le4
le4
le4
le4
le4
104
le4
le4
le4
le4
104
104
le4
le4

STA
1e5
1e5
1e5
185
185
185
185
1@5
1e5
1e5
1e5
185
185
185
1@5
1e5
1e5
1e5
185
185
185
1@5
1e5

STA
186
186
1@e6
1@e6
1@e6
186
186
186
1@e6
1@e6
1@e6
1@e6
1686
1686
1686
106
106
106
106
106
106
106
106

YEAR
2000
2001
2082
2083
2084
2085
2086
20087
2088
2089
2010
2011
2012
2013
2014
2015
2016
2017
2018
2019
2020
2021
2022

YEAR
2eee
2801
2882
2883
2004
2085
2806
20887
2ees
2889
2818
2011
2012
2013
2814
20815
20816
2817
2018
2019
2020
2821
2822

YEAR
2000
2ee1
2082
2083
2084
2085
2086
2087
2ee8
2ee9
2018
2011
2012
2013
2014
2015
2016
2017
2018
2019
2020
2021
2022

1

660
25380
548
11230
2840
13480
8750
9460
18558
46568
17118
2418
18498
4450
6310
59480
7130
31260
7160
7950
4980
11858
381

1
418
9128
1278
2848
570
480
2538
5848
9828
23896
4658
790
7120
2220
1498
728
2148
13778
940
2130
5880
948
438

1
1418
813@
6158

le14e
7260
2730
6780
22778
26908
2783e
18768
4108
25378
11588
15818
76480
8580
20040
12028E
13280
1968
14198
15898

le4se
1211e
23380
12168
14858

4728
49660

1880
40978
22948
28758
20248
22428

9718

9998
11968
44298
347980
15308
37320
18128
10820

6310

3
27430
47620
44448
12600
115948
21080
23300
22720
300850
274908
49568

2300
44478
24330

5300
46468
32280
49348

1928
30780
15818
22590
17198

3
49780
25848
31558
1488
3210
3980
4990
11268
99480
18368
14788
1@
29670
15578
748
29048
21748
6580
1878
18920
6830
11028
119@

3
27998
29898
24628

3680
12278
14398
15418
24468
22968
11768
3e3le

219@

9438
35618

1498
46378
28560
46528

315@
16690
18600
23630
14768

4
18366
15428
42788
25208
3400
3748
5728
9348
11518
7118
11828
42128
38290
3660
2738
46920
19898
64154E
2418
8750
2768
13118
52208

4
7970
5870

18600
3548
2110
1250

698
13810
958
38580
7528
1e57@
9410
560
5ee

11948

le6ee

12128

17@
5640
458
351e
11ee

4
9460
6430

15298
2358
8900
2999
1418
5860
7538
29608

28908

11498

18768
2168
2818

18728

15218

17153E

748
8920

18498
6280
3900

5
8390
88e
628

258
1468
798
1628
1928
628
5548
1298
9668
21158
17@
4288E
7160
520
171@
1786
610

6
600
e
1ee
530
400
1250
3@
30
138
e
91@
46850
220
e
2380
8580
1268
3425E
e
460
490
440
16@

6
590
8
8
348
@
320
410
8
330

143

000 008~

68

2898

5@
640
55@

e

30
920

Bl
156E

e
e
340

5@

220

338

390

60
1148

33e

350
260
360
900
15@
248E
200
11@
850
490
1220

[ R v I o B I v I B v e B v I v B e B v I B v I o R I v 4]

[y

148

-~
= )
©

o]
ha
0D 000 0000000000000 00

ha

M

2o
2o

35e
38
368
17@e
208
148
3ee
218
228
348
15e
248
218
278
268
270
1lee
260
1916
148

290
11@

00000000000 0 0 W0

o]
o
o @

ha
200000 000000000000

280
40
328
358
31e
17@e
328
13e
18e
558
218
168
158
8@
268
240
18@
200
1548
11@
19@

60

1@

2658

470

198

420

11
8e
638

350

568
860

146
116
290
280
400

290
leee

36E
3758
48
48
48
30

11

480
320
328

340
358
330
330

4260
20

1@

11
1@
848
258
368
3ee
158
1748
358
738
9ee
33e
558
768
78
3ee
840
270
5E

147@
1468
730
31@
50

2738
1228
74780
5598
860
768
3420
5ee

2778
2148
1538
1418
1458
1958
1458
1968
945E
9118
6268
4760
1118
290

TOTAL
73970
111e86
134446
47238
34720
31158
847480
45816
112546
124248
114946
63270
167808
44230
44836
127676
998480
194237
38640
91890
42106
598180
33390

TOTAL
23e1e
568528
68188
14258
13668

8200
28338
2ee1e
45848
51428
48780
19220
69320
22540

9968
5131e
47338
53848
1187@
46926
18768
16768

4718

TOTAL
69ede
6a77e
geese
36718
46900
27200
8e27e
58290
182890
71328
185e7@
42680
87788
64818
48130
183190
1eee7e
126750
530840
85160
58270
60540
43900



Continuacion...

STA YEAR 1 2 3
187 2000 918 29848 24498
187 20e1 1496 15788 97590
187 2ee2 11ee 42178 73448
187 2083 6730 16460 2886
187 28e4 1998 12658 8518
187 2@es5 650 3ed4e  1987@
187 2ee6 5748 61988 24258
1e7 2087 9840 1408 31740
187 208 22948 87198 45880
1e7 2009 51120 38778 42920
187 2e1e 6180 42828 34318
187 2011 2058 9380 610
187 2012 18888 98328 59618
1e7 2013 4480 5598 35158
187 2014 3480 7268 3898
187 2015 2400 9058 68370
187 2016 6696 3919 44768
187 2017  38472E 56889E 43659E
187 2018 2571E  3411E  4756E
187 2019 4815E 35059E 26476E
187 2020 5211E 11228E 25256E
1e7 2021 4093E  1272E 35244E
187 2022 2299E  1784E 24961E
STA YEAR 1 2 3
188 26600 2448 19938 22858
les 2801 19340 9338 33140
188 26802 1346 32799 33380
les 2803 13718 13670 3260
188 26804 5618 18350 4890
188 2885 1138 2878 13748
188 206 14858 39868  18@le
188 207 19658 1338 1713@
188 208 25900 58688 27998
188 2009 67610 24788 17238
188 201 15238 3831@ 13698
188 20811 6198 9668 568
le8 2812 24200 532680 30680
1e8 20813 8420 6848 18900
les 2814 7830 6730 1920
1e8 20815 5580 9860 36330
188 2016 148088 38398 18808
188 2017  35868E A43348E 40597E
188 2018 7@73E  6922E  1314E
188 2019  15114E 33926FE 15874F
188 2020 8891E 20394E 123@5E
188 2821  1@824E  3972E 18629E
188 2822 7816E  42e1E 17853E
ADJUSTED FREQUENCY STATISTICS
STA ITEM 1 2
1e1 MEAN 3.462 3.756 3.
STD DEV  @.464 ©.589 a.
SKEW -©.567 -8.424 -8
INCRMT 44.89 95.98 184
1@2 MEAN 3.299 3.698 3.
STD DEV  @.485 @.516 a.
SKEW ©.382 -1.209 -@.
INCRMT 38.52 78.087 296.
1e3 MEAN 3.598 3.997 4.
STD DEV  8.535 e._448 e.
SKEW -©.984 -8.858 -1
INCRMT 64.85 142.37 154.
184 MEAN 3.832 4.168 4.
STD DEV  8.475 e.428 e.
SKEW -2.521 -8.537 -1.
INCRMT 118.16 212.46 265
1es5 MEAN 3.354 3.7es8 3.
STD DEV  8.5ee e.s574 e.
SKEW ©2.358 -8.974 -1.
INCRMT 42.43 88.29 112
1e6 MEAN 3.996 4.200 4.
STD DEV  ©.347 8.327 =]
SKEW -e.848 -©.727 -1.
INCRMT 125.65 197.89 282
1e7 MEAN 3.697 4.174 4.
STD DEV a.463 B8.553 a
SKEW a.235 -@.345 -1
INCRMT 89.49 386.41 358.
1aa8 MEAN 4,884 4.147 4.
STD DEV a.41e a.442 a
SKEW -@.447 -2.474 -1.
INCRMT 148.37 216.23 186.

3

3
-494 e.
-4a3 <]
=

-473 5]

4
196668
15798
42789
2248
3278
1118
1176
381e
6548
2680
8660
15088
19688
1926
986@
13178
12188
22667E
788E
7765E
2277E
5298E
3695E

4
387860
341608
99468
6208
16658
4188
5248
12268
30450
8550
396568
48678
75218
8870
3158
33788
53828
72626E
2348E
20487E
16355E
23181E
18131E

3

887 3

-as8 52
183
162 =
.86 8
356

51 9
114 4.

Sel1 -e.
26 3e4.

778 3.
552 a.
-835 -1.
-32 35.

711 3.
ee3 a.
866 -1.
27 34.

ee9 3.
523 a.
461 -@.
26 77

328 4.
377 a.
513 a.
-39 143,

188

328
1e2@
468
618
EL)
2010
2090
4200
4710
168
376
2376
297

E
E
E

484E

1273
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343
528
19
76

287
567
a7l
ae
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685
747
5e
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389
29

-465
586 a.
245 -a.
-49

548
386

3.797
.399 a.
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-az
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-813
-56

281

-449
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E
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-e.
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|
NOON
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[
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.81
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.86
.eaz
.3e
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.743
.238 -
-39
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-TTT
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.554
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.35

.532
.598

-883
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.@25
.75

6
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1@

120

3@8E
117E
66E

93@
120
1ee
458

208
196

316
1lee

138 -
a1

FPORE POOR

We N

.242 2
-737 a.
-933 -a.
.92 ie.

ROR R

|73
36

SO yoown

144

WeaN

60E
28E

4E
67E
36E
48E

631
.892
.844
-33

-154
.@55
-171
-11

-849
-989
77e
.38

- 425

885
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a1

-A79
.89
-2ea
-66

.646
.548
. 686
.75

- 467
-897
- 755
-92

-391
- 344
-343

QOOQ WOON

QRO

NERRL

RORLRO

31E
43E
37E
A6E
49E
58E

.2@3
.e13
.228
-87

-851
.98
.244
-S57

-B66B2
.862
.e4a3
-1e

-351
-868
-418
.28

.947
-873
. 747
W17

.458
.334
.229
.7e

. 690
-863
-e49
.34

-391
- 646
.780
.45

O3

QRrRLEO
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@R ORL NOON

-973
-89l
-343
a7

-117
-893
.764
-4z

-439
-896
-1e7
.73

-293
-88a
-568
-14

-e82
-8az
-633
-34

-327
-318
-385
-87

-583
-120
-286
.32

-661
-11e
-143
.48

338

38e
470
300

123E
74E
88E
118E
198E
189E

18
138
200
98@
240

123@
388
19@
490
8ee
188
598
438
460

191@

1648

le2e
248
A19E
323E
327E
264E
692E
379E

.7ea
-142
-B63
-37

DOLEE

-991
-e4az
-383
.46

QORLRe

-233
-e1e
-672
.63

|
Qe R

-266
-ese7v
-359
-13

QRrRLEO

-546
-804
-44a2
-17

QWeo

.294
-326
453
66

.118
-930
-389
-1a

mmm(‘g NOON

1.571

a.275
-a.237

a.44

Foon POON

160

2E
245E
58E
29E
16E

11
218
2070

330
350
758
1868
53
gee
938
668
988
1348
270
370
1810
288
248E
1563E
923E
637E
763E
398E

1a

1.57@
1.e2e
8.254
1.88

1.498
e.921
@.343
1.3

1.87@
a.764
2.998
1.84

- 449
-81s5
.289
.42

NERRL

.694
. B85
-946
.82

0RO

544
Az
332
a8

-127
-319
-335
-92

-661
-313
-392
.54

OO N

12
1378
568
578
1200
198
598
578
220
48
658
358
740
228
258
558
920
520
69E
997E
1464E
1048E
745E
675E

12
2538
1920
3230
4700

880
2860
1768
1148

248
2268
1698
2788
1e7@

900
3400
2260
2018
1824E
4887E
3784E
2778E
1949E
1617E

11

1.372

1.el1e
-8.485

1.83

1.558

2.898
-8.826

1.13

1.789
8.861
-8.897
1.72
1.958
8.887
-8.276
4.84
1.576
1.825
e.284
3.28

2.512
e.579
1.242
5.88

1.385
a.859
a.618
a.83

-812
-296
-163
.18

WOAIN

TOTAL
79548
145378
168619
29860
27518
25528
94868
46498
163658
136678
92848
28610
189728
49518
18778
902508
183920
154956
14203
75997
45718
47476
33843

TOTAL
91898
101350
172248
42978
41828
25468
8139@
53@3e
146480
122128
187758
69868
188580
47598
29630
95520
128888
197667
26222
21867
62819
61728
49778

12

2.452

e.718
-8.471

8.13

2.248

e.735
-e.441

5.18

2.698

a.e648
-e.8e1
l1e.7e

2.937

8.766
-8.896
23.14

2.388

e.81e
-B8.566

7.62

3.231

@.457
-8.737
26.75

2.686

8.382
-1.253

5.59

3.279

a.28@
-1.2314
28.91



Continuacion...

CONSISTENT CORRELATION MATRIX FOR MONTH 1

STA

lel
1e2
1683
184
185
186
187
1688

181
182
1e3
led
185
1686
187
1688

8
-@
-8
-8
-8
-8
-8

oW

181

.6ee
787
791
77

651

.706
.819
.851

.0es
.151
231
.178
.189
.286
.129
-0.

891

-0.
-0.

a.
-8.
-8.
-8.
-0.
-0.

2000000k

102

787
fee
702
711
700
637

787

758

837
835
e3e
154
148
193
170
171

1683

184

185

WITH CURRENT MONTH
8

g.

a.

.
-0.
-8.
-a.
-0.
-0.
-0.
-0.

CONSISTENT CORRELATION

STA

1e1
182
1683
184
185
166
187
1e8

1e1
182
1683
184
185
186
1e7
188

OO0 000 0 9k

00 000000 d®

le1

oee
934
918
886
778
908
845
911

332
341
402
424
401
186
384
35@

182

8.934
1.000
8.902
0.874
8.
8
8
8

726

.889
.804
.897

8.212
8.176
8.273
0.298
8.
8
e
8

260

.084
257
.260

e
1
8.
8
8
8

791
762
.68
876
. 765
.817
871
898

B78
122
817
151
891
246
878
894

8

777

8.711

- ®

8

8
-0
8
8
0
-0
0

8.

.876
.eee
.823
.748
.936
.942
WITH PRECEDING MONTH
122
.@35
.163
.038
.895
.22
.51

848

[ I R I I

8
-8.836
8
-8.825
8
-6.214
8

0.

.651
.760
765
.823
Bee
.576
.920
.841

.897

.29

134

.e77
865

MATRIX FOR MONTH

183

le4

185

WITH CURRENT MONTH

W

8

.918

8.902

[ R R R~ T~ R R~ T o R~ T R~

.eee
.941
.855
.870
883
.930

273
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.365
374
.344
.165
.245
.302

8.

8.
TH PRECEDING MONTH
8.

(xR v I B R v v I v ]

[ J v B v I v B v ]

886
.874
.941
.0oe
833
.805
875
931

336
363
469
541
476
.207
416
430

8

778

8.726

[ I R R T R

o e S

.855
.833
.00
.688
899
.8e3

.302
.366
.412
.585
331
.185
.319
.383

AT

-0.
-0.
-8.
-8.
-8.
-8.
-0.
-0.
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=

OO0 0O®

CONSISTENT CORRELATION MATRIX FOR MONTH 5
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184
185
1086
187
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101
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184
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1086
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1088

[ |
o e ®®

@ e EE e @
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.6ee

769
612
612
428
752
665

711

.253
.020
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.ege
.267
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.867
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@ e EE @
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.769
.6ee
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.583
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.866
.799
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.835
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288
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161
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.231

1683
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WITH CURRENT MONTH
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@ e ® e ®
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756
473
874

.986
8.
WITH PRECEDING MONTH
-0.
8.
8.
8.ee7
8.294
8.
8
8

948
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893
244

B84

.148
.151

a.

mEE e E®
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.756
.0ee
.356
.748
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866
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8.279

O ®®
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.141
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164
.201

wm e m e ®

a.

-8

8.
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-0.
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8.
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.595
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0ee
588
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@55
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828
e47

e EE e E®
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wE R EDE D

=

(xR R i e v B v B o » B o> B o> ]

PO 0

106 187
.786 0.819 @
637 @.787 @
.817 8.871 @
L7480 8.936 @
576 08.920 @
.ee 8.715 @
.715 1.e688 @
.745 8,971 1
ABOVE STATION
897 -0.013 -0
171 -8.182 -0
862 -0.171 -8
167 -08.879 -8
180 -0.024 -0
291 -8.329 -0
185 -08.852 -0
162 -0.872 -0.
106 187
908 0.845
.889 0.804
870 0.883
.805 8.875
688 0.899
.6ee @.757
757 1.608
.856 @.918
ABOVE STATION
.186 @.385 @
.215 8.348 @
.285 0.417 @
.247 8.514 @
.177 8.3686 @
.092 0.174 @
.152 @.332 @
.195 @.483 @
186 1687
.752 B8.ee5 @
866 0.799 8.
874 0.906 0.
748 08.709 6.
588 @.555 @
@ee 0.878 @
878 1.000 @
908 0.982 1
ABOVE STATION
188 -8.857 -8.
ge4 06.143 6.
184 08.279 6.
824 0.884 6.
419 -8.197 -@.
882 0.149 @.
891 06.204 8.
892 06.216 @.

P OO0 e od®

188

.851
758
.898
.942
.841
745
971
.eea

.146
.295
171
.178
212
.345
.198
155

108

911
.897
930
931
803
.856
918
.0e0

.322
.338
424
. 465
344
.189
.309
.390

168

711

873
948
739

.549
.988
.982
.eee

121
852
231
849
318
874
154
156

CONSISTENT CORRELATION MATRIX FOR MONTH 2

STA

181
182
le3
led
185
186
167
1e8

le1
102
183
184
1e5
1e6
1e7
1e8

DO mE® @

[~ I T R~ R T

le1

.6ee
.925

881
862
839
869

.863
.914

.183
178

183
271
213
252

.206
.267

o OO m® ®

[~ R I~ R R~ R R e

1082

.925

008

.878
.812
.820
873
.848

892

133

134

223
.353
.254
.184
.280
.247

CONSISTENT CORRELATION MATRIX FOR MONTH

STA

1e1
182
1e3
184
105
106
167
108

1e1
102
183
184
185
186
107
168

2000000 ® =

000000 ®

1e1

.6ee
.848
779
.658
757
.789
.8es
.827
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.611
.625
.597
.568
.567
.611
.645

2000000 Rk e

000000 ®

1682

.848
.6ee
.918
. 760
.866
.9e8
.898
.986

.523
.558
577
.550
423
511
.529
.569

CONSISTENT CORRELATION MATRIX FOR MONTH

STA

101
1682
103
104
105
106
187
108

101
102
1683
104
185
106
187
1088

145

00000000

200000 00

101

.0oe
.162
.429
.120
.189
.232
.320
.336

171
. 865
.247
.287
143
.3ee
.80
.153

000000000

D000 0 0k ®

1682

.162
.eee
.486

397
851

.689
.293
448

.99
.242

185
108

.258
.259
.88
.ee9

1683 104 185
WITH CURRENT MONTH
0.881 ©.862 0.839
0.878 0.812 0.820
1.p00 ©.921 0.856
6.921 1.eee ©.889
6.856 ©.889 1.600
6.923 ©.818 0.79%
8.997 ©.943 0.967
8.951 ©.936 ©.911
WITH PRECEDING MONTH
8.336 08.319 8.552
8.308 0.259 0.444
8.355 ©.310 0.442
0.497 0.446 0.585
8.401 ©.316 0.541
8.358 ©.299 0.388
8.378 ©.316 0.522
8.379 ©.311 0.499
163 le4 185
WITH CURRENT MONTH
8.779 ©.658 8.757
8.918 B8.760 ©.366
1.060 ©.848 0.855
6.840 1.000 ©.854
8.855 8.854 1.000
8.913 ©.718 8.760
8.914 8.904 0.897
0.918 ©.874 0.830
WITH PRECEDING MONTH
8.577 B8.855 0.467
0.648 ©.663 0.482
B.644 B8.629 0.449
0.569 8.599 8.463
8.545 B8.601 0.436
8.579 B8.609 0.446
0.620 ©8.635 8.495
B.626 B8.630 ©.496
1683 184 185
WITH CURRENT MONTH
0.429 ©.120 ©.189
6.486 ©.397 0.851
1.008 9.413 @.352
8.413 1.66@ @.220
8.352 ©.220 1.600
B.768 0.475 0.182
B.761 B.553 8.773
0.787 0.634 0.612
WITH PRECEDING MONTH
0.282 ©.886 0.879
8.169 8.259 -@.011
8.359 ©.495 -0.066
8.144 @.165 -8.185
-0.879 0.808 8.159
6.387 ©.421 0.608
8.116 8.217 -0.878
0.221 ©.291 -0.824

A

=3

AT

A

=

00000000

[~ R R R o ]

[ I~ R R R R o

[ B R R R o R~ R )

[~ R R~ T~ R~ T~

(s> v I i e I v I v B« > B o 5 ]

186 187
.B69 ©8.863 @
873 0.848 @.
.923 @.9%987 @
.818 ©.943 @
796 08.967 @.
.6ee ©.889 ©
.809 1.000 @
899 0.968 1.
ABOVE STATION
.151 @.439 @
176 08.363 @.
164 8.391 @.
.387 8.530 @
.189 @.438 @
119 @.379 e.
173 08.421 @
.186 ©.424 @
106 107
.789 ©.868 @
J6@ ©.898 0.
913 @.914 @.
.718 ©.%984 @
.768 ©.897 @
.gee 0.825 @
825 1.000 0.
900 @.965 1.
ABOVE STATION
468 ©.495 @
548 0.440 @
547 ©0.434 @
481 @.5ee @.
.378 ©0.395 @
.468 ©.400 0@
.482 ©.530 @
.584 @.526 @
1086 187
.232 8.320
.689 8.293
.768 B.761
475 8.553
182 8.773
.0ee @.527
.527 1.000
558 8.922
ABOVE STATION
.287 ©.389 @
121 8.281 @
321 8.354
119 ©.114
.134 -8.169 -
.239 09.264
.056 @.043
.158 8.206

=R I~ R~~~

[ R R R

108

914

892

.951
.936

911

.890
.960

000

.387

333
378

.508
.397

376

.390
.398

108

.827

906
918

.874
.830
.90

965
008

.522
5519
.539

586

.450
465
.575
.579

188

.336
.448
787
.634

612

.558
922
.6ee

337
.270
.326

117

.189
.299
.034
.164



Continuacion...

CONSISTENT CORRELATION MATRIX FOR MONTH 7

STA

161
162
103
14
185
106
187
163

101
102
103
104
185
106
167
108

D00 0 00 @k

-8.
-8.
8.
8.
-8.
a.
-8.
-8.

181

.00

298

.378
131
.582

520
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889
868
129
846
870
285
874
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-8.
8.
8.
.
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.ged

8.

.028

-8
-8

-0

102

8.2938
1.6008
8.418
08.066
8.
8
8
8

375

.330
.515
491

842
126
008
174

286

CONSISTENT CORRELATION MATRIX FOR MONTH 9

STA

181
182
183
104
185
186
187
168

181
102
183

185
186
187
188

-8

101

.608
.598
122
175
.257
.836

0.249
8.438

112
.e48

832

.8438

275

.149

155

.857

|
e D Em D@ ®

-0.
-8.
-0.

.
-8.
-8.
-8.
-0.
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.598
.6ee
172
.159
.838
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895
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310
870
122
865

CONSISTENT CORRELATION MATRIX FOR MONTH 11

STA

161
162
163
184
185
186
107
188

161
102
163
164
185
186
187
168

oD EmE @

-8.

-8.
-8.
-8.
-0.

101

.6ee

664
486

247
.387
514

664

.693

.633

027

101

128
102
897
118

.e4e

8
1
8
8
8
8
8
8

102

.664
.6ee
.542
472
.647
.38e
747
.698

.638
.845
.16@
-8.
-8.
-8.
-8.
-8.

142
898
184
166
832

183 le4 165 186 107 108
WITH CURRENT MONTH
8.378 ©.131 0.582 0.528 8.333 8.439
8.418 ©.e66 ©.375 ©.338 8.515 @.491
1.000 ©.337 0.546 0.667 8.292 0.298
8.337 1.000 ©.345 ©.634 8.720 @.578
8.546 ©.345 1.000 ©.419 8.580 0.561
8.667 ©.634 0.419 1.000 8.547 0.449
8.292 ©.720 0.580 0.547 1.000 0.784
8.298 ©.578 ©.561 ©.449 8.784 1.000
WITH PRECEDING MONTH AT ABOVE STATION
8.110 -0.140 -0.115 ©.894 -8.006 -0.090
8.115 0.127 -9.232 0.147 -8.0876 0.045
8.308 ©.263 ©.003 ©.287 8.092 0.119
8.6023 ©.487 0.142 ©.621 8.480 0.46l
8.048 ©.247 09.150 0.893 8.131 8.032
8.538 ©.291 0.831 ©.422 8.333 0.349
0.464 ©.483 -0.873 ©.551 8.293 0.304
8.183 0.265 -0.316 ©.233 8.037 0.027
103 led 105 106 187 108
WITH CURRENT MONTH
-8.122 @.175 8.257 -0.036 @.249 @.488
8.172 -0.159 -0.038 0.014 0.452 0.283
1.00€ -0.219 @.112 @.5e7 @.163 @.247
-8.219 1.000 0.979 -0.672 @.283 0.418
8.112 @.e79 1.000 -0.038 @.232 0.686
8.507 -0.072 -8.038 1.ee0 @.357 @.697
8.163 ©0.283 0.232 0.357 1.008 @.255
8.247 ©.418 0.986 0.007 @.255 1.000
WITH PRECEDING MONTH AT ABOVE STATIOM
-8.435 0.189 0.160 -0.216 -0.263 0.026
-8.218 -0.040 -8.153 -0.235 -0.272 0.207
8.146 -0.331 -8.174 @.591 -0.207 @.285
8.456 ©.616 8.170 ©.025> @.268 -8.306
-8.244 0.154 8.558 0.196 @.335 0.226
8.088 -0.377 -8.258 0.723 -0.232 -8.021
0.087 0.230 0.157 0.142 @.e59 -8.211
-8.112 @.315 -8.060 -0.096 -0.287 -8.191
183 184 185 186 107 188
WITH CURRENT MONTH
0.486 @.247 @.337 0.514 @.eed 0.693
8.542 0.472 0.647 0.380 0.747 0.690
1.000 @.364 @.354 @.e64 0.572 0.768
8.364 1.000 ©.476 0.433 0.689 0.671
8.354 @.476 1.000 0.583 @.782 0.631
8.664 @.483 0.583 1.608 0.784 0.830
8.572 0.609 0.782 0.784 1.e00 0.912
8.768 @.671 ©.631 0.838 0.912 1.000
WITH PRECEDING MONTH AT ABOVE STATION
-9.014 -8.239 -0.242 0.661 -8.195 -0.186
-0.024 -0.421 -0.448 0.€70 -8.319 -0.273
8.268 -8.175 -8.163 8.155 @.855 ©.830
-8.147 -8.361 -0.374 0.€12 -8.319 -8.285
-0.209 -0.416 -0.246 ©.€79 -8.346 -0.253
-0.084 -0.248 -0.136 -8.616 -0.194 -8.172
-8.167 -8.343 -0.287 0.648 -8.302 -0.287
8.014 -8.256 -0.222 0.156 -8.166 -@.163

CONSISTENT CORRELATION MATRIX FOR MONTH 8

STA 101 162 103 le4 185 186 107
WITH CURRENT MONTH
181 1.0e6 @.326 @.167 0.435 @.543 @.156 0.123
182 @.326 1.eee 0.192 @.167 0.€25 -9.092 0.026 -8.
183 @.167 ©.192 1.000 0.354 0.000 ©.299 ©.494
184 @.435 ©.167 0.354 l.60e 0.462 -8.138 €.302 -8
185 9.543 ©.62> 0.000 0.462 1.000 -0.053 0.422
186 0.150 -8.892 0.299 -8.138 -8.853 1.000 -0.977
187 9.123 ©.626 0.494 0.302 @.422 -0.677 1.6008
188 9.245 -8.167 0.140 -0.244 @.298 0.009 @.326
WITH PRECEDING MONTH AT ABOVE STATION
181 -9.144 -0.456 -08.273 -8.332 -0.184 -0.260 -8.563 -8.
182 9.108 ©.140 0.062 -9.029 -9.089 @.€78 0.052
183 -08.314 -0.080 0.149 0.119 -8.041 -9.041 -8.019 -8.
184 -0.076 -8.399 -8.159 0.166 -8.832 0.877 -8.027 -8.
185 -9.091 -0.458 -08.324 -9.198 -0.181 -0.210 -8.330 -8.
186 -8.357 -0.627 0.125 -9.671 -8.854 -98.143 -8.185 -8.
187 -0.178 -08.2706 -0.240 0.182 -0.097 -0.138 0.053
188 -0.016 -0.183 -0.852 -9.144 -9.@36 -0.076 -8.249 -8.
CONSISTENT CORRELATION MATRIX FOR MONTH 18
STA 181 102 103 led 185 186 107
WITH CURRENT MONTH
161 1.eee ©.707 ©.745 0.4087 0.477 0.666 0.567 ©
182 @.767 1.eee ©.787 ©.379 ©.284 ©.707 ©.57@ O
183 ©.745 ©.787 1.ee@ ©.552 ©.519 ©.705 ©.740 @
184 ©.4687 ©.379 0.552 1.000 ©.717 0©.664 0.340 @
185 ©.477 ©.284 @.519 ©.717 1.00@ ©.538 0.831 0.
186 B.e66 ©.787 ©.785 0.664 ©.538 1.000 ©.774 @
187 @.567 ©.57@ ©.740 0.340 0.831 0.774 1l.000 @
188 ©.639 0.048 0.749 0.797 0.764 0.853 0.955 1.
WITH PRECEDING MONTH AT ABOVE STATION
1681 -98.088 -8.129 -0.044 0.380 0.305 -0.220 ©.136 -0
1682 -8.211 -8.378 -8.162 ©.477 0.217 -8.132 0.107 -0
1683 -8.679 -8.215 ©.013 ©.489 ©.120 -0.099 0.037 -0
184 ©.204 9.093 ©.165 ©.251 ©.393 -0.049 0.258 @
185 ©.328 ©.316 ©.091 ©.043 0.354 -0.043 0.118 @
186 -8.163 -8.285 ©.068 ©.236 0.433 -0.183 0.067 -0
187 ©.678 -8.661 ©.116 ©.213 ©.256 -0.092 0.054 ©
188 -8.117 -8.155 ©.163 ©.214 ©.271 -0.094 ©.069 ©
CONSISTENT CORRELATION MATRIX FOR MONTH 12
STA 101 102 103 184 185 186 187
WITH CURRENT MONTH
181 1.0e6 ©.599 ©.704 0.526 0.687 0.744 0.686 0
182 ©.599 1.060 ©.740 0.683 0.489 0.781 0.460 0.
183 ©.784 ©.746 1.000 0.652 0.636 0.828 0.723 0
184 ©.526 0.683 0.652 1.080 0.697 0.652 0.584 @
185 ©.687 0.489 0.636 0.697 1.000 0.587 0.835 @
186 ©.744 ©.781 0.828 0.652 0.587 1.080 0.665 @
187 ©.686 ©.466 ©.723 0.584 0.835 @.665 1.060 0.
108 ©.823 0.679 0.8l6 0.637 0.717 0.789 0.827 1
WITH PRECEDING MONTH AT ABOVE STATION
181 9.049 0.052 -0.014 0.293 ©.322 0.380 0.205 0.
1682 -8.119 -8.171 -8.254 ©.126 ©.289 0.218 0.0910 -0.
183 9.979 -0.192 -0.037 0.237 0.154 0.348 0.088 @
184 ©.291 ©.125 -8.676 0.€72 ©.277 0.388 0.228 @
185 ©.384 ©.237 0.009 0.293 0.276 0.331 0.339 @
186 ©.082 -9.180 -8.262 0.193 0.212 @.369 0.173 @
187 0.020 -0.131 -0.100 ©.270 0.050 0.234 0.104 ©
1688 -0.089 -0.081 -0.207 0.346 0.220 0.222 0.115 @
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Anexo 7: Hidrogramas de los registros de precipitacion post analisis estadistico (saltos y tendencias).

HIDROGRAMA PRECIPITACION ESTACION "CAMPAMENTO SEDE"
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2
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HIDROGRAMA PRECIPITACION ESTACION "EL TIGRE"
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HIDROGRAMA PRECIPITACION ESTACION "CABO INGA"
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HIDROGRAMA PRECIPITACION ESTACION "MATAPALO"

Precipitacion Mensual Acumulada (mm)

(=]
o
©

o © © o

o O O

M N -
wuw) IYNSNINW

VavinwnNdv NOIDVL1idID3dd

o o
o o
n <

(

PERIODO (2000 - 2022)

z

2

HIDROGRAMA PRECIPITACION ESTACION "V1"
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Anexo 8:Diagramas doble masa de los registros de precipitacion post analisis estadistico (saltos y tendencias).

Andlisis doble masa de 8 estaciones ubicadas en lazona de la cuenca del rio Tumbes: Campamento sede, La cruz, El tigre, Cabo Inga, Cafiaveral, Matapalo, V1y V2

Estacion

" Can;g:g:ento Estacion "La Cruz" Estacion "El tigre" | Estacién "Cabo Inga" "C?:F:ZSL?EI" " l\lflsattiga?lg" Estacion "V1" Estacion "Vv2" Pr;fgﬁ:;%ciic?n

Afio =) =) =) =) anual
P. Anual | P. Acum Auel P. Acum P. Anual | P. Acum P. Anual P. Acum Anual P. Acum | P. Anual | P. Acum Anual P. Acum Anual P. Acum | acumulada

(mm) (mm) (mm) (mm) (mm) (mm) (mm) (mm) (mm) (mm) (mm) (mm) (mm) (mm) (mm) (mm) (mm)
2000 | 211.20 211.20 | 222.80 222.80 480.10 | 480.10 739.70 739.70 | 230.10 | 230.10 690.40 | 690.40 | 795.40 | 795.40 | 918.90 | 918.90 536.08
2001 | 361.30 572.50 | 325.40 548.20 511.30 | 991.40 1110.80 | 1850.50 | 505.20 | 735.30 607.70 | 1298.10 | 1453.70 | 2249.10 | 1013.50 | 1932.40 1272.19
2002 | 617.30 | 1189.80 | 439.90 988.10 785.90 | 1777.30 | 1344.40 | 3194.90 | 681.80 | 1417.10 | 800.50 | 2098.60 | 1606.19 | 3855.29 | 1722.40 | 3654.80 2271.99
2003 | 137.90 | 1327.70 | 95.90 1084.00 249.10 | 2026.40 472.30 3667.20 | 14250 | 1559.60 | 367.10 | 2465.70 | 298.60 | 4153.89 | 429.70 | 4084.50 2546.12
2004 | 136.40 | 1464.10 | 131.00 | 1215.00 272.20 | 2298.60 347.20 4014.40 | 136.60 | 1696.20 | 469.00 | 2934.70 | 275.10 | 4428.99 | 410.20 | 4494.70 2818.34
2005 95.40 1559.50 | 81.10 1296.10 148.50 | 2447.10 311.50 4325.90 | 82.00 | 1778.20 | 272.00 | 3206.70 | 255.20 | 4684.19 | 254.60 | 4749.30 3005.87
2006 | 382.50 | 1942.00 | 340.10 | 1636.20 494.70 | 2941.80 | 847.40 5173.30 | 283.30 | 2061.50 | 802.70 | 4009.40 | 940.60 | 5624.79 | 813.90 | 5563.20 3619.02
2007 | 147.70 | 2089.70 | 173.70 | 1809.90 252.20 | 3194.00 458.10 5631.40 | 200.10 | 2261.60 | 582.90 | 4592.30 | 464.90 | 6089.69 | 530.30 | 6093.50 3970.26
2008 | 534.40 | 2624.10 | 522.00 | 2331.90 729.40 | 3923.40 | 1125.40 | 6756.80 | 458.40 | 2720.00 | 1028.90 | 5621.20 | 1636.50 | 7726.19 | 1464.00 | 7557.50 4907.64
2009 | 348.90 | 2973.00 | 285.80 | 2617.70 495.40 | 4418.80 | 1242.40 | 7999.20 | 514.20 | 3234.20 | 713.20 | 6334.40 | 1366.70 | 9092.89 | 1221.20 | 8778.70 5681.11
2010 | 488.10 | 3461.10 | 372.70 | 2990.40 634.70 | 5053.50 | 1149.40 | 9148.60 | 407.80 | 3642.00 | 1050.70 | 7385.10 | 928.40 | 10021.29 | 1077.50 | 9856.20 6444.77
2011 | 130.00 | 3591.10 | 125.50 | 3115.90 243.10 | 5296.60 632.70 9781.30 | 192.20 | 3834.20 | 426.80 | 7811.90 | 286.10 | 10307.39 | 698.60 | 10554.80 6786.65
2012 | 414.70 | 4005.80 | 319.90 | 3435.80 765.20 | 6061.80 | 1678.00 |11459.30 | 693.20 | 4527.40 | 877.00 | 8688.90 | 1897.20 | 12204.59 | 1885.80 | 12440.60 7853.02
2013 | 199.80 | 4205.60 | 199.30 | 3635.10 260.40 | 6322.20 442.30 | 11901.60 | 229.40 | 4756.80 | 640.10 | 9329.00 | 495.10 | 12699.69 | 475.90 | 12916.50 8220.81
2014 | 148.20 | 4353.80 | 114.20 | 3749.30 260.60 | 6582.80 440.30 [ 12341.90 | 99.00 | 4855.80 | 481.30 | 9810.30 | 187.70 | 12887.39 | 296.30 |13212.80 8474.26
2015 | 457.10 | 4810.90 | 344.30 | 4093.60 798.50 | 7381.30 | 1276.70 |13618.60 | 513.10 | 5368.90 | 1031.90 |10842.20| 902.50 | 13789.89 | 959.20 | 14172.00 9259.67
2016 | 523.00 | 5333.90 | 346.30 | 4439.90 757.30 | 8138.60 998.40 | 14617.00 | 473.30 | 5842.20 | 1000.70 |11842.90 | 1039.20 | 14829.09 | 1288.80 | 15460.80 | 10063.05
2017 | 670.90 | 6004.80 | 728.90 | 5168.80 | 1120.30 | 9258.90 | 1942.37 |[16559.37 | 538.40 | 6380.60 | 1267.50 |13110.40 | 1549.56 | 16378.65 | 1976.67 | 17437.47 | 11287.37
2018 | 121.20 | 6126.00 | 119.50 | 5288.30 245.20 | 9504.10 386.40 | 16945.77 | 118.70 | 6499.30 | 530.40 |13640.80 | 142.03 | 16520.68 | 262.22 |17699.69 | 11528.08
2019 | 23250 | 6358.50 | 200.10 | 5488.40 702.20 |10206.30 | 918.90 |17864.67 | 409.26 | 6908.56 | 851.60 |14492.40| 759.97 | 17280.65 | 910.67 |18610.36 | 12151.23
2020 | 256.80 | 6615.30 | 184.82 | 5673.22 338.86 |10545.16 | 421.00 |18285.67 | 187.00 | 7095.56 | 582.70 |15075.10| 457.10 | 17737.75 | 620.19 |19230.55 | 12532.29
2021 | 206.10 | 6821.40 | 160.00 | 5833.22 369.70 |10914.86 | 598.10 |18883.77 | 167.60 | 7263.16 | 605.40 |15680.50 | 474.76 | 18212.51 | 617.28 | 19847.83 | 12932.16
2022 | 21410 | 7035.50 | 77.10 5910.32 118.20 |11033.06 | 333.90 [19217.67 | 47.10 | 7310.26 | 439.00 |16119.50| 338.43 | 18550.94 | 497.70 | 20345.53 | 13190.35
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(01) Diagrama doble masa - Estacion "Campamento Sede"
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(02) Diagrama doble masa - Estacion "La Cruz"
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(03) Diagrama doble masa - Estacion "El Tigre"
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(04) Diagrama doble masa - Estacion "Cabo Inga"
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(05) Diagrama doble masa - Estacion "Canaveral"
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(06) Diagrama doble masa - Estacién "Matapalo”
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(07) Diagrama doble masa - Estacion "V1"
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(08) Diagrama doble masa - Estacion "V2"
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Diagrama doble masa referido al promedio anual acumulado de 8 estaciones:

Campamento sede, La cruz, El tigre, Cabo Inga, Caiaveral, Matapalo, V1y V2.
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Anexo 9: Calculo del Factor R acumulado mensual — anual

Estacion meteoroldgica Campamento Sede: Factor R acumulado mensual - anual, enero de 2000 a diciembre de 2022.

ESTACION: CAMPAMENTO SEDE LATITUD: 3°33'4.14" S DPTO. TUMBES
N° DE REGISTROS: 23 ANOS LONGITUD: 80°25'46.64" W PROV. TUMBES
PERIODO: 2000-2022 ALTITUD: 17 m.s.n.m DIST. TUMBES
ARO ENE. FEB. MAR. | ABR. | MAY. JUN. JUL. AGO. SET. OCT. NOV. DIC. (MJ.rE'rA\n(/:I-:—ao.ErsAﬁo)
2000 0.51 22.58 123.88 | 137.05| 8.23 0.00 0.00 0.00 0.00 0.00 0.00 0.02 292.27
2001 7.52 72.69 | 1541.86 | 38.34 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 1660.42
2002 0.00 891.39 | 2351.73 | 92.29 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.02 3335.43
2003 10.66 19.48 1.57 0.24 0.03 0.00 0.03 0.00 0.00 0.00 0.00 |199.43 231.43
2004 0.75 11.86 26.87 |187.14| 0.17 0.00 0.00 0.00 0.00 0.03 0.00 0.01 226.82
2005 0.15 0.20 321.56 | 10.91 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.42 333.25
2006 7.29 | 3664.22 | 34.83 0.11 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.23 3706.68
2007 282.88 0.05 156.99 | 0.05 0.02 0.00 0.00 0.00 0.00 0.00 0.03 0.01 440.05
2008 247.95 | 2302.09 | 138.14 | 1.93 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 2690.10
2009 357.67 | 1058.55 4.49 1.90 0.04 0.00 0.00 0.00 0.00 0.00 0.01 0.01 1422.66
2010 0.75 876.93 | 787.50 | 113.88| 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 1779.07
2011 10.04 82.02 0.05 55.32 2.28 0.00 0.41 0.00 0.00 0.00 0.00 0.00 150.12
2012 87.44 | 633.60 | 146.34 | 71.21 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 938.60
2013 1.82 43.04 590.66 | 8.94 0.01 0.00 0.00 0.00 0.00 0.05 0.00 0.00 644.53
2014 60.71 20.86 0.01 0.08 | 118.57 0.39 0.00 0.00 0.00 0.10 0.00 0.04 200.76
2015 0.22 8.07 5312.65 | 2.41 8.99 0.00 0.00 0.00 0.00 0.04 0.00 0.00 5332.38
2016 2.39 |1681.58 | 637.24 | 41.21 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.03 2362.46
2017 246.39 | 62.10 | 3175.91 | 16.64 3.55 0.00 0.00 0.00 0.00 0.00 0.00 0.00 3504.59
2018 2.26 29.08 0.73 0.00 40.12 0.00 0.00 0.00 0.00 0.00 0.00 43.08 115.27
2019 118.12 | 273.39 16.36 2.29 0.00 0.00 0.00 0.00 0.00 0.00 0.00 5.06 415.21
2020 14.09 | 991.33 88.14 0.15 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.05 1093.76
2021 137.72 1.02 214.02 | 1.04 1.17 0.01 0.00 0.00 0.00 0.12 0.02 0.59 355.72
2022 105.65 2.72 290.72 | 7.17 0.87 0.04 0.00 0.00 0.00 0.03 0.00 0.00 407.20
PROMEDIO 74.0 554.3 694.0 34.4 8.0 0.0 0.0 0.0 0.0 0.0 0.0 10.8 1375.6
MAXIMO 357.7 | 3664.2 | 5312.7 | 187.1 | 118.6 0.4 0.4 0.0 0.0 0.1 0.0 199.4 5332.4
MINIMO 0.0 0.1 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 115.3
DESVIACION | 108.71 | 920.73 | 1294.04 | 52.21 | 25.55 0.08 0.09 0.00 0.00 0.03 0.01 42.08 1451.51

Fuente: PEBPT
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Estacion meteoroldgica La Cruz: Factor R acumulado mensual - anual, enero de 2000 a diciembre de 2022.

ESTACION: LA CRUZ LATITUD: 3°37'41.85" S DPTO. TUMBES
N° DE REGISTROS: 23 ANOS LONGITUD: 80°34'9.36" W PROV. TUMBES
PERIODO: 2000-2022 ALTITUD: 6 msnm DIST. LA CRUZ
FACTOR R
ARO ENE. FEB. MAR. ABR. | MAY. JUN. JUL. AGO. SET. OCT. NOV. DIC. (MJ.mm/Ha.Afio)
2000 1.37 24.46 60.05 69.56 | 84.74 0.00 0.00 0.00 0.00 0.00 0.00 0.00 240.19
2001 3.69 10.68 2449.82 | 12.70 0.03 0.00 0.00 0.00 0.00 0.00 0.01 0.00 2476.94
2002 0.02 633.12 | 1020.02 | 77.96 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.03 1731.15
2003 24.78 17.20 4.11 3.93 0.00 0.00 0.02 0.00 0.00 0.00 0.00 5.81 55.84
2004 2.20 124.15 4.23 55.98 0.90 0.00 0.00 0.00 0.00 0.00 0.00 0.00 187.47
2005 1.91 1.25 231.46 0.02 0.00 0.00 0.00 0.00 0.00 0.02 0.20 0.07 234.94
2006 2.15 | 1493.28 | 368.80 0.01 0.00 0.00 0.00 0.00 0.00 0.00 0.01 0.06 1864.31
2007 103.86 0.00 605.33 0.46 0.01 0.00 0.00 0.00 0.00 0.00 0.02 0.00 709.68
2008 188.06 | 2411.14 | 193.46 0.30 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 2792.96
2009 199.91 | 1425.28 0.59 0.16 0.01 0.00 0.00 0.00 0.00 0.00 0.00 0.00 1625.95
2010 0.20 372.52 593.82 | 146.07 | 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 1112.62
2011 0.14 392.70 0.01 53.46 0.00 0.00 0.04 0.01 0.00 0.00 0.00 0.00 446.37
2012 10.68 | 525.42 126.18 | 46.26 0.39 0.05 0.00 0.00 0.00 0.00 0.00 0.00 708.99
2013 3.73 33.67 764.60 1.28 0.01 0.01 0.00 0.00 0.00 0.00 0.00 0.03 803.34
2014 63.09 5.89 0.37 0.10 29.92 0.48 0.00 0.00 0.00 0.21 0.00 0.09 100.14
2015 0.01 11.77 2241.51 | 38.66 2.14 0.00 0.00 0.00 0.00 0.12 0.00 0.00 2294.22
2016 1.17 196.65 | 1209.36 | 32.08 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 1439.27
2017 130.32 | 33.86 4850.46 | 45.48 3.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 5063.11
2018 1.95 103.61 0.00 0.00 4.94 0.00 0.00 0.00 0.00 0.00 0.00 87.45 197.95
2019 3.27 561.19 8.72 32.25 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.36 605.78
2020 0.89 316.46 138.28 1.39 0.00 0.00 0.00 0.00 0.00 0.00 0.00 1.64 458.67
2021 19.36 1.52 215.45 | 48.57 0.19 0.00 0.00 0.00 0.00 0.00 0.00 0.00 285.10
2022 0.97 11.38 97.38 3.40 0.00 0.00 0.00 0.00 0.00 0.02 0.00 0.00 113.15
PROMEDIO 33.2 378.6 660.2 29.1 5.5 0.0 0.0 0.0 0.0 0.0 0.0 4.2 1110.8
MAXIMO 199.9 | 24111 4850.5 | 146.1 84.7 0.5 0.0 0.0 0.0 0.2 0.2 87.5 5063.1
MINIMO 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 55.8
DESVIACION | 61.38 | 611.70 | 1141.31 | 36.33 | 18.37 0.10 0.01 0.00 0.00 0.05 0.04 18.20 1198.56

Fuente: SENAMHI
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Estacion meteoroldgica El Tigre: Factor R acumulado mensual - anual, enero de 2000 a diciembre de 2022.

ESTACION: EL TIGRE LATITUD: 3°48'8.4" S DPTO. TUMBES
N° DE REGISTROS: 23 AROS LONGITUD: 80°27'24" W PROV. TUMBES
PERIODO: 2000-2022 ALTITUD: 45 msnm DIST.  SAN JACINTO
FACTOR R
ARG ENE. | FEB. | MAR. | ABR. | MAY. | JUN. | JUL. | AGO. | SET. | OCT. | NOV. | DIC. | ;i ioanos
2000 0.00 | 190.87 | 328.65 | 196.56 | 142.41 | 0.03 0.00 0.00 0.00 | 0.00 0.00 | 0.13 858.67
2001 31.37 | 18.82 |3379.14| 4065 | 0.21 0.00 0.00 0.00 0.00 | 0.00 0.01 | 0.07 3470.26
2002 0.03 | 508.55 | 2525.08 | 635.58 | 0.00 0.00 0.00 0.00 0.00 | 0.00 0.00 | 0.81 3670.06
2003 332.53 | 200.04 | 18.81 | 0.42 0.00 0.01 0.01 0.00 0.00 | 0.00 0.00 | 1.18 553.01
2004 0.41 | 611.51 | 48.45 | 121.93 | 0.06 0.00 0.00 0.00 0.00 | 0.00 0.00 | 0.00 782.36
2005 0.00 | 418 | 865.12 | 4.55 0.00 0.00 0.00 0.00 0.00 | 0.01 0.02 | 0.02 873.91
2006 20.00 | 3760.09 | 183.96 | 0.02 0.00 0.00 0.00 0.00 0.00 | 0.00 001 | 0.02 3964.09
2007 303.72 | 022 | 269.46 | 29.33 | 0.00 0.00 0.00 0.00 0.00 | 0.00 0.05 | 0.03 602.81
2008 192.53 | 2590.42 | 433.24 | 14.23 | 0.15 0.00 0.00 0.00 0.00 | 0.00 0.00 | 0.00 3230.57
2009 915.15 | 1047.20 | 91.87 | 0.03 0.00 0.00 0.00 0.00 0.00 | 0.00 0.00 | 0.00 2054.24
2010 76.32 | 507.64 | 932.25 | 162.37 | 0.01 0.01 0.00 0.00 0.00 | 0.00 0.00 | 0.03 1678.63
2011 36.18 | 99.38 | 0.01 | 573.55 | 0.00 0.00 0.00 0.00 0.00 | 0.00 0.00 | 0.36 709.48
2012 170.38 | 1498.15 | 467.81 | 96.14 | 1.04 0.08 0.00 0.00 0.00 | 0.00 0.01 | 0.00 2233.61
2013 7.75 | 55.05 |1174.97| 0.23 0.08 0.00 0.00 0.00 0.00 | 0.07 0.00 | 0.01 1238.15
2014 213.48 | 56.21 | 0.61 0.13 | 4531 | 3.69 0.00 0.00 0.00 | 0.08 0.00 | 1.35 320.84
2015 1.08 | 96.09 |2601.34| 375.11 | 83.38 | 0.00 0.00 0.00 0.00 | 0.03 0.00 | 0.00 3157.04
2016 2.48 | 2417.44|1047.84| 149.04 | 0.00 0.02 0.00 0.00 0.00 | 0.00 0.00 | 0.09 3616.92
2017 116.58 | 808.28 | 1337.41| 596.59 | 52.98 | 0.00 0.00 0.00 0.00 | 0.00 0.00 | 0.00 2911.83
2018 14.84 | 548.62 | 0.03 0.00 5.64 0.00 0.00 0.00 0.00 | 0.00 0.00 |105.16 674.30
2019 98.90 | 738.89 | 934.64 | 99.45 | 0.00 0.00 0.00 0.00 0.00 | 0.00 0.00 | 2.60 1874.49
2020 0.61 | 383.30 | 640.24 | 3.37 0.04 0.50 0.02 0.00 0.00 | 0.00 0.00 | 1.23 1029.32
2021 61.34 | 10.49 |1437.42| 17.34 | 0.54 0.00 0.00 0.00 0.00 | 0.02 0.00 | 0.03 1527.19
2022 2.63 | 1.98 | 293.11 | 7.20 0.01 0.05 0.00 0.00 0.00 | 0.00 0.00 | 0.00 304.99
PROMEDIO | 113.0 | 702.3 | 826.6 | 1358 | 14.4 0.2 0.0 0.0 0.0 0.0 0.0 4.9 1797.3
MAXIMO 915.2 | 3760.1 | 3379.1 | 635.6 | 142.4 3.7 0.0 0.0 0.0 0.1 0.1 | 105.2 3964.1
MINIMO 0.0 0.2 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 305.0
DESVIACION | 201.63 | 984.62 | 924.40 | 205.56 | 35.25 | 0.77 0.01 0.00 0.00 | 0.02 0.01 | 21.86 1230.29

Fuente: PEBPT
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Estacion meteoroldgica Cabo Inga: Factor R acumulado mensual - anual, enero de 2000 a diciembre de 2022.

ESTACION: CABO INGA LATITUD: 3°58'33.39" S DPTO. |TUMBES
N° DE REGISTROS: 23 ANOS LONGITUD: 80°24'6.54" W PROV. |TUMBES
PERIODO: 2000-2022 ALTITUD: 231 m.s.n.m DIST. SAN JACINTO
FACTOR R
ARIO ENE. FEB. MAR. ABR. MAY. JUN. JUL. AGO. SET. OCT. NOV. DIC. (MJ.mm/Ha.Afio)
2000 0.02 402.13 | 1474.05 | 442.03 | 42.18 0.02 0.00 0.00 0.00 0.00 0.00 0.02 2360.45
2001 634.51 | 344.25 | 4034.72 | 142.30 0.03 0.00 0.00 0.00 0.00 0.00 0.01 0.04 5155.87
2002 0.00 | 1358.85 | 2558.28 | 2282.18 | 0.01 0.00 0.00 0.00 0.00 0.54 0.00 11.43 6211.30
2003 198.26 | 870.64 | 280.03 2.24 0.01 0.02 0.00 0.00 0.00 0.00 0.01 0.24 1351.44
2004 5.09 770.77 | 378.06 8.73 0.03 0.01 0.00 0.00 0.00 0.02 0.00 0.00 1162.72
2005 0.63 1.01 | 2448.18 | 13.67 0.00 0.51 0.00 0.00 0.00 0.00 0.05 1.09 2465.14
2006 39.02 | 3866.61 | 736.81 | 10.90 1.01 0.00 0.00 0.00 0.00 0.00 0.04 1.48 4655.87
2007 124.07 566 |1718.72 | 119.40 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.09 1967.93
2008 242.94 | 3613.47 | 1032.74 | 58.03 2.94 0.00 0.35 0.00 0.00 0.00 0.00 0.00 4950.48
2009 3311.82]1594.22 | 681.63 | 11.79 0.23 0.00 0.00 0.00 0.00 0.00 0.00 3.13 5602.83
2010 184.70 | 1218.49 | 4488.56 | 49.35 1.68 0.03 0.00 0.00 0.00 0.00 0.00 0.00 5942.80
2011 1.26 14.86 1.10 |6746.64| 6.55 6.00 0.02 0.00 0.00 0.01 0.00 0.22 6776.67
2012 132.14 | 3871.29 | 1838.37 | 1173.51 | 9.47 0.00 0.00 0.00 0.00 0.00 0.00 0.00 7024.80
2013 13.61 46.88 | 2224.69 | 7.57 13.25 0.00 0.00 0.00 0.00 0.01 0.00 0.00 2306.02
2014 39.07 72.39 23.15 3.16 842.11 2.10 0.00 0.00 0.00 0.05 0.00 0.15 982.19
2015 6.60 35.33 | 3158.81 | 3253.57 | 11.90 19.90 0.02 0.00 0.00 0.00 0.03 0.00 6486.17
2016 16.51 | 2536.95 | 1532.02 | 358.40 0.00 0.09 0.00 0.00 0.00 0.00 0.00 0.03 4444.00
2017 512.73 | 844.71 | 2016.13 | 4431.93 | 9.74 0.67 0.00 0.00 0.00 0.00 0.00 0.00 7815.91
2018 69.44 | 110.13 1.34 2.65 99.42 0.00 0.00 0.00 0.00 0.00 9.98 64.33 357.29
2019 25.92 | 1578.76 | 1504.26 | 34.56 0.99 0.01 0.00 0.00 0.00 0.00 0.00 49.60 3194.10
2020 20.54 | 163.86 | 657.34 3.50 6.09 0.02 0.01 0.00 0.00 0.00 0.00 14.17 865.52
2021 132.54 | 27.35 |1132.42| 221.34 | 11.14 0.01 0.00 0.00 0.00 0.00 0.00 0.11 1524.91
2022 13.02 3.42 |1196.25| 33.50 0.00 0.00 0.00 0.00 0.00 0.00 0.00 15.53 1261.73
PROMEDIO 248.9 | 1015.3 | 1526.9 | 844.0 46.0 1.3 0.0 0.0 0.0 0.0 0.4 7.0 3689.8
MAXIMO 3311.8 | 3871.3 | 4488.6 | 6746.6 | 842.1 19.9 0.4 0.0 0.0 0.5 10.0 64.3 7815.9
MINIMO 0.0 1.0 1.1 2.2 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 357.3
DESVIACION | 687.60 | 1287.72 | 1222.79 | 1736.83 | 174.88 4.26 0.07 0.00 0.00 0.11 2.08 16.58 2365.20

Fuente: SENAMHI
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Estacion meteoroldgica Canaveral: Factor R acumulado mensual - anual, enero de 2000 a diciembre de 2022.

ESTACION: CANAVERAL LATITUD: 3°56'20.75" DPTO. TUMBES
N° DE REGISTROS: 23 ANOS LONGITUD: 80°39'2.1" W PROV. C.M.V.Z
PERIODO: 2000 - 2022 ALTITUD: 133 m.s.n.m DIST. CASITAS
FACTOR R
ARO ENE. FEB. MAR. ABR. MAY. | JUN. JUL. AGO. SET. OCT. NOV. DIC. (MJ.mm/Ha.Afio)
2000 0.03 89.37 50.54 208.41 5.14 0.08 0.00 0.00 0.00 0.00 0.00 0.17 353.73
2001 95.99 70.80 2183.24 25.59 0.01 0.00 0.00 0.00 0.00 0.00 0.01 0.02 2375.66
2002 0.17 241.00 | 2534.73 | 519.37 0.01 0.00 0.00 0.01 0.00 0.00 0.00 0.01 3295.30
2003 7.17 83.84 2.32 37.47 0.04 0.03 0.03 0.00 0.00 0.00 0.03 1.77 132.70
2004 0.17 222.91 29.77 8.45 0.09 0.00 0.03 0.00 0.00 0.31 0.00 0.00 261.72
2005 0.21 2.11 122.00 3.78 0.06 0.06 0.00 0.00 0.00 0.00 0.08 0.21 128.52
2006 4.88 1828.62 37.44 0.10 0.01 0.02 0.01 0.00 0.00 0.00 0.01 0.03 1871.13
2007 64.99 0.10 724.71 3.01 0.02 0.00 0.00 0.02 0.00 0.00 0.02 0.02 792.88
2008 138.64 | 1835.27 | 143.78 0.13 0.01 0.01 0.01 0.00 0.00 0.02 0.01 0.00 2117.86
2009 1517.03| 229.32 137.03 7.03 0.00 0.01 0.00 0.00 0.00 0.00 0.03 0.02 1890.46
2010 1754 | 427.38 563.34 74.20 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 1082.47
2011 0.27 133.56 0.00 636.82 0.00 0.00 0.80 0.00 0.00 0.00 0.00 0.03 771.47
2012 28.42 765.09 | 2056.29 65.60 0.36 0.00 0.00 0.00 0.00 0.00 0.00 0.00 2915.76
2013 4.52 16.98 1684.40 0.07 0.10 0.00 0.00 0.00 0.00 0.00 0.00 0.00 1706.08
2014 4.83 124.26 0.59 0.18 23.90 | 0.00 0.00 0.00 0.00 0.01 0.00 0.00 153.77
2015 0.05 10.89 3027.65 | 210.44 6.52 0.00 0.00 0.00 0.00 0.00 0.00 0.11 3255.67
2016 1.37 268.00 | 1433.82 | 166.20 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 1869.38
2017 300.31 | 1130.37 31.59 204.77 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 1667.03
2018 0.92 0.25 7.27 0.01 8.24 0.00 0.00 0.00 0.00 0.00 85.90 9.85 112.44
2019 1.68 672.90 225.99 31.14 0.00 0.01 0.00 0.00 0.00 0.00 0.00 36.37 968.09
2020 114.23 31.57 179.03 0.05 0.00 0.00 0.00 0.00 0.00 0.00 0.00 2.13 327.01
2021 0.55 0.00 886.24 28.64 0.31 0.01 0.00 0.00 0.00 0.00 0.00 0.00 915.76
2022 0.35 1.01 7.49 5.92 0.01 0.00 0.00 0.00 0.00 0.00 0.00 7.49 22.27
PROMEDIO 100.2 355.9 698.7 97.3 2.0 0.0 0.0 0.0 0.0 0.0 3.7 2.5 1260.3
MAXIMO 1517.0 | 1835.3 3027.7 636.8 23.9 0.1 0.8 0.0 0.0 0.3 85.9 36.4 3295.3
MINIMO 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 22.3
DESVIACION | 316.78 | 547.07 954.03 169.05 5.31 0.02 0.17 0.00 0.00 0.06 17.91 7.79 1052.23

Fuente: SENAMHI
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Estacion meteoroldgica Matapalo: Factor R acumulado mensual - anual, enero de 2000 a diciembre de 2022.

ESTACION: MATAPALO LATITUD: 3°40'57.94" S DPTO. TUMBES
N° DE REGISTROS: 23 ANOS LONGITUD: 80°11'54.64" W PROV. ZARUMILLA
PERIODO: 2000-2022 ALTITUD: 62 m.s.n.m DIST. MATAPALO
FACTOR R
ARO ENE. FEB. MAR. ABR. MAY. JUN. JUL. AGO. SET. OCT. NOV. DIC. (MJ.mm/Ha.Afio)
2000 0.22 90.39 | 1736.91 | 67.06 292.68 | 0.02 0.00 0.00 0.00 0.00 0.00 1.61 2188.90
2001 51.54 | 170.34 | 2561.32 | 25.50 0.22 0.00 0.00 0.00 0.00 0.00 0.06 0.17 2809.15
2002 14.76 | 810.79 | 946.76 | 226.78 0.02 0.00 0.00 0.00 0.00 0.17 0.00 26.44 2025.74
2003 212.99 | 367.32 10.18 2.65 0.08 0.02 0.03 0.00 0.01 0.00 0.01 35.68 628.98
2004 54.13 | 463.28 | 261.33 99.73 0.10 0.01 0.00 0.00 0.00 0.01 0.00 0.09 878.69
2005 6.52 33.68 954.44 8.56 0.00 0.02 0.00 0.00 0.00 0.05 0.00 0.14 1003.41
2006 19.00 | 7737.66 | 231.21 0.18 0.00 0.02 0.00 0.00 0.00 0.00 0.33 2.53 7990.93
2007 1205.36| 0.68 1494.16 | 20.55 0.32 0.00 0.00 0.00 0.00 0.00 0.00 0.01 2721.09
2008 847.45 | 2994.04 | 526.96 18.59 0.02 0.17 0.00 0.00 0.00 0.01 0.02 0.00 4387.26
2009 1489.84| 910.72 | 122.69 1.96 0.32 0.00 0.00 0.00 0.01 0.00 0.05 1.60 2527.21
2010 278.55 | 376.93 | 1174.79 | 1018.34 0.30 0.02 0.00 0.00 0.00 0.00 0.00 0.41 2849.35
2011 11.23 | 1351.18 1.71 247.20 0.04 0.06 0.02 0.00 0.00 0.01 0.03 0.58 1612.07
2012 903.40 | 623.49 46.39 361.78 9.41 0.93 0.00 0.00 0.00 0.03 0.02 0.16 1945.61
2013 137.78 | 81.23 | 4006.49 0.82 0.19 0.00 0.00 0.00 0.00 0.18 0.00 0.27 4226.96
2014 537.76 | 135.67 0.45 111 122.67 | 17.63 0.01 0.00 0.00 0.13 0.00 1.01 816.44
2015 19.33 74.16 | 4321.90 | 583.40 410.10 | 0.00 0.03 0.00 0.00 0.07 0.03 0.14 4879.16
2016 28.67 | 3943.49 | 1057.40 | 159.72 0.00 0.01 0.00 0.00 0.00 0.00 0.00 0.34 5189.62
2017 256.27 | 1340.79 | 3205.65 | 160.70 2.51 0.21 0.00 0.00 0.00 0.00 0.00 0.03 4966.16
2018 204.28 | 421.30 3.68 0.05 43.18 0.00 0.00 0.82 0.43 0.01 0.37 88.93 763.05
2019 135.41 | 3005.32 | 268.80 41.04 0.01 0.00 0.00 0.00 0.00 0.00 0.18 14.18 3464.95
2020 0.77 607.75 | 657.34 | 117.92 0.51 0.03 0.06 0.00 0.00 0.00 0.04 11.02 1395.44
2021 275.62 | 122.19 | 1272.76 | 23.89 0.54 0.02 0.01 0.00 0.00 0.09 0.00 0.13 1695.26
2022 626.75 | 39.25 502.32 9.27 0.04 0.02 0.28 0.00 0.00 0.00 0.00 0.00 1177.93
PROMEDIO 318.2 | 1117.5 | 1102.9 116.0 38.4 0.8 0.0 0.0 0.0 0.0 0.1 8.1 2701.9
MAXIMO 1489.8 | 7737.7 | 4321.9 | 1018.3 410.1 17.6 0.3 0.8 0.4 0.2 0.4 88.9 7990.9
MINIMO 0.2 0.7 0.5 0.1 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 629.0
DESVIACION | 421.68 | 1800.52 | 1278.15 | 219.26 | 103.78 | 3.67 0.06 0.17 0.09 0.06 0.10 19.91 1848.65

Fuente: SENAMHI
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Estacion Virtual V1: Factor R acumulado mensual - anual, enero de 2000 a diciembre de 2022.

ESTACION: VIRTUAL 01 LATITUD: 4°8'40.96" S DPTO. TUMBES
N° DE REGISTROS: 23 ANOS LONGITUD:  80°34'1221"W  PROV. C.M.V.Z
PERIODO: 2000-2022 ALTITUD: 17 m.s.n.m DIST.  CASITAS
FACTOR R
ARG ENE. | FEB. MAR. | ABR. | MAY. | JUN. | JUL. | AGO. | SET. | OCT. | NOV. | DIC. |t ai s
2000 0.05 | 1701.91 | 940.82 | 486.73 | 1.45 | 0.00 | 0.00 0.00 0.00 0.00 0.00 | 0.16 3131.14
2001 86.80 | 101.87 [24094.80| 102.06 | 0.00 | 0.00 | 0.00 0.00 0.00 0.00 0.00 | 0.00 24385.52
2002 0.03 [ 1673.92 | 8841.42 [ 1738.93 [ 0.00 | 0.00 | 0.00 0.00 0.00 0.00 0.00 [ 0.00 12254.31
2003 84.88 | 1241.86 | 6.65 313 | 000 [ 0.00 [ 0.00 0.00 0.00 0.00 0.00 [ 0.48 1337.01
2004 248 | 637.46 | 194.08 | 11.01 [ 0.01 | 0.00 | 0.00 0.00 0.00 0.04 0.00 [ 0.00 845.09
2005 0.10 9.90 [ 276498 | 048 | 000 [ 0.00 [ 0.00 0.00 0.00 0.00 0.00 [ 0.07 2775.53
2006 9.42 [11859.51| 710.31 | 0.8 [ 0.00 | 0.00 | 0.00 0.00 0.00 0.00 0.00 [ 0.01 12579.33
2007 136.57 | 0.39 [ 458354 | 3.91 [ 0.00 | 0.00 | 0.00 0.00 0.00 0.00 0.00 [ 0.00 4724.42
2008 262.01 [ 14386.18| 2096.12 | 6.07 | 0.00 | 0.00 [ 0.00 0.00 0.00 0.00 0.00 | 0.00 16750.39
2009 3799.11| 1657.28 | 2248.48 | 055 | 0.00 | 0.00 | 0.00 0.00 0.00 0.00 0.00 | 0.01 7705.43
2010 11.99 | 3988.01 | 205154 | 32.99 | 0.00 | 0.00 [ 0.00 0.00 0.00 0.00 0.00 [ 0.00 6084.53
2011 2.56 | 245.05 | 0.07 | 101823 | 0.00 | 0.00 | 0.01 0.00 0.00 0.00 0.00 | 0.12 1266.04
2012 22.39 | 16526.29] 3683.05 | 120.78 | 0.03 | 0.00 | 0.00 0.00 0.00 0.00 0.00 [ 0.00 20352.54
2013 11.73 | 22.78 [ 566443 | 092 | 0.65 | 0.00 [ 0.00 0.00 0.00 0.01 0.00 [ 0.00 5700.52
2014 2355 | 213.81 | 16.49 0.53 | 1052 | 0.01 | 0.00 0.00 0.00 0.06 0.00 | 0.09 265.05
2015 0.73 | 39.28 [11660.37| 121.06 | 2.64 | 0.00 | 0.00 0.00 0.00 0.00 0.00 [ 0.04 11824.13
2016 12.84 | 2581.65 | 3846.28 | 77.50 | 0.00 | 0.00 [ 0.00 0.00 0.00 0.00 0.00 | 0.01 6518.28
2017 666.51 | 4337.02 | 1960.33 | 274.34 | 0.02 | 0.00 | 0.00 0.00 0.00 0.00 0.00 [ 0.00 7238.23
2018 14.43 | 33.69 | 90.98 0.30 | 241 [ 0.00 | 0.00 0.00 0.00 0.00 0.01 | 0.84 142.66
2019 7.66 | 2955.45 | 1272.86 | 32.11 | 0.00 | 0.00 | 0.00 0.00 0.00 0.00 0.00 [ 0.22 4268.29
2020 20.80 | 207.67 | 2368.63 | 1.74 | 0.00 | 0.00 | 0.00 0.00 0.00 0.00 0.00 [ 0.17 2599.01
2021 9.52 0.29 |6080.84 | 2056 | 0.01 | 0.00 | 0.00 0.00 0.00 0.00 0.00 | 0.06 6111.29
2022 2.80 1.14 | 3589.24 | 1164 | 001 | 000 | 0.00 0.00 0.00 0.00 0.00 | 0.07 3604.90
PROMEDIO | 225.6 | 2801.0 | 3859.4 | 1768 | 0.8 | 00 | 0.0 0.0 0.0 0.0 0.0 0.1 7063.6
MAXIMO | 3799.1 | 16526.3 | 24094.8 | 1738.9 | 105 | 0.0 | 0.0 0.0 0.0 0.1 0.0 0.8 24385.5
MINIMO 0.0 0.3 0.1 0.1 0.0 | 0.0 | 0.0 0.0 0.0 0.0 0.0 0.0 142.7
DESVIACION | 792.33 | 4771.85 | 5296.80 | 410.25 | 2.26 | 0.00 | 0.00 0.00 0.00 0.01 0.00 | 0.19 6512.92

Fuente: SENAMHI
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Estacion Virtual V2: Factor R acumulado mensual - anual, enero de 2000 a diciembre de 2022.

ESTACION: VIRTUAL 02 LATITUD: 3°54'56.08" S DPTO. TUMBES
N° DE REGISTROS: 23 ANOS LONGITUD: 80°14'26.12" W PROV. ZARUMILLA
PERIODO: 2000-2022 ALTITUD: 527 m.s.n.m DIST. PAPAYAL
FACTOR R
ARO ENE. FEB. MAR. ABR. MAY. | JUN. JUL. AGO. SET. OCT. NOV. DIC. (MJ.mm/Ha.Afio)
2000 0.75 408.36 | 553.02 | 3008.43 | 5.67 0.04 0.00 0.00 0.00 0.00 0.00 0.84 3977.11
2001 322.15 36.17 | 1620.84 | 1765.82 | 0.04 0.00 0.00 0.00 0.00 0.00 0.39 0.32 3745.73
2002 0.05 708.67 | 747.61 |19741.38| 0.00 0.00 0.00 0.00 0.00 0.02 0.00 0.68 21198.41
2003 415.70 | 412.08 5.59 38.45 0.00 0.01 0.00 0.00 0.00 0.00 0.01 16.75 888.59
2004 30.54 191.76 20.22 798.30 0.10 0.00 0.00 0.00 0.00 0.32 0.01 0.12 1041.37
2005 0.51 3.14 917.47 25.83 0.00 0.00 0.00 0.00 0.00 0.02 0.15 8.27 955.40
2006 171.63 | 3919.00 | 361.50 8.90 0.00 0.00 0.00 0.00 0.00 0.00 0.40 0.34 4461.76
2007 892.74 0.28 591.44 | 216.82 0.00 0.00 0.00 0.00 0.00 0.01 0.02 0.17 1701.49
2008 445.66 | 5182.96 | 562.49 | 724.22 0.03 0.00 0.00 0.00 0.00 0.01 0.01 0.00 6915.39
2009 10405.72| 507.38 | 172.22 21.04 0.00 0.00 0.00 0.00 0.00 0.00 0.03 0.39 11106.78
2010 143.51 | 1131.23 | 265.23 | 2532.35 | 0.01 0.00 0.00 0.00 0.00 0.01 0.01 0.20 4072.55
2011 18.46 70.15 0.01 8971.41 | 0.00 0.00 0.00 0.00 0.00 0.01 0.06 1.53 9061.62
2012 248.67 | 2650.82 | 506.69 | 7464.54 | 0.14 0.00 0.00 0.00 0.00 0.00 0.04 0.02 10870.92
2013 82.62 44.29 934.40 72.74 1.26 0.00 0.00 0.00 0.00 0.96 0.00 0.10 1136.38
2014 97.88 85.88 1.99 8.81 20.87 | 0.33 0.00 0.00 0.00 1.24 0.01 11.07 228.08
2015 8.40 46.36 | 2319.27 | 1864.38 | 5.05 0.00 0.00 0.00 0.00 0.05 0.29 0.56 4244.38
2016 100.68 | 1757.10 | 206.35 | 4628.71 | 0.00 0.03 0.00 0.00 0.00 0.00 0.00 0.25 6693.13
2017 753.96 | 1331.76 | 1093.96 | 6263.18 | 0.48 0.00 0.00 0.00 0.00 0.00 0.00 0.02 9443.35
2018 119.74 112.23 0.77 4.38 4.54 0.00 0.00 0.00 0.00 0.01 1.29 23.10 266.06
2019 180.52 | 2041.62 | 209.14 | 449.59 0.00 0.00 0.00 0.00 0.00 0.00 0.04 2.83 2883.75
2020 49.28 789.11 | 173.33 | 406.99 0.01 0.02 0.00 0.00 0.00 0.00 0.02 1.98 1420.74
2021 118.81 5.87 605.71 | 1167.06 | 0.19 0.00 0.00 0.00 0.00 0.03 0.04 0.69 1898.41
2022 44.69 10.01 641.76 | 771.32 0.02 0.00 0.00 0.00 0.00 0.01 0.01 0.55 1468.36
PROMEDIO 637.1 932.4 544.0 2650.2 1.7 0.0 0.0 0.0 0.0 0.1 0.1 3.1 4768.7
MAXIMO 10405.7 | 5183.0 | 2319.3 | 19741.4 | 20.9 0.3 0.0 0.0 0.0 1.2 1.3 23.1 21198.4
MINIMO 0.1 0.3 0.0 4.4 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 228.1
DESVIACION | 2142.54 | 1370.90 | 565.13 | 4525.87 | 4.53 0.07 0.00 0.00 0.00 0.32 0.28 6.05 4951.30

Fuente: SENAMHI
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Anexo 10: Script para extraer datos del producto Pisco — Senamhi

#5crip para extraer datos del producto pisco

#Definir la carpeta de trabajo
setwd("D: /FACTOR_R")
rm(1list = 1s())

#1lamar la librerias necesarias
library(sp)

library(raster)

library(ncdf4)

#Procedimiento

long lat <- read.csv("long lat.csv", header = T)

raster pp <- raster::brick("data.nc")
sp::coordinates(long lat) <- ~XX+YY
raster::projection(long lat) <- raster::projection(raster pp)
points long lat <- raster::extract(raster pp[[1]], long lat,
cellnumbers = T)[,1]

data_long lat <- t(raster_pp[points_long lat])
colnames(data_long lat) <- as.character(long latfN)

#5alida
write.csv(data_long lat, "data_long lat.csv”, quote = F)
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Anexo 11: Mapa de Isoyetas
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Anexo 12: Mapa de textura
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Anexo 13: Mapa de cobertura vegetal
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Anexo 14: Mapa de ubicacion
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Anexo 15: Mapa de Factor R (2000)
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Anexo 16: Mapa de Factor R (2001)
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